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Figure 3-4: BTS Login screen – identifying circuit and packet BTS files
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Figure 3-5: Self–Managed Network Elements (NEs) state of a packet mode SC4812T
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Figure 3-6: Available packet mode commands
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Figure 3-7: Packet mode site with MCC–1 and BBX–1 under LMF control
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Command Line Interface Overview

The LMF also provides Command Line Interface (CLI) capability.
Activate the CLI by clicking on a shortcut icon on the desktop. The CLI
can not be launched from the GUI, only from the desktop icon.

Both the GUI and the CLI use a program known as the handler. Only one
handler can be running at one time. Due to architectural limitations, the
GUI must be started before the CLI if you want the GUI and CLI to use
the same handler. When the CLI is launched after the GUI, the CLI
automatically finds and uses an in–progress login session with a BTS
initiated under the GUI. This allows the use of the GUI and the CLI in
the same BTS login session. If a CLI handler is already running when
the GUI is launched (this happens if the CLI window is already running
when the user starts the GUI, or if another copy of the GUI is already
running when the user starts the GUI), a dialog window displays the
following warning message:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure you want to start the application?
           Yes       No

This window also contains Yes and No buttons. Selecting Yes starts the
application. Selecting No terminates the application.

CLI Format Conventions

The CLI command syntax is as follows:

S verb

S device including device identifier parameters

S switch

S option parameters consisting of:

– keywords

– equals signs (=) between the keywords and the parameter values

– parameter values

Spaces are required between the verb, device, switch, and option
parameters. A hyphen is required between the device and its identifiers.
Following is an example of a CLI command.

measure bbx–<bts_id>–<bbx_id> rssi channel=6 sector=5

Refer to LMF CLI Commands for a complete explanation of the CLI
commands and their usage.
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Logging into a BTS
Logging into a BTS establishes a communication link between the BTS
and the LMF. An LMF session can be logged into only one BTS at a
time.

Prerequisites

Before attempting to log into a BTS, ensure the following have been
completed:

S The LMF is correctly installed on the LMF computer.

S A bts-nnn folder with the correct CDF/NECF and CBSC files exists.

S The LMF computer was connected to the BTS before starting the
Windows operating system and the LMF software. If necessary, restart
the computer after connecting it to the BTS in accordance with
Table 3-5 and Figure 3-3.

CAUTION Be sure that the correct bts–#.cdf/necf and cbsc–#.cdf file are
used for the BTS. These should be the CDF/NECF files that are
provided for the BTS by the CBSC. Failure to use the correct
CDF/NECF files can result in invalid optimization. Failure to
use the correct CDF/NECF files to log into a live
(traffic–carrying) site can shut down the site.

BTS Login from the GUI Environment

Follow the procedure in Table 3-6 to log into a BTS when using the GUI
environment.

Table 3-6: BTS GUI Login Procedure

n Step Action

1 Start the CDMA LMF GUI environment by double clicking on the WinLMF desktop icon (if the
LMF is not running).

NOTE
If a warning similar to the following is displayed, select No, shut down other LMF sessions which
may be running, and start the CDMA LMF GUI environment again:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure you want to start the application?

Yes No

2 Click on the Login tab (if not displayed).

3 If no base stations are displayed in the Available Base Stations pick list, double click on the
CDMA icon.

4 Click on the desired BTS number. For explanation of BTS numbering, see Figure 3-4.

5 Click on the Network Login tab (if not already in the forefront).

6 Enter the correct IP address (normally 128.0.0.2 for a field BTS) if not correctly displayed in the
IP Address box.

. . . continued on next page
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Table 3-6: BTS GUI Login Procedure

n ActionStep

NOTE
128.0.0.2 is the default IP address for MGLI–1 in field BTS units. 128.0.0.1 is the default IP
address for MGLI–2.

7 Type in the correct IP Port number (normally 9216) if not correctly displayed in the IP Port box.

8 Click on Ping.

– If the connection is successful, the Ping Display window shows text similar to the following:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255

– If there is no response the following is displayed:

128.0.0.2:9216:Timed out

If the MGLI fails to respond, reset and perform the ping process again. If the MGLI still fails to
respond, typical problems are shorted BNC to inter–frame cabling, open cables, crossed A and B
link cables, missing 50–Ohm terminators, or the MGLI itself.

9 Change the Multi-Channel Preselector (from the Multi-Channel Preselector pick list), normally
MPC, corresponding to your BTS configuration, if required.

NOTE
When performing RX tests on expansion frames, do not choose EMPC if the test equipment is
connected to the starter frame.

10 Click on the Use a Tower Top Amplifier, if applicable.

11 Click on Login. (A BTS tab with the BTS and frame numbers is displayed.)

NOTE
S If you attempt to login to a BTS that is already logged on, all devices will be gray.

S There may be instances where the BTS initiates a log out due to a system error (i.e., a device
failure).

S If the MGLI is OOS_ROM (blue), it will have to be downloaded with code before other devices
can be seen.

S If the MGLI is OOS–RAM (yellow), it must be enabled before other installed devices can be
seen.
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BTS Login from the CLI Environment

Follow the procedure in Table 3-7 to log into a BTS when using the CLI
environment.

NOTE If the CLI and GUI environments are to be used at the same
time, the GUI must be started first and BTS login must be
performed from the GUI. Refer to Table 3-6 to start the GUI
environment and log into a BTS.

Table 3-7: BTS CLI Login Procedure

n Step Action

1 Double–click the WinLMF CLI desktop icon (if the LMF CLI
environment is not already running).

NOTE
If a BTS was logged into under a GUI session before the CLI
environment was started, the CLI session will be logged into the same
BTS, and Step 2 is not required.

2 At the /wlmf prompt, enter the following command:

login bts–<bts#>  host=<host>  port=<port>

where:

host = MGLI card IP address (defaults to address last logged into for
this BTS or 128.0.0.2 if this is first login to this BTS)

port = IP port of the BTS (defaults to port last logged into for this
BTS or 9216 if this is first login to this BTS)

A response similar to the following will be displayed:

LMF>
13:08:18.882 Command Received and Accepted
             COMMAND=login bts–33

13:08:18.882 Command In Progress

13:08:21.275 Command Successfully Completed
             REASON_CODE=”No Reason”
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Logging Out

Logging out of a BTS is accomplished differently for the GUI and CLI
operating environments.

NOTE The GUI and CLI environments use the same connection to a
BTS. If a GUI and the CLI session are running for the same BTS
at the same time, logging out of the BTS in either environment
will log out of it for both. When either a login or logout is
performed in the CLI window, there is no GUI indication that the
login or logout has occurred.

Logging Out of a BTS from the GUI Environment

Follow the procedure in Table 3-8 to logout of a BTS when using the
GUI environment.

Table 3-8: BTS GUI Logout Procedure

n Step Action

1 Click on BTS on the BTS tab menu bar.

2 Click the Logout item in the pull–down menu (a Confirm Logout
pop–up message will appear).

3 Click on Yes or press the <Enter> key to confirm logout. The Login
tab will appear.

NOTE
If a logout was previously performed on the BTS from a CLI window
running at the same time as the GUI, a Logout Error pop–up
message appears stating the system should not log out of the BTS.
When this occurs, the GUI must be exited and restarted before it can
be used for further operations.

4 If a Logout Error pop–up message appears stating that the system
could not log out of the Base Station because the given BTS is not
logged in, click OK and proceed to Step 5.

5 Select File > Exit in the window menu bar, click Yes in the Confirm
Logout pop–up, and click OK in the Logout Error pop–up which
appears again.

6 If further work is to be done in the GUI, restart it.

NOTE
S The Logout item on the BTS menu bar will only log you out of the

displayed BTS.

S You can also log out of all BTS sessions and exit LMF by clicking
on the File selection in the menu bar and selecting Exit from the
File menu list. A Confirm Logout pop–up message will appear.
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Logging Out of a BTS from the CLI Environment

Follow the procedure in Table 3-9 to logout of a BTS when using the
CLI environment.

Table 3-9: BTS CLI Logout Procedure

n Step Action

NOTE
If the BTS is also logged into from a GUI running at the same time
and further work must be done with it in the GUI, proceed to Step 2.

1 Log out of a BTS by entering the following command:

logout bts–<bts#>

A response similar to the following will be displayed:

LMF>
13:24:51.028 Command Received and Accepted

COMMAND=logout bts–33
13:24:51.028 Command In Progress
13:24:52.04 Command Successfully Completed

REASON_CODE=”No Reason”

2 If desired, close the CLI interface by entering the following
command:

exit

A response similar to the following will be displayed before the
window closes:

Killing background processes....
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Establishing an MMI Communication Session

Equipment Connection – Figure 3-8 illustrates common equipment
connections for the LMF computer. For specific connection locations on
FRUs, refer to the illustration accompanying the procedures which
require the MMI communication session.

Initiate MMI Communication – For those procedures which require
MMI communication between the LMF and BTS FRUs, follow the
procedures in Table 3-10 to initiate the communication session.

Table 3-10: Establishing MMI Communications

Step Action

1 Connect the LMF computer to the equipment as detailed in the applicable procedure that requires the
MMI communication session.

2 If the LMF computer has only one serial port (COM1) and the LMF is running, disconnect the LMF
from COM1 by performing the following:

2a – Click on Tools in the LMF window menu bar, and select Options from the pull–down menu list.
–– An LMF Options dialog box will appear.

2b – In the LMF Options dialog box, click the Disconnect Port button on the Serial Connection tab.

3 Start the named HyperTerminal connection for MMI sessions by double clicking on its Windows
desktop shortcut.

NOTE
If a Windows desktop shortcut was not created for the MMI connection, access the connection from the
Windows Start menu by selecting:

Programs > Accessories > Hyperterminal > HyperTerminal > <Named HyperTerminal
Connection (e.g., MMI Session)>

4 Once the connection window opens, establish MMI communication with the BTS FRU by pressing
the LMF computer <Enter> key until the prompt identified in the applicable procedure is obtained.
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Figure 3-8: CDMA LMF Computer Common MMI Connections
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Online Help

Task oriented online help is available in the LMF by clicking on Help in
the window menu bar, and selecting LMF Help from the pull–down
menu.
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Pinging the Processors

Pinging the BTS

For proper operation, the integrity of the Ethernet LAN A and B links
must be be verified. Figure 3-9 represents a typical BTS Ethernet
configuration. The drawing depicts one link (of two identical links),
A and B.

Ping is a program that routes request packets to the LAN network
modules to obtain a response from the specified “targeted” BTS.

Figure 3-9: BTS Ethernet LAN Interconnect Diagram
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Follow the procedure in Table 3-11 and refer to Figure 3-9 as required to
ping each processor (on both LAN A and LAN B) and verify LAN
redundancy is operating correctly.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.
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NOTE IMPORTANT: The Ethernet LAN A and B cables must be
installed on each frame/enclosure before performing this test. All
other processor board LAN connections are made via the
backplanes.

Table 3-11: Pinging the Processors

n Step Action

1 If you have not already done so, connect the LMF to the BTS (see Table 3-5 on page 3-17).

2 From the Windows desktop, click the Start button and select Run.

3 In the Open box, type ping and the <MGLI IP address> (for example, ping 128.0.0.2).

NOTE
128.0.0.2 is the default IP address for MGLI–1 in field BTS units. 128.0.0.1 is the default IP
address for MGLI–2.

4 Click on the OK button.

5 If the connection is successful, text similar to the following is displayed:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255

If there is no response the following is displayed:

Request timed out

If the MGLI fails to respond, reset and perform the ping process again. If the MGLI still fails to
respond, typical problems are shorted BNC to inter-frame cabling, open cables, crossed A and B
link cables, missing 50–Ohm terminators, or the MGLI itself.

3



Download the BTS68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP 3-35

Download the BTS

Overview
Before a BTS can operate, each equipped device must contain device
initialization (ROM) code. ROM code is loaded in all devices during
manufacture or factory repair, or, for software upgrades, from the CBSC
using the DownLoad Manager (DLM). Device application (RAM) code
and data must be downloaded to each equipped device by the user before
the BTS can be made fully functional for the site where it is installed.

ROM Code
Downloading ROM code to BTS devices from the LMF is NOT routine
maintenance nor a normal part of the optimization process. It is only
done in unusual situations where the resident ROM code in the device
does not match the release level of the site operating software AND the
CBSC cannot communicate with the BTS to perform the download.

If you must download ROM code, the procedures are located in
Appendix G.

Before ROM code can be downloaded from the LMF, the correct ROM
code file for each device to be loaded must exist on the LMF computer.
ROM code must be manually selected for download.

NOTE The ROM code file is not available for GLI3s. GLI3s are ROM
code loaded at the factory.

ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded will change to
OOS_ROM (blue). The device will remain OOS_ROM (blue) when the
download is completed. A compatible revision–level RAM code must
then be downloaded to the device. Compatible code loads for ROM and
RAM must be used for the device type to ensure proper performance.
The compatible device code release levels for the BSS software release
being used are listed in the Version Matrix section of the SCt CDMA
Release Notes (supplied on the tape or CD–ROM containing the BSS
software).

RAM Code
Before RAM code can be downloaded from the LMF, the correct RAM
code file for each device must exist on the LMF computer. RAM code
can be automatically or manually selected depending on the Device
menu item chosen and where the RAM code file for the device is stored
in the LMF file structure. The RAM code file will be selected
automatically if the file is in the <x>:\<lmf home
directory>\cdma\loads\n.n.n.n\code folder (where n.n.n.n is the
download code version number that matches the “NextLoad” parameter
of the CDF file). The RAM code file in the code folder must have the
correct hardware bin number for the device to be loaded.

RAM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to OOS-ROM
(blue). When the download is completed successfully, the device will
change to OOS-RAM (yellow).
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When code is downloaded to an MGLI or GLI, the LMF automatically
also downloads data and then enables the MGLI. When enabled, the
MGLI will change to INS_ACT (bright green). A redundant GLI will
not be automatically enabled and will remain OOS_RAM (yellow).
When the redundant GLI is manually commanded to enable through the
LMF, it will change state to INS_SBY (olive green).

For non–MGLI devices, data must be downloaded after RAM code is
downloaded. To download data, the device state must be OOS–RAM
(yellow).

The devices to be loaded with RAM code and data are:

S Master Group Line Interface (MGLI2 or MGLI3)

S Redundant GLI (GLI2 or GLI3)

S Clock Synchronization Module (CSM) (Only if new revision code
must be loaded)

S Multi Channel Card (MCC24E, MCC8E or MCC–1X)

S Broadband Transceiver (BBX2 or BBX–1X)

S Test Subscriber Interface Card (TSIC) – if RFDS is installed

NOTE The MGLI must be successfully downloaded with code and data,
and put INS before downloading any other device. The
download code process for an MGLI automatically downloads
data and enables the MGLI before downloading other devices.
The other devices can be downloaded in any order.
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Verify GLI ROM Code Loads

Devices should not be loaded with a RAM code version which is not
compatible with the ROM code with which they are loaded. Before
downloading RAM code and data to the processor cards, follow the
procedure in Table 3-12 to verify the GLI devices are loaded with the
correct ROM code for the software release used by the BSS.

Prerequisite

Identify the correct GLI ROM code load for the software release being
used on the BSS by referring to the Version Matrix section of the SCt
CDMA Release Notes (supplied on the tapes or CD–ROMs containing
the BSS software).

Table 3-12: Verify GLI ROM Code Loads

Step Action

1 If it has not already been done, start a GUI LMF session and log into the
BTS ( refer to Table 3-6).

2 Select all GLI devices by clicking on them, and select Device > Status
from the BTS menu bar.

3 In the status report window which opens, note the number in the ROM
Ver column for each GLI.

4 If the ROM code loaded in the GLIs is not the correct one for the software
release being used on the BSS, perform the following:

4a – Log out of the BTS as described in Table 3-8 or Table 3-9, as
applicable.

4b – Disconnect the LMF computer.

4c – Reconnect the span lines as described in Table 5-7.

4d – Have the CBSC download the correct ROM code version to the BTS
devices.

5 When the GLIs have the correct ROM load for the software release being
used, be sure the span lines are disabled as outlined in Table 3-4 and
proceed to downloading RAM code and data.
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Download RAM Code and Data to MGLI and GLI
Follow the procedure in Table 3-13 to download the firmware
application code for the MGLI. The download code action downloads
data and also enables the MGLI.

Prerequisite

S Prior to performing this procedure, ensure a code file exists for each of
the devices to be loaded.

S The LMF computer is connected to the BTS (refer to Table 3-5), and
is logged in using the GUI environment (refer to Table 3-6).

Table 3-13: Download and Enable MGLI

n Step Action

1 Be sure the LMF will use the correct software release for code and
data downloads by performing the following steps:

1a – Click on Tools in the LMF menu bar, and select Update
NextLoad > CDMA from the pull–down menus.

1b – Click on the BTS to be loaded.
–– The BTS will be highlighted.

1c – Click the button next to the correct code version for the software
release being used.
–– A black dot will appear in the button circle.

1d – Click Save.

1e – Click OK to close each of the advisory boxes which appear.

2 Prepare to download code to the MGLI by clicking on the device.

3 Click Device in the BTS menu bar, and select Download >
Code/Data in the pull–down menus.

– A status report is displayed confirmimg change in the device(s)
status.

4 Click OK to close the status window.

– The MGLI will automatically be downloaded with data and
enabled.

5 Once the MGLI is enabled, load and enable additional installed GLIs
by clicking on the devices and repeating Steps 3 and 4.

6 Click OK to close the status window for the additional GLI devices.
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Download Code and Data to Non–GLI Devices
Downloads to non–GLI devices can be performed individually for each
device or all equipped devices can be downloaded with one action.

NOTE – When downloading multiple devices, the download may
fail for some of the devices (a time out occurs). These
devices can be downloaded separately after completing the
multiple download.

– CSM devices are RAM code–loaded at the factory. RAM
code is downloaded to CSMs only if updating to a newer
software version.

Follow the procedure in Table 3-14 to download RAM code and data to
non–GLI devices.

Table 3-14: Download RAM Code and Data to Non–GLI Devices

n Step Action

1 Select the target CSM, MCC, and/or BBX device(s) by clicking on
them.

2 Click Device in the BTS menu bar, and select Download >
Code/Data in the pull–down menus.

– A status report displays the result of the download for each
selected device.

3 Click OK to close the status report window when downloading is
completed.

NOTE
After a BBX, CSM or MCC is successfully downloaded with code
and has changed to OOS-RAM, the status LED should be rapidly
flashing GREEN.

NOTE
The command in Step 2 loads both code and data. Data can be
downloaded without doing a code download anytime a device is
OOS–RAM using the command in Step 4.

4 To download just the firmware application data to each device, select
the target device and select: Device>Download>Data

BBX Cards Remain OOS_ROM

If BBX cards remain OOS_ROM (blue) after power–up or following
code load, refer to Table 6-4, steps 9 and 10.
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Select CSM Clock Source
CSMs must be enabled prior to enabling the MCCs. Procedures in the
following two sub-sections cover the actions to accomplish this. For
additional information on the CSM sub–system, see “Clock
Synchronization Manager (CSM) Sub–system Description” in the CSM
System Time – GPS & LFR/HSO Verification section of this chapter.

Select CSM Clock Source

A CSM can have three different clock sources. The Clock Source
function can be used to select the clock source for each of the three
inputs. This function is only used if the clock source for a CSM needs to
be changed. The Clock Source function provides the following clock
source options:

S Local GPS

S Mate GPS

S Remote GPS

S HSO (only for sources 2 & 3)

S HSO Extender

S HSOX (only for sources 2 & 3)

S LFR (only for sources 2 & 3)

S 10 MHz (only for sources 2 & 3)

S NONE (only for sources 2 & 3)

Prerequisites
S MGLI is INS_ACT (bright green)

S CSM is OOS_RAM (yellow) or INS_ACT (bright green)

Follow the procedure in Table 3-15 to select a CSM Clock Source.

Table 3-15: Select CSM Clock Source

n Step Action

1 Select the applicable CSM(s) for which the clock source is to be
selected.

2 Click on Device in the BTS menu bar, and select CSM/MAWI >
Select Clock Source... in the pull–down menu list.

– A CSM clock reference source selection window will appear.

3 Select the applicable clock source in the Clock Reference Source
pick lists. Uncheck the related check boxes for Clock Reference
Sources 2 and 3 if you do not want the displayed pick list item to be
used.

4 Click on the OK button.

– A status report is displayed showing the results of the operation.

5 Click on the OK button to close the status report window.
 

NOTE For non–RGPS sites only, verify the CSM configured with the
GPS receiver “daughter board” is installed in the CSM–1 slot
before continuing.
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Enable CSMs

NOTE – CSMs are code loaded at the factory. This data is retained
in EEPROM. The download code procedure is required in
the event it becomes necessary to code load CSMs with
updated software versions. Use the status function to
determine the current code load versions.

– The CSM(s) to be enabled must have been downloaded
with code (Yellow, OOS–RAM) and data.

Each BTS CSM system features two CSM boards per site. In a typical
operation, the primary CSM locks its Digital Phase Locked Loop
(DPLL) circuits to GPS signals. These signals are generated by either an
on–board GPS module (RF–GPS) or a remote GPS receiver (R–GPS).
The CSM2 card is required when using the R–GPS. The GPS receiver
(mounted on CSM–1) is the primary timing reference and synchronizes
the entire cellular system. CSM–2 provides redundancy but does not
have a GPS receiver.

The BTS may be equipped with a remote GPS, LORAN–C LFR, HSO
10 MHz Rubidium source, or HSOX for expansion frames, which the
CSM can use as a secondary timing reference. In all cases, the CSM
monitors and determines what reference to use at a given time.

Follow the procedure in Table 3-16 to enable the CSMs.

Table 3-16: Enable CSMs

n Step Action

1 Click on the target CSM (CSM–2 first, if equipped with two CSMs).

2 From the Device pull down, select Enable.

– A status report is displayed confirming change in the device(s) status.

– Click OK to close the status report window.

NOTE
– The board in slot CSM 1 interfaces with the GPS receiver. The enable sequence for this board can

take up to one hour (see below).

– FAIL may be shown in the status report table for a slot CSM 1 enable action. If Waiting For Phase
Lock is shown in the Description field, the CSM changes to the Enabled state after phase lock is
achieved.

* IMPORTANT
– The GPS satellite system satellites are not in a geosynchronous orbit and are maintained and

operated by the United States Department of Defense (D.O.D.). The D.O.D. periodically alters
satellite orbits; therefore, satellite trajectories are subject to change. A GPS receiver that is INS
contains an “almanac” that is updated periodically to take these changes into account.

– If a GPS receiver has not been updated for a number of weeks, it may take up to an hour for the
GPS receiver “almanac” to be updated.

– Once updated, the GPS receiver must track at least four satellites and obtain (hold) a 3–D position
fix for a minimum of 45 seconds before the CSM will come in service. (In some cases, the GPS
receiver needs to track only one satellite, depending on accuracy mode set during the data load).

. . . continued on next page
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Table 3-16: Enable CSMs

n ActionStep

NOTE
– If equipped with two CSMs, CSM–1 should be bright green (INS–ACT) and CSM–2 should be

dark green (INS–STY)

– After the CSMs have been successfully enabled, observe the PWR/ALM LEDs are steady green
(alternating green/red indicates the card is in an alarm state).

3 If more than an hour has passed, refer to CSM Verification, see Figure 3-11 and Table 3-20 to
determine the cause.

 

Enable MCCs

Follow the procedure in Table 3-17 to enable the MCCs.

NOTE The MGLI and primary CSM must be downloaded and enabled
(IN–SERVICE ACTIVE) before downloading and enabling the
MCC.

Table 3-17: Enable MCCs

n Step Action

1 Select the MCCs to be enabled or from the Select pull–down menu
choose MCCs.

2 Click on Device in the BTS menu bar, and select Enable in the
pull–down menu list.

– A status report is displayed showing the  results of the enable
operation.

3 Click on OK to close the status report window.
 

Enable Redundant GLIs

Follow the procedure in Table 3-18 to enable the redundant GLI(s).

Table 3-18: Enable Redundant GLIs

n Step Action

1 Select the target redundant GLI(s).

2 From the Device menu, select Enable.

– A status report window confirms the change in the device(s)
status and the enabled GLI(s) is green.

3 Click on OK to close the status report window.
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CSM System Time – GPS & LFR/HSO Verification

CSM & LFR Background

The primary function of the Clock Synchronization Manager (CSM)
boards (slots 1 and 2) is to maintain CDMA system time. The CSM in
slot 1 is the primary timing source while slot 2 provides redundancy. The
CSM2 card (CSM second generation) is required when using the remote
GPS receiver (R–GPS). R–GPS uses a GPS receiver in the antenna head
that has a digital output to the CSM2 card. CSM2 can have a daughter
card as a local GPS receiver to support an RF–GPS signal.

The CSM2 switches between the primary and redundant units (slots 1
and 2) upon failure or command. CDMA Clock Distribution
Cards (CCDs) buffer and distribute even–second reference and 19.6608
MHz clocks. CCD–1 is married to CSM–1 and CCD–2 is married to
CSM 2. A failure on CSM–1 or CCD–1 cause the system to switch to
redundant CSM–2 and CCD–2.

In a typical operation, the primary CSM locks its Digital Phase Locked
Loop (DPLL) circuits to GPS signals. These signals are generated by
either an on–board GPS module (RF–GPS) or a remote GPS receiver
(R–GPS). The CSM2 card is required when using the R–GPS. DPLL
circuits employed by the CSM provide switching between the primary
and redundant unit upon request. Synchronization between the primary
and redundant CSM cards, as well as the LFR or HSO back–up source,
provides excellent reliability and performance.

Each CSM board features an ovenized, crystal oscillator that provides
19.6608 MHz clock, even second tick reference, and 3 MHz sinewave
reference, referenced to the selected synchronization source (GPS,
LORAN–C Frequency Receiver (LFR), or High Stability Oscillator
(HSO), T1 Span, or external reference oscillator sources).

The 3 MHz signals are also routed to the RDM EXP 1A & 1B
connectors on the top interconnect panel for distribution to co–located
frames at the site.

Fault management has the capability of switching between the GPS
synchronization source and the LFR/HSO backup source in the event of
a GPS receiver failure on CSM–1. During normal operation, the CSM–1
board selects GPS as the primary source (see Table 3-20). The source
selection can also be overridden via the LMF or by the system software.

Front Panel LEDs

The status of the LEDs on the CSM boards are as follows:

S Steady Green – Master CSM locked to GPS or LFR (INS).

S Rapidly Flashing Green – Standby CSM locked to GPS or LFR
(STBY).

S Flashing Green/Rapidly Flashing Red – CSM OOS–RAM attempting
to lock on GPS signal.

S Rapidly Flashing Green and Red – Alarm condition exists. Trouble
Notifications (TNs) are currently being reported to the GLI.
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Low Frequency Receiver/High Stability Oscillator (LFR/HSO)

The CSM and the LFR/HSO – The CSM performs the overall
configuration and status monitoring functions for the LFR/HSO. In the
event of GPS failure, the LFR/HSO is capable of maintaining
synchronization initially established by the GPS reference signal.

LFR – The LFR requires an active external antenna to receive
LORAN–C RF signals. Timing pulses are derived from this signal,
which is synchronized to Universal Time Coordinates (UTC) and GPS
time. The LFR can maintain system time indefinitely after initial GPS
lock.

HSO – The HSO is a high stability 10 MHz oscillator with the necessary
interface to the CSMs. The HSO is typically installed in those
geographical areas not covered by the LORAN–C system. Since the
HSO is a free–standing oscillator, system time can only be maintained
for 24 hours after 24 hours of GPS lock

Upgrades and Expansions: LFR2/HSO2/HSOX

LFR2/HSO2 (second generation cards) both export a timing signal to the
expansion or logical BTS frames. The associated expansion or logical
frames require an HSO–expansion (HSOX) whether the starter frame has
an LFR2 or an HSO2. The HSOX accepts input from the starter frame
and interfaces with the CSM cards in the expansion frame. LFR and
LFR2 use the same source code in source selection (see Table 3-19).
HSO, HSO2, and HSOX use the same source code in source selection
(see Table 3-19).

NOTE Allow the base site and test equipment to warm up for 60
minutes after any interruption in oscillator power. CSM board
warm-up allows the oscillator oven temperature and oscillator
frequency to stabilize prior to test. Test equipment warm-up
allows the Rubidium standard timebase to stabilize in frequency
before any measurements are made.
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CSM Frequency Verification

The objective of this procedure is the initial verification of the CSM
boards before performing the RF path verification tests. Parts of this
procedure will be repeated for final verification after the overall
optimization has been completed.

Null Modem Cable
A null modem cable is required. It is connected between the MMI port
of the primary CSM and the null modem board. Figure 3-10 shows the
wiring detail for the null modem cable.

Figure 3-10: Null Modem Cable Detail

5
3
2
7
8
1
4
6

GND
RX
TX

RTS
CTS

RSD/DCD
DTR
DSR

GND
TX
RX
RTS
CTS
RSD/DCD
DTR
DSR

ON BOTH CONNECTORS
SHORT PINS 7, 8;
SHORT PINS 1, 4, & 6

9–PIN D–FEMALE 9–PIN D–FEMALE

5
2
3
7
8
1
4
6

FW00362

Prerequisites

Ensure the following prerequisites have been met before proceeding:

S The LMF is NOT logged into the BTS.

S The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.
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Test Equipment Setup: GPS & LFR/HSO Verification

Follow the procedure in Table 3-19 to set up test equipment while
referring to Figure 3-11 as required.

Table 3-19: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action

1 Perform one of the following operations:

S For local GPS (RF–GPS), verify a CSM board with a GPS receiver is installed in primary CSM
slot 1 and that CSM–1 is INS.
This is verified by checking the board ejectors for kit number SGLN1145 on the board in slot 1.

S For Remote GPS (RGPS), verify a CSM2 board is installed in primary slot 1 and that CSM–1 is
INS.
This is verified by checking the board ejectors for kit number SGLN4132ED (or later).

2 Remove CSM–2 (if installed) and connect a serial cable from the LMF COM 1 port (via null modem
board) to the MMI port on CSM–1.

3 Reinstall CSM–2.

4 Start an MMI communication session with CSM–1 by using the Windows desktop shortcut icon (see
Table 3-3)

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

5 When the terminal screen appears, press the <Enter> key until the CSM> prompt appears.
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Figure 3-11: CSM MMI terminal connection

NULL MODEM
BOARD

(TRN9666A)

RS–232 SERIAL
MODEM CABLE

DB9–TO–DB25
ADAPTER

COM1

LMF
NOTEBOOK

FW00372

CSM board shown
removed from frame

19.6 MHZ  TEST
POINT REFERENCE

(NOTE 1)

EVEN SECOND
TICK TEST POINT

REFERENCE

GPS RECEIVER
ANTENNA INPUT

GPS RECEIVER

MMI SERIAL
PORT

ANTENNA COAX
CABLE

REFERENCE
OSCILLATOR

9–PIN TO 9–PIN
RS–232 CABLE

NOTES:
1. One LED on each CSM:

Green = IN–SERVICE ACTIVE
Fast Flashing Green = OOS–RAM
Red = Fault Condition
Flashing Green & Red = Fault
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GPS Initialization/Verification

Follow the procedure in Table 3-20 to initialize and verify proper GPS
receiver operation.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

S The LMF is not logged into the BTS.

S The COM1 port is connected to the MMI port of the primary CSM via
a null modem board (see Figure 3-11).

S The primary CSM and HSO (if equipped) have been warmed up for at
least 15 minutes.

CAUTION Connect the GPS antenna to the GPS RF connector ONLY.
Damage to the GPS antenna and/or receiver can result if the
GPS antenna is inadvertently connected to any other RF
connector.
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Table 3-20: GPS Initialization/Verification

Step Action

1 To verify that Clock alarms (0000), Dpll is locked and has a reference source, and
GPS self test passed messages are displayed within the report, issue the following MMI
command

bstatus

– Observe the following typical response:

Clock Alarms (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11

2 Enter the following command at the CSM> prompt to display the current status of the Loran and the
GPS receivers.

sources

– Observe the following typical response for systems equipped with LFR:

N Source Name Type TO Good Status Last Phase Target Phase Valid
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 LocalGPS Primary 4 YES Good 0 0 Yes
1 LFR CHA Secondary 4 YES Good –2013177 –2013177 Yes
2 Not Used
Current reference source number: 0

– Observe the following typical response for systems equipped with HSO:

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 No N/A timed–out* Timed–out* No

NOTE
“Timed–out” should only be displayed while the HSO is warming up.  “Not–Present” or “Faulty”
should not be displayed.  If the HSO does not appear as one of the sources, then configure the HSO as
a back–up source by entering the following command at the CSM> prompt:

ss 1 12

After a maximum of 15 minutes, the Rubidium oscillator should reach operational temperature and the
LED on the HSO should now have changed from red to green.  After the HSO front panel LED has
changed to green, enter sources <cr> at the CSM> prompt.  Verify that the HSO is now a valid
source by confirming that the bold text below matches the response of the “sources” command.

The HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO rubidium
oscillator is fully warmed.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 Yes N/A xxxxxxxxxx xxxxxxxxxx Yes

3 HSO information (underlined text above, verified from left to right) is usually the #1 reference source.
If this is not the case, have the OMCR determine the correct BTS timing source has been identified in
the database by entering the display bts csmgen command and correct as required using the edit
csm csmgen refsrc command.

. . . continued on next page
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Table 3-20: GPS Initialization/Verification

Step Action

4 If any of the above mentioned areas fail, verify:

– If LED is RED, verify that HSO had been powered up for at least 5 minutes. After oscillator
temperature is stable, LED should go GREEN Wait for this to occur before continuing !

– If “timed out” is displayed in the Last Phase column, suspect the HSO output buffer or oscillator
is defective

– Verify the HSO is FULLY SEATED and LOCKED to prevent any possible board warpage

5 Verify the following GPS information (underlined text above):

– GPS information is usually the 0 reference source.

– At least one Primary source must indicate “Status = good” and “Valid = yes” to bring site up.

6 Enter the following command at the CSM> prompt to verify that the GPS receiver is in tracking mode.

gstatus

– Observe the following typical response:

24:06:08 GPS Receiver Control Task State: tracking satellites.
24:06:08 Time since last valid fix: 0 seconds.
24:06:08 
24:06:08 Recent Change Data:
24:06:08 Antenna cable delay 0 ns.
24:06:08 Initial position: lat 117650000 msec, lon –350258000 msec, height 0 cm (GPS)
24:06:08 Initial position accuracy (0): estimated.
24:06:08 
24:06:08 GPS Receiver Status:
24:06:08 Position hold:  lat 118245548 msec, lon –350249750 msec, height 20270 cm
24:06:08 Current position: lat 118245548 msec, lon –350249750 msec, height 20270 cm
(GPS)
24:06:08 8 satellites tracked, receiving 8 satellites, 8 satellites visible.
24:06:08 Current Dilution of Precision (PDOP or HDOP): 0.
24:06:08 Date & Time: 1998:01:13:21:36:11
24:06:08 GPS Receiver Status Byte: 0x08
24:06:08 Chan:0, SVID: 16, Mode: 8, RSSI: 148, Status: 0xa8
24:06:08 Chan:1, SVID: 29, Mode: 8, RSSI: 132, Status: 0xa8
24:06:08 Chan:2, SVID: 18, Mode: 8, RSSI: 121, Status: 0xa8
24:06:08 Chan:3, SVID: 14, Mode: 8, RSSI: 110, Status: 0xa8
24:06:08 Chan:4, SVID: 25, Mode: 8, RSSI:  83, Status: 0xa8
24:06:08 Chan:5, SVID:  3, Mode: 8, RSSI:  49, Status: 0xa8
24:06:08 Chan:6, SVID: 19, Mode: 8, RSSI: 115, Status: 0xa8
24:06:08 Chan:7, SVID: 22, Mode: 8, RSSI: 122, Status: 0xa8
24:06:08 
24:06:08 GPS Receiver Identification:
24:06:08 COPYRIGHT 1991–1996 MOTOROLA INC. 
24:06:08 SFTW P/N # 98–P36830P      
24:06:08 SOFTWARE VER # 8           
24:06:08 SOFTWARE REV # 8           
24:06:08 SOFTWARE DATE  6 AUG 1996 
24:06:08 MODEL #    B3121P1115      
24:06:08 HDWR P/N # _               
24:06:08 SERIAL #   SSG0217769      
24:06:08 MANUFACTUR DATE 6B07       
24:06:08 OPTIONS LIST    IB        
24:06:08 The receiver has 8 channels and is equipped with TRAIM.

. . . continued on next page
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Table 3-20: GPS Initialization/Verification

Step Action

7 Verify the following GPS information (shown above in underlined text):

– At least 4 satellites are tracked, and 4 satellites are visible.

– GPS Receiver Control Task State is “tracking satellites”. Do not continue until this occurs!

– Dilution of Precision indication is not more that 30.

Record the current position base site latitude, longitude, height and height reference (height reference
to Mean Sea Level (MSL) or GPS height (GPS).  (GPS = 0   MSL = 1).

8 If steps 1 through 7 pass, the GPS is good.

NOTE
If any of the above mentioned areas fail, verify that:

– If Initial position accuracy is “estimated” (typical), at least 4 satellites must be tracked and
visible (1 satellite must be  tracked and visible if actual lat, log, and height data for this site has
been entered into CDF file).

– If Initial position accuracy is “surveyed”, position data currently in the CDF file is assumed to be
accurate. GPS will not automatically survey and update its position.

– The GPS antenna is not obstructed or misaligned.

– GPS antenna connector center conductor measures approximately +5 Vdc with respect to the
shield.

– There is no more than 4.5 dB of loss between the GPS antenna OSX connector and the BTS frame
GPS input.

– Any lightning protection installed between GPS antenna and BTS frame is installed correctly.

9 Enter the following commands at the CSM> prompt to verify that the CSM is warmed up and that GPS
acquisition has taken place.

debug dpllp 

Observe the following typical response if the CSM is not warmed up (15 minutes from application of
power)  (If warmed–up proceed to step 10)

CSM>DPLL Task Wait. 884 seconds left.
DPLL Task Wait. 882 seconds left.
DPLL Task Wait. 880 seconds left.   ...........etc.

NOTE
The warm command can be issued at the MMI port used to force the CSM into warm–up, but the
reference oscillator will be unstable.

. . . continued on next page
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Table 3-20: GPS Initialization/Verification

Step Action

10 Observe the following typical response if the CSM is warmed up.

c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175

11 Verify the following GPS information (underlined text above, from left to right):

– Lower limit offset from tracked source variable is not less than –60 (equates to 3µs limit).

– Upper limit offset from tracked source variable is not more than +60 (equates to 3µs limit).

– TK SRC: 0 is selected, where SRC 0 = GPS.

12 Enter the following commands at the CSM> prompt to exit the debug mode display.

debug dpllp

 

LFR Initialization/Verification
The LORAN–C LFR is a full size card that resides in the C–CCP Shelf.
The LFR is a completely self-contained unit that interfaces with the
CSM via a serial communications link. The CSM handles the overall
configuration and status monitoring functions of the LFR.

The LFR receives a 100 kHz, 35 kHz BW signal from up to 40 stations
(8 chains) simultaneously and provides the following major functions:

S Automatic antenna pre-amplifier calibration (using a second
differential pair between LFR and LFR antenna)

S A 1 second ±200 ηs strobe to the CSM

If the BTS is equipped with an LFR, follow the procedure in Table 3-21
to initialize the LFR and verify proper operation as a backup source for
the GPS.

NOTE If CSMRefSrc2 = 2 in the CDF file, the BTS is equipped with
an LFR. If CSMRefSrc2 = 18, the BTS is equipped with an
HSO.
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Table 3-21: LFR Initialization/Verification

Step Action Note

1 At the CSM> prompt, enter lstatus <cr> to verify that the LFR is in tracking
mode. A typical response is:mode. A typical response is:

CSM> lstatus <cr>
LFR St ti  St tLFR Station Status:
Clock coherence: 512 >
5930M 51/60 dB 0 S/N Flag:
5930X 52/64 dn –1 S/N Flag:
5990 47/55 dB –6 S/N Flag:
7980M 62/66 dB 10 S/N Fl

This must be greater
than 100 before LFR
becomes a valid source.

7980M 62/66 dB 10 S/N Flag:
7980W 65/69 dB 14 S/N Flag: . PLL Station . >
7980X 48/54 dB –4 S/N Flag:
7980Y 46/58 dB –8 S/N Flag:E
7980Z 60/67 dB 8 S/N Flag:
8290M 50/65 dB 0 S/N Flag:

This shows the LFR is
locked to the selected
PLL station.

8290M 50/65 dB 0 S/N Flag:
8290W 73/79 dB 20 S/N Flag:
8290W 58/61 dB 6 S/N Flag:8290W 58/61 dB 6 S/N Flag:
8970M 89/95 dB 29 S/N Flag:
8970W 62/66 dB 10 S/N Flag:
8970X 73/79 dB 22 S/N Flag:8970X 73/79 dB 22 S/N Flag:
8970Y 73/79 dB 19 S/N Flag:
8970Z 62/65 dB 10 S/N Flag:
9610M 62/65 dB 10 S/N Fl

g
9610M 62/65 dB 10 S/N Flag:
9610V 58/61 dB 8 S/N Flag:
9610W 47/49 dB –4 S/N Flag:E9610W 47/49 dB –4 S/N Flag:E
9610X 46/57 dB –5 S/N Flag:E
9610Y 48/54 dB –5 S/N Flag:E
9610Z 65/69 dB 12 S/N Flag:9610Z 65/69 dB 12 S/N Flag:
9940M 50/53 dB –1 S/N Flag:S
9940W 49/56 dB –4 S/N Flag:E9940W 49/56 dB 4 S/N Flag:E
9940Y 46/50 dB–10 S/N Flag:E
9960M 73/79 dB 22 S/N Flag:
9960W 51/60 dB 0 S/N Flag:9960W 51/60 dB 0 S/N Flag:
9960X 51/63 dB –1 S/N Flag:
9960Y 59/67 dB 8 S/N Flag:
9960Z 89/96 dB 29 S/N Fl9960Z 89/96 dB 29 S/N Flag:

LFR Task State: lfr locked to station 7980W
LFR Recent Change Data:

Search List: 5930 5990 7980 8290 8970 9940 9610 9960 >
PLL GRI: 7980W

LFR Master, reset not needed, not the reference source.
CSM>

This search list and PLL
data must match the
configuration for the
geographical location
of the cell site.

2 Verify the following LFR information (highlighted above in boldface type):

– Locate the “dot” that indicates the current phase locked station assignment (assigned by MM).

– Verify that the station call letters are as specified in site documentation as well as M X Y Z
assignment.

– Verify the signal to noise (S/N) ratio of the phase locked station is greater than 8.

3 At the CSM> prompt, enter sources <cr> to display the current status of the the LORAN receiver.

– Observe the following typical response.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good –3 0 Yes
1 LFR ch A Secondary 4 Yes Good –2013177 –2013177 Yes
2 Not used
Current reference source number: 1

. . . continued on next page
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Table 3-21: LFR Initialization/Verification

Step NoteAction

4 LORAN–C LFR information (highlighted above in boldface type) is usually the #1 reference source
(verified from left to right).

NOTE
If any of the above mentioned areas fail, verify:

– The LFR antenna is not obstructed or misaligned.

– The antenna pre–amplifier power and calibration twisted pair connections are intact and < 91.4 m
(300 ft) in length.

– A dependable connection to suitable Earth Ground is in place.

– The search list and PLL station for cellsite location are correctly configured .

NOTE
LFR functionality should be verified using the “source” command (as shown in Step 3). Use the
underlined responses on the LFR row to validate correct LFR operation.

5 Close the Hyperterminal window.

 

HSO Initialization/Verification

The HSO module is a full–size card that resides in the C–CCP Shelf.
This completely self contained high stability 10 MHz oscillator
interfaces with the CSM via a serial communications link. The CSM
handles the overall configuration and status monitoring functions of the
HSO. In the event of GPS failure, the HSO is capable of maintaining
synchronization initially established by the GPS reference signal for a
limited time.

The HSO is typically installed in those geographical areas not covered
by the LORAN–C system and provides the following major functions:

S Reference oscillator temperature and phase lock monitor circuitry

S Generates a highly stable 10 MHz sine wave.

S Reference divider circuitry converts 10 MHz sine wave to 10 MHz
TTL signal, which is divided to provide a 1 PPS strobe to the CSM.
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Prerequisites
S The LMF is not logged into the BTS.

S The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.

S The primary CSM and the HSO (if equipped) have warmed up for 15
minutes.

If the BTS is equipped with an HSO, follow the procedure in Table 3-22
to configure the HSO.

Table 3-22: HSO Initialization/Verification

Step Action

1 At the BTS, slide the HSO card into the cage.

NOTE
The LED on the HSO should light red for no longer than 15-minutes, then switch to green. The CSM
must be locked to GPS.

2 On the LMF at the CSM> prompt, enter sources <cr>.

– Observe the following typical response for systems equipped with HSO:

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good 0 0 Yes
1 HSO Backup 4 Yes N/A xxxxxxx –69532 Yes
2 Not used
Current reference source number: 0

When the CSM is locked to GPS, verify that the HSO “Good” field is Yes and the “Valid” field is Yes.

3 If source “1” is not configured as HSO, enter at the CSM> prompt: ss 1 12 <cr>

Check for Good in the Status field.

4 At the CSM> prompt, enter sources <cr>.

Verify the HSO valid field is Yes. If not, repeat this step until the “Valid” status of Yes is returned. The
HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO Rubidium
oscillator is fully warmed.
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Test Equipment Set-up

Connecting Test Equipment to the BTS
The following equipment is required to perform optimization:

S LMF

S Test set

S Directional coupler and attenuator

S RF cables and connectors

S Null modem cable (see Figure 3-10)

S GPIB interface box

Refer to Table 3-23 and Table 3-24 for an overview of connections for
test equipment currently supported by the LMF. In addition, see the
following figures:

S Figure 3-16 and Figure 3-17 show the test set connections for TX
calibration.

S Figure 3-19 and Figure 3-20 show test set connections for IS–95 A/B
optimization/ATP tests.

S Figure 3-21 shows test set connections for IS–95 A/B and
CDMA 2000 optimization/ATP tests.

S Figure 3-23 and Figure 3-24 show typical TX and RX ATP setup with
a directional coupler (shown with and without RFDS).

Test Equipment GPIB Address Settings

All test equipment is controlled by the LMF through an IEEE–488/GPIB
bus. To communicate on the bus, each piece of test equipment must have
a GPIB address set which the LMF will recognize. The standard address
settings used by the LMF for the various types of test equipment items
are as follows:

S Signal generator address:  1

S Power meter address:  13

S Communications system analyzer:  18

Using the procedures included in the Verifying and Setting GPIB
Addresses section of Appendix F, verify and, if necessary, change the
GPIB address of each piece of employed test equipment to match the
applicable addresses above.
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Supported Test Equipment

CAUTION To prevent damage to the test equipment, all TX test connections
must be through the directional coupler and in-line attenuator as
shown in the test setup illustrations.

IS–95 A/B Testing
Optimization and ATP testing for IS–95A/B may be performed using
one of the following test sets:

S CyberTest

S Advantest R3465 and HP 437B or Gigatronics Power Meter

S Hewlett–Packard HP 8935

S Hewlett–Packard HP 8921 (W/CDMA and PCS Interface for
1.7/1.9 GHz) and HP 437B or Gigatronics Power Meter

The equipment listed above cannot be used for  CDMA 2000 testing.

CDMA2000 1X Operation
Optimization and ATP testing for CDMA2000 1X sites or carriers may
be performed using the following test equipment:

S Advantest R3267 Analyzer with Advantest R3562 Signal Generator

S Agilent E4406A with E4432B Signal Generator

S Agilent 8935 series E6380A communications test set (formerly HP
8935) with option 200 or R2K and with E4432B signal generator for
1X FER

The E4406A/E4432B pair, or the R3267/R3562 pair, should be
connected together using a GPIB cable. In addition, the R3562 and
R3267 should be connected with a serial cable from the Serial I/O to the
Serial I/O. This test equipment is capable of performing tests in both
IS–95 A/B mode and CDMA 2000 mode if the required options are
installed.

S Agilent E7495A communications test set

Optional test equipment
S Spectrum Analyzer (HP8594E) – can be used to perform cable

calibration.

Test Equipment Preparation

See Appendix F for specific steps to prepare each type of test set and
power meter to perform calibration and ATP.

Agilent E7495A communications test set requires additional setup and
preparation. This is described in detail in Appendix F.
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Test Equipment Connection Charts

To use the following charts to identify necessary test equipment
connections, locate the communications system analyzer being used in
the COMMUNICATIONS SYSTEM ANALYZER columns, and read down
the column. Where a dot appears in the column, connect one end of the
test cable to that connector. Follow the horizontal line to locate the end
connection(s), reading up the column to identify the appropriate
equipment and/or BTS connector.

IS–95A/B–only Test Equipment Connections

Table 3-23 depicts the interconnection requirements for currently
available test equipment supporting IS–95A/B only which meets
Motorola standards and is supported by the LMF.

Table 3-23: IS–95 A/B Test Equipment Setup
COMMUNICATIONS SYSTEM ANALYZER ADDITIONAL TEST EQUIPMENT

SIGNAL
Cyber–

Test

Advant-
est

R3465
HP

8935
HP

8921A
HP 8921
W/PCS

Power
Meter

GPIB
Inter-
face LMF

30 dB Direction-
al Coupler & 20

dB Pad* BTS

EVEN SECOND 
SYNCHRONIZATION

EVEN
SEC
REF

EVEN SEC
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

19.6608 MHZ
CLOCK TIME

BASE IN

CDMA
TIME BASE

IN
EXT

REF IN

CDMA
TIME

BASE IN

CDMA
TIME

BASE IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB HP–IB HP–IB GPIB

SERIAL
PORTHP–IB HP–IB

TX TEST
CABLES

RF
IN/OUT

INPUT
50–OHM

RF
IN/OUT TX1–6

RF
IN/OUT

RF
IN/OUT

30 DB COUPLER
AND 20 DB PAD

RX TEST
CABLES

RF GEN
OUT

RF OUT
50–OHM RX1–6

DUPLEX
OUT

RF OUT
ONLY

SYNC
MONITOR

FREQ
MONITOR

RF
IN/OUT
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CDMA2000 1X/IS–95A/B–capable Test Equipment
Connections
Table 3-24 depicts the interconnection requirements for currently
available test equipment supporting both CDMA 2000 1X and
IS–95A/B which meets Motorola standards and is supported by the
LMF.

Table 3-24: CDMA2000 1X/IS–95A/B Test Equipment Interconnection
COMMUNICATIONS SYSTEM ANALYZER ADDITIONAL TEST EQUIPMENT

SIGNAL

Agilent
8935 (Op-
tion 200 
or R2K)

Agilent
E7495A

Advan
test

R3267
Agilent
E4406A

Agilent
E4432B
Signal

Generator

Advant-
est

R3562
Signal

Genera-
tor

Power
Meter

GPIB
Inter-
face LMF

30 dB
Directional
Coupler &
20 dB Pad* BTS

EVEN SECOND 
SYNCHRONIZATION

EXT
TRIG  IN

EXT 
TRIG

TRIGGER 
IN

19.6608 MHZ
CLOCK

MOD TIME
BASE IN

EXT REF
IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB HP–IB GPIB

SERIAL
PORTHP–IB

TX TEST
CABLES

RF
IN/OUT RF IN TX1–6

RF INPUT
50 OHM

30 DB COUPLER
AND 20 DB PAD

RX TEST
CABLES

RF OUT
50 OHM

RF OUT
50–OHM RX1–6

RF OUT
ONLY

SYNC
MONI
TOR

FREQ
MONITOR

PATTERN
TRIG  IN

GPIB

RF OUTPUT
50 OHM

RF OUTPUT
50–OHM

10 MHZ IN
10 MHZ OUT
(SWITCHED) 10 MHZ IN

10 MHZ
OUT10 MHZ

SERIAL
I/O

SERIAL
I/OSIGNAL SOURCE

CONTROLLED
SERIAL I/O

EVEN
SECOND
SYNC  IN

EXT REF
IN

HP–IB

RF IN/OUT

DUPLEX
OUT *

SYNTHE
REF IN

*  WHEN USED ALONE, THE AGILENT 8935 WITH OPTION 200 OR R2K SUPPORTS IS–95A/B RX TESTING BUT NOT CDMA2000 1X RX TESTING.

EVEN
SECOND
SYNC  IN

PORT 1
RF OUT

PORT 2
RF IN
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Equipment Warm-up

NOTE To assure BTS stability and contribute to optimization accuracy
of the BTS, warm-up the BTS test equipment prior to
performing the BTS optimization procedure as follows:

– Agilent E7495A for a minimum of 30 minutes

– All other test sets for a minimum of 60 minutes
Time spent running initial or normal power-up, hardware/
firmware audit, and BTS download counts as warm-up time.

WARNING Before installing any test equipment directly to any BTS TX
OUT connector, verify there are no CDMA channels keyed.

– At active sites, have the OMC-R/CBSC place the antenna
(sector) assigned to the LPA under test OOS. Failure to do
so can result in serious personal injury and/or equipment
damage.

Automatic Cable Calibration Set–up
Figure 3-12 through Figure 3-15 show the cable calibration setup for
various supported test sets. The left side of the diagram depicts the
location of the input and output ports of each test set, and the right side
details the set up for each test.

Manual Cable Calibration

If manual cable calibration is required, refer to the procedures in
Appendix F.
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Figure 3-12: IS–95A/B Cable Calibration Test Setup – 
CyberTest, Agilent 8935, Advantest R3465, and HP 8921A
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Figure 3-13: IS–95A/B and CDMA 2000 1X Cable Calibration Test Setup –
Agilent E4406A/E4432B and Advantest R3267/R3562
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Figure 3-14: CDMA2000 1X Cable Calibration Test Setup – Agilent 8935/E4432B
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Figure 3-15: CDMA2000 1X Cable Calibration Test Setup –  Agilent E7495A
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Set-up for TX Calibration
Figure 3-16 through Figure 3-18 show the test set connections for TX
calibration.

Figure 3-16: TX Calibration Test Setup – CyberTest (IS–95A/B) and 
Agilent 8935 (IS–95A/B and CDMA2000 1X), and Advantest R3465
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Figure 3-17: TX Calibration Test Setup – 
Agilent E4406A and Advantest R3567 (IS–95A/B and CDMA2000 1X)
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Figure 3-18: TX Calibration Test Setup – Agilent E7495A (IS–95A/B and CDMA2000 1X)
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Setup for Optimization/ATP
Figure 3-19 and Figure 3-21 show test set connections for IS–95 A/B
optimization/ATP tests. Figure 3-21 and Figure 3-22 show test set
connections for IS-95 A/B/C optimization/ATP tests.

Figure 3-19: Optimization/ATP Test Setup Calibration – Agilent 8935

ÁÁÁÁÁÁÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁ

TEST SET Optimization/ATP SET UP

RF IN/OUT

HP–IB
TO GPIB
BOX

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

RX ANTENNA
PORT OR RFDS

RX DIRECTIONAL
COUPLER

ANTENNA PORT

TX ANTENNA
PORT OR RFDS

TX DIRECTIONAL
COUPLER

ANTENNA PORT

RS232 NULL
MODEM
CABLE

BTS

TX
TEST
CABLE

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

RX
TEST
CABLE

COMMUNICATIONS
TEST SET

IEEE 488
GPIB BUS

RF
IN/OUT

TEST SET
INPUT/

OUTPUT
PORTS

NOTE:  IF BTS RX/TX SIGNALS ARE
DUPLEXED (4800E): BOTH THE TX AND RX
TEST CABLES CONNECT TO THE DUPLEXED
ANTENNA GROUP.

100–WATT (MIN)
NON–RADIATING

RF LOAD

2O DB PAD FOR 1.7/1.9 GHZ
(10 DB PAD FOR 800 MHZ)

EVEN
SECOND/SYNC
IN

CDMA
TIMEBASE

 IN

FREQ
MONITOR

SYNC
MONITOR

CSM

30 DB
DIRECTIONAL
COUPLER

RS232–GPIB
INTERFACE BOX

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

DIP SWITCH SETTINGS

INTERNAL PCMCIA
ETHERNET CARD

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

CDMA
LMF

REF FW00096

Agilent 8935 Series E6380A (formerly HP 8935)

3



Test Equipment Set-up68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP 3-69

Figure 3-20: Optimization/ATP Test Setup – HP 8921
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Figure 3-21: IS–95A/B and CDMA2000 1X Optimization/ATP Test Setup – 
Advantest R3267/3562, Agilent E4432B/E4406A
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Figure 3-22: IS–95A/B and CDMA2000 1X Optimization/ATP Test Setup – 
Agilent E7495A

TEST SET ATP TEST SET UP

INTERNAL PCMCIA
ETHERNET CARD

UNIVERSAL TWISTED PAIR (UTP)
CABLE  (RJ45 CONNECTORS)

BTS

CDMA
LMF

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

INTERNAL
ETHERNET

CARD

RF INPUT 50 Ω
OR INPUT 50 Ω

SYNC
MONITOR

CSM

COMMUNICATIONS
SYSTEM ANALYZER

50 Ω
TERM

TX TEST

DIRECTIONAL
COUPLER
(30 DB)

100–WATT (MIN.)
NON–RADIATING

RF LOAD
TX TEST

NOTE:  IF BTS IS EQUIPPED
WITH DUPLEXED RX/TX
SIGNALS, CONNECT THE TX
TEST CABLE TO THE DUPLEXED
ANTENNA CONNECTOR.

2O DB IN–LINE
ATTENUATOR

ETHERNET HUB

RX TEST

RX TEST

RX
ANTENNA

CONNECTOR

TX
ANTENNA

CONNECTOR

TEST
CABLES

NOTE:  USE THE SAME
CABLE SET FOR TX AND RX
ATP. SWITCH THE CABLES
DURING ALL ATP TESTS AS
SHOWN.

POWER METER

PORT 2
RF IN

PORT 1
RF OUT

Agilent  E7495A

PORT 1
RF OUT

PORT 2
RF IN

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

Use only
Agilent supplied
power adapter

GPS

GPIO

Serial 1

Serial 2

Power REF
50 MHz

Sensor

Ext Ref
In

Even Second
Sync In

Antenna

Port 1
RF Out / SWR

Port 2
RF In

3



Test Equipment Set-up 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATP3-72

ATP Setup with Directional Couplers

Figure 3-23 shows a typical TX ATP setup.

Figure 3-23: Typical TX ATP Setup with Directional Coupler
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Figure 3-24: Typical RX ATP Setup with Directional Coupler

Figure 3-24 shows a typical RX ATP setup.
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Test Set Calibration

Background
Proper test equipment calibration ensures that the test equipment and
associated test cables do not introduce measurement errors, and that
measurements are correct.

NOTE If the test equipment set being used to optimize or test the BTS
has been calibrated and maintained as a set, this procedure does
not need to be performed.

This procedure must be performed prior to beginning the optimization.
Verify all test equipment (including all associated test cables and
adapters actually used to interface all test equipment and the BTS) has
been calibrated and maintained as a set.

CAUTION If any piece of test equipment, test cable, or RF adapter that
makes up the calibrated test equipment set has been replaced, the
set must be re-calibrated. Failure to do so can introduce
measurement errors, resulting in incorrect measurements and
degradation to system performance. Motorola recommends
repeating cable calibration before testing at each BTS site.

NOTE Calibration of the communications system analyzer (or
equivalent test equipment) must be performed at the site before
calibrating the overall test equipment set. Calibrate the test
equipment after it has been allowed to warm–up and stabilize for
a minimum of 60 minutes.

Calibration Procedures Included

Automatic

Procedures included in this section use the LMF automated calibration
routine to determine path losses of the supported communications
analyzer, power meter, associated test cables, adapters, and (if used)
antenna switch that make up the overall calibrated test equipment set.
After calibration, the gain/loss offset values are stored in a test
measurement offset file on the LMF computer.

Manual

Agilent E4406A Transmitter Tester – The E4406A does not support
the power level zeroing calibration performed by the LMF. If this
instrument is to be used for Bay Level Offset calibration and calibration
is attempted with the LMF Calibrate Test Equipment function, the
LMF will return a status window failure message stating that zeroing
power is not supported by the E4406A. Refer to the Equipment
Calibration section of Appendix F for instructions on using the
instrument’s self–alignment (calibration) function prior to performing
Bay Level Offset calibration.

Power Meters – Manual power meter calibration procedures to be
performed prior to automated calibration are included in the Equipment
Calibration section of Appendix F.
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Cable Calibration – Manual cable calibration procedures using the HP
8921A and Advantest R3465 communications system analyzers are
provided in the Manual Cable Calibration section of Appendix F, if
needed.

GPIB Addresses

GPIB addresses can range from 1 through 30. The LMF will accept any
address in that range, but the numbers entered in the LMF Options
window GPIB address box must match the addresses of the test
equipment. Motorola recommends using 1 for a CDMA signal generator,
13 for a power meter, and 18 for a communications system analyzer. To
verify and, if necessary, change the GPIB addresses of the test
equipment, refer to the Setting GPIB Addresses section of Appendix F.

IP Addresses

For the Agilent E7495A Communications Test Set, set the IP address
and complete initial setup as described in Appendix F (Specifically, see
Table F-1 on page F-3).

Selecting Test Equipment

Serial Connection and Network Connection tabs are provided in the
LMF Options window to specify the test equipment connection method.
The Serial Connection tab is used when the test equipment items are
connected directly to the LMF computer through a GPIB box (normal
setup). The Network Connection tab is used when the test equipment is
to be connected remotely via a network connection or the Agilent
E7495A Communications Test Set is used. Refer to Appendix F
(Specifically, see Table F-1 on page F-3).

Prerequisites
Ensure the following prerequisites have been met before proceeding:

S Test equipment is correctly connected and turned on.

S GPIB addresses set in the test equipment have been verified as correct
using the applicable procedures in Appendix F. (GPIB not applicable
with Agilent E7495A)

S LMF computer serial port and test equipment are connected to the
GPIB box. (GPIB not applicable with Agilent E7495A)

Selecting Test Equipment

Test equipment may be selected either manually with operator input or
automatically using the LMF autodetect feature.
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Manually Selecting Test Equipment in a Serial Connection Tab

Test equipment can be manually specified before, or after, the test
equipment is connected. The LMF does not check to see if the test
equipment is actually detected for manual specification. Follow the
procedure in Table 3-25 to select test equipment manually.

Table 3-25: Selecting Test Equipment Manually in a Serial Connection Tab

n Step Action

1 In the LMF window menu bar, click Tools and select Options... from the pull–down menu. The
LMF Options window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on the Manual Specification button (if not enabled).

5 Click on the check box corresponding to the test item(s) to be used.

6 Type the GPIB address in the corresponding GPIB address box (refer to the Setting GPIB
Addresses section of Appendix F for directions on verifying and/or changing test equipment GPIB
addresses). Motorola–recommended addresses are:
1 = signal generator
13 = power meter
18 = communications system analyzer

* IMPORTANT
When test equipment items are manually selected by the operator, the LMF defaults to using a
power meter for RF power measurements. The LMF will use a communications system analyzer
for RF power measurements only if a power meter is not selected (power meter checkbox not
checked).

7 Click on Apply. (The button darkens until the selection has been committed.)

NOTE
With manual selection, the LMF does not attempt to detect the test equipment to verify it is
connected and communicating with the LMF.

To verify and, if necessary, change the GPIB address of the test equipment, refer to Appendix F.

8 Click on Dismiss to close the LMF Options window.
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Automatically Selecting Test Equipment in Serial Connection Tab

When using the auto-detection feature to select test equipment, the LMF
examines which test equipment items are actually communicating with
the LMF. Follow the procedure in Table 3-26 to use the auto-detection
feature.

Table 3-26: Selecting Test Equipment Using Auto-Detect

n Step Action

1 In the LMF window menu bar, click Tools and select Options... from the pull–down menu. The
LMF Options window appears.

2 If it is not in the forefront, click on the Serial Connection tab.

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 If it is not selected (no black dot showing), click on the Auto–Detection button.

5 If they are not already displayed in the box labeled GPIB address to search, click in the box and
type in the GPIB addresses for the test equipment to be used, separating each address with
commas and no spaces. (Refer to the Setting GPIB Addresses section of Appendix F for
instructions on verifying and/or changing test equipment GPIB addresses.)

NOTE
During the GPIB address search for a test equipment item to perform RF power measurements
(that is, for TX calibration), the LMF will select the first item it finds with the capability to
perform the measurement. If, for example, the address sequence 13,18,1 is included in the GPIB
addresses to search box, the power meter (GPIB address 13) will be used for RF power
measurements. If the address sequence 18,13,1 is included, the LMF will use the communications
system analyzer (GPIB address 18) for power measurements.

6 Click Apply.  The button will darken until the selection has been committed. A check mark will
appear in the applicable Manual Configuration section check boxes for detected test equipment
items.

7 Click Dismiss to close the LMF Options window.

 

Detecting Test Equipment when using Agilent E7495A

Check that no other equipment is connected to the LMF. Agilent
E7495A equipment must be connected to the LAN to detect it. Then
perform the procedures described in Appendix F (Specifically, see
Table F-1 on page F-3,  Table F-2, and Table F-3 on page F-4).

3



Test Set Calibration 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATP3-78

Calibrating Test Equipment

The calibrate test equipment function zeros the power measurement level
of the test equipment item that is to be used for TX calibration and audit.
If both a power meter and an analyzer are connected, only the power
meter is zeroed.

NOTE The Agilent E4406A transmitter tester does not support power
measurement level zeroing. Refer to the Equipment Calibration
section of Appendix F for E4406A calibration.

Prerequisites
S LMF computer serial port and test equipment are connected to the

GPIB box.
S Test equipment to be calibrated has been connected correctly for tests

that are to be run.

S Test equipment has been selected in the LMF (Table 3-25 or
Table 3-26)

Calibrating test equipment

Follow the procedure in Table 3-27 to calibrate the test equipment.

Table 3-27: Test Equipment Calibration

n Step Action

1 From the Util menu, select Calibrate Test Equipment
from the pull–down menu. A Directions window is
displayed.

2 Follow the directions provided.

3 Click on Continue to close the Directions window and
start the calibration process. A status report window is
displayed.

4 Click on OK to close the status report window.
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Calibrating Cables Overview

The LMF Cable Calibration function is used to measure the path loss (in
dB) for the TX and RX cables, adapters, directional couplers, and
attenuators that make up the cable configurations used for testing. A
communications system analyzer is used to measure the loss of both the
TX test cable and the RX test cable configurations. LMF cable
calibration consists of the following processes:

Measure the loss of a short cable

This is done to compensate for any measurement error of the
communications system analyzer. The short cable, which is used only for
the calibration process, is connected in series with both the TX and RX
test cable configurations when they are measured.

The measured loss of the TX and RX test cable configurations minus the
measured loss of the short cable equals the actual loss of the
configurations. This is done so that any error in the analyzer
measurement is eliminated from both the TX and RX measurements.

Measure the loss of the short cable plus the RX test
cable configuration

The RX test cable configuration normally consists only of a coax cable
with type–N connectors that is long enough to reach from the BTS RX
connector to the test equipment.

When the BTS antenna connectors carry duplexed TX and RX signals, a
directional coupler is required and an additional attenuator may also be
required (for certain BTS types) for the RX test cable configuration.
These additional items must be included in the path loss measurement.

Measure the loss of the short cable plus the TX test
cable configuration

The TX test cable configuration normally consists of two coax cables
with type–N connectors, a directional coupler, a termination load with
sufficient rating to dissipate the BTS output power, and an additional
attenuator, if required by the BTS type. The total path loss of the TX test
configuration must be as required for the BTS (normally 30 or 50 dB).

The Motorola Cybertest analyzer differs from other communications
system analyzers because the required attenuation/load is built into the
test set. Because of this, the Cybertest TX test configuration consists
only of the required length coax cable.
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Calibrate Test Cabling using Communications System Analyzer

Cable Calibration is used to calibrate both TX and RX test cables.
Appendix F covers the procedures for manual cable calibration.

NOTE LMF cable calibration cannot be accomplished using an HP8921
analyzer for 1.7/1.9 GHz.  A different analyzer type or the signal
generator and spectrum analyzer method (Table 3-29 and
Figure 3-25) must be used. Cable calibration values must be
manually entered into the LMF cable loss file if the signal
generator and spectrum analyzer method is used. To use the
HP8921A for manual test cable configuration calibration for 800
MHz BTSs, refer to the Manual Cable Calibration section of
Appendix F.

Prerequisites

S Test equipment is turned on and has warmed up for at least 60
minutes. Agilent E7495A requires only 30 minute warmup.

S Test equipment has been selected in the LMF (Table 3-25 or
Table 3-26).

S Test equipment has been calibrated and correctly connected for the
type of test cable configuration to be  calibrated.

Calibrating cables

Refer to Figure 3-12, Figure 3-13, or Figure 3-14 and follow the
procedure in Table 3-28 to calibrate the test cable configurations.

Table 3-28: Test Cabling Calibration using Comm. System Analyzer

n Step Action

1 Click Util in the BTS menu bar, and select Cable
Calibration... in the pull–down menu. A Cable
Calibration window is displayed.

2 Enter one or more channel numbers in the Channels box

NOTE
Multiple channels numbers must be separated with a
comma, no space (i.e., 200,800). When two or more
channels numbers are entered, the cables are calibrated for
each channel. Interpolation is accomplished for other
channels as required for TX calibration.

3 Select TX and RX Cable Cal, TX Cable Cal, or RX
Cable Cal in the Cable Calibration pick list.

4 Click OK, and follow the directions displayed for each
step. A status report window will be displayed with the
results of the cable calibration.
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Calibrate Test Cabling Using Signal Generator & Spectrum Analyzer
Follow the procedure in Table 3-29 to calibrate the TX/Duplexed RX
cables using a signal generator and spectrum analyzer. Refer to
Figure 3-25, if required.  Follow the procedure in Table 3-30 to calibrate
the Non–Duplexed RX cables using the signal generator and spectrum
analyzer. Refer to Figure 3-26, if required.

Table 3-29: Calibrating TX/Duplexed RX Cables Using Signal Generator & Spectrum Analyzer

Step Action

1 Connect a short test cable between the spectrum analyzer and the signal generator as shown in
Figure 3-25, detail “A” (top portion of figure).

2 Set signal generator to 0 dBm at the customer frequency of:

869–894 MHz for North American Cellular or 1930–1990 MHz for North American PCS

3 Use spectrum analyzer to measure signal generator output (see Figure 3-25, A) & record the value.

4 Connect the spectrum analyzer’s short cable to point B, (as shown in the lower right portion of the
diagram) to measure cable output at customer frequency of:

869–894 MHz for North American Cellular or 1930–1990 MHz for North American PCS

Record the value at point B.

5 Calibration factor = (value measured with detail “A” setup) – (value measured with detail “B” setup)

Example: Cal factor = –1 dBm – (–53.5 dBm) = 52.5 dB

NOTE
The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the test cable configuration as is to ensure test
procedures use the correct calibration factor.

 

Figure 3-25: Cal Setup for TX/Duplexed RX Test Cabling 
Using Signal Generator & Spectrum Analyzer
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Table 3-30: Calibrating Non–Duplexed RX Cables Using a Signal Generator  &Spectrum Analyzer

Step Action

NOTE
When preparing to calibrate a BTS with Duplexed TX and RX the RX cable calibration must be done
using calibration setup in Figure 3-25 and the procedure in Table 3-29.

1 Connect a short test cable between the spectrum analyzer and the signal generator as shown in
Figure 3-26, detail “A” (top portion of figure).

2 Set signal generator to –10 dBm at the customer’s RX frequency of:

824–849 for North American Cellular or 1850–1910 MHz band for North American PCS

3 Use spectrum analyzer to measure signal generator output (see Figure 3-26, A) and record the value.

4 Connect the test setup, as shown in the lower portion of the diagram (see Figure 3-26, B) to measure
the output at the customer’s RX frequency of:

824–849 for North American Cellular or 1850–1910 MHz band for North American PCS

Record the value at point B.

5 Calibration factor = (value measured with detail “A” setup) – (value measured with detail “B” setup)

Example: Cal factor = –1 dBm – (–53.5 dBm) = 52.5 dB

NOTE
The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the test cable configuration as is to ensure test
procedures use the correct calibration factor.

 

Figure 3-26: Cal Setup for Non–Duplexed RX Test Cabling 
Using Signal Generator & Spectrum Analyzer
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Setting Cable Loss Values
Cable loss values for TX and RX test cable configurations are normally
set by accomplishing automatic cable calibration using the LMF and the
applicable test equipment. The LMF stores the measured loss values in
the cable loss files. The cable loss values can also be set or changed
manually. Follow the procedure in Table 3-31 to set cable loss values.

CAUTION If cable calibration was performed without using the LMF, cable
loss values must be manually entered in the LMF database.
Failure to do this will result in inaccurate BTS calibration and
reduced site performance.

Prerequisites
S LMF is logged into the BTS

Table 3-31: Setting Cable Loss Values

Step Action

1 Click Util in the BTS menu bar, and select Edit > Cable Loss in the pull–down menus.

– A tabbed data entry pop–up window will appear.

2 Click on the TX Cable Loss tab or the RX Cable Loss tab, as required.

3 To add a new channel number, perform the following:

3a – Click on the Add Row button.

3b – Click in the Channel # or Loss (dBm) column, as required.

3c – Enter the desired value.

4 To edit existing values, click in the data box to be changed and change the value.

5 To delete a row, click on the row and then click on the Delete Row button.

6 For each tab with changes, click on the Save button to save displayed values.

7 Click on the Dismiss button to close the window.

NOTE
S Values entered or changed after the Save button was used will be lost when the window is

dismissed.

S If cable loss values exist for two different channels the LMF will interpolate for all other channels.

S Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.
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Setting TX Coupler Loss Values

If an in–service TX coupler is installed, the coupler loss (e.g., 30 dB)
must be manually entered so it will be included in the LMF TX
calibration and audit calculations and RX FER Test. Follow the
procedure in Table 3-32 to set coupler loss values.

Prerequisites
S LMF is logged into the BTS

S Path loss, in dB, of the TX coupler must be known

Setting loss values

Table 3-32: Setting TX Coupler Loss Value

Step Action

1 Click Util in the BTS menu bar, and select Edit > Coupler
Loss... in the pull–down menus.

– A tabbed data entry pop–up window will appear.

2 Click on the TX Coupler Loss tab or the RX Coupler Loss
tab, as required

3 Click in the Loss (dBm) column for each carrier that has a
coupler and enter the appropriate value.

4 To edit existing values, click in the data box to be changed
and change the value.

5 For each tab with changes, click on the Save button to save
displayed values.

6 Click on the Dismiss button to close the window.

NOTE
S Values entered or changed after the Save button is used will

be lost when the window is dismissed.

S The In–Service Calibration check box in the Tools >
Options > BTS Options tab must be checked before
entered TX coupler loss values will be used by the TX
calibration and audit functions.

S New or changed values will be used by the LMF as soon as
they are saved. Logging out and logging in again are not
required to cause saved changes to take effect.
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Bay Level Offset Calibration

Introduction
Bay Level Offset (BLO) calibration is the central activity of the
optimization process. BLO calibration compensates for normal
equipment variations within the BTS RF paths and assures the correct
transmit power is available at the BTS antenna connectors to meet site
performance requirements.

RF Path Bay Level Offset Calibration
Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database calibration
table in the LMF. The BLOs are subsequently downloaded to each BBX.

For starter frames, each receive path starts at a BTS RX antenna port and
terminates at a backplane BBX slot. Each transmit path starts at a BBX
backplane slot, travels through the Power Amplifier (PA) and terminates
at a BTS TX antenna port.

For expansion frames each receive path starts at the BTS RX port of the
cell site starter frame, travels through the frame-to-frame expansion
cable, and terminates at a backplane BBX slot of the expansion frame.
The transmit path starts at a BBX backplane slot of the expansion frame,
travels though the PA and terminates at a BTS TX antenna port of the
same expansion frame.

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database. Each
transmit path starts at a C–CCP shelf backplane BBX slot, travels
through the PA, and ends at a BTS TX antenna port. When the TX path
calibration is performed, the RX path BLO is automatically set to the
default value.

At omni sites, BBX slots 1 and 13 (redundant) are tested. At sector sites,
BBX slots 1 through 12, and 13 (redundant) are tested. Only those slots
(sectors) actually equipped in the current CDF are tested, regardless of
physical BBX board installation in the slot.

When to Calibrate BLOs
Calibration of BLOs is required:

S After initial BTS installation

S Once each year

S After replacing any of the following components or associated
interconnecting RF cabling:

– BBX board

– C–CCP shelf

– CIO card

– CIO to Power Amplifier backplane RF cable

– PA backplane

– PA

– TX filter / TX filter combiner

– TX thru-port cable to the top of frame
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TX Path Calibration

The TX Path Calibration assures correct site installation, cabling, and the
first order functionality of all installed equipment. The proper function
of each RF path is verified during calibration. The external test
equipment is used to validate/calibrate the TX paths of the BTS.

WARNING Before installing any test equipment directly to any TX OUT
connector you must first verify that there are no CDMA
channels keyed. Have the OMC–R place the sector assigned to
the LPA under test OOS. Failure to do so can result in serious
personal injury and/or equipment damage.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module. If this is not done, there is a
high probability that the card/module could be damaged by ESD.

NOTE At new site installations, to facilitate the complete test of each
CCP shelf (if the shelf is not already fully populated with BBX
boards), move BBX boards from shelves currently not under test
and install them into the empty BBX slots of the shelf currently
being tested to insure that all BBX TX paths are tested.

– This procedure can be bypassed on operational sites that are
due for periodic optimization.

– Prior to testing, view the CDF file to verify the correct
BBX slots are equipped. Edit the file as required to include
BBX slots not currently equipped (per Systems
Engineering documentation).

BLO Calibration Data File

During the calibration process, the LMF creates a bts–n.cal calibration
(BLO) offset data file in the bts–n folder. After calibration has been
completed, this offset data must be downloaded to the BBXs using the
Download BLO function. An explanation of the file is shown below.

NOTE Due to the size of the file, Motorola recommends that you  print
out a hard copy of a bts.cal file and refer to it for the following
descriptions.

The CAL file is subdivided into sections organized on a per slot basis (a
slot Block).

Slot 1 contains the calibration data for the 12 BBX slots. Slot 20
contains the calibration data for the redundant BBX. Each BBX slot
header block contains:

S A creation Date and Time – broken down into separate parameters of
createMonth, createDay, createYear, createHour, and createMin.

S The number of calibration entries – fixed at 720 entries corresponding
to 360 calibration points of the CAL file including the slot header and
actual calibration data.
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S The calibration data for a BBX is organized as a large flat array. The
array is organized by branch, sector, and calibration point.

– The first breakdown of the array indicates which branch the
contained calibration points are for. The array covers transmit, main
receive and diversity receive offsets as follows:

Table 3-33: BLO BTS.cal File Array Assignments

Range Assignment

C[1]–C[240] Transmit

C[241]–C[480] Main Receive

C[481]–C[720] Diversity Receive

NOTE Slot 385 is the BLO for the RFDS.

– The second breakdown of the array is per sector. Configurations
supported are Omni, 3–sector or 6–sector.

Table 3-34: BTS.cal File Array (Per Sector)

BBX Sectorization TX RX RX Diversity

Slot[1] (Primary BBXs 1 through 12)

1 (Omni) 3–Sector, C[1]–C[20] C[241]–C[260] C[481]–C[500]

2
3–Sector,

1st
C i

C[21]–C[40] C[261]–C[280] C[501]–C[520]

3 6 Sector,
1st

Carrier C[41]–C[60] C[281]–C[300] C[521]–C[540]

4
1st

Carrier 3–Sector, C[61]–C[80] C[301]–C[320] C[541]–C[560]

5
Carrier 3–Sector,

3rd
C i

C[81]–C[100] C[321]–C[340] C[561]–C[580]

6 Carrier C[101]–C[120] C[341]–C[360] C[581]–C[600]

7 3–Sector, C[121]–C[140] C[361]–C[380] C[601]–C[620]

8
3–Sector,

2nd
C i

C[141]–C[160] C[381]–C[400] C[621]–C[640]

9 6 Sector,
2nd

Carrier C[161]–C[180] C[401]–C[420] C[641]–C[660]

10
2nd

Carrier 3–Sector, C[181]–C[200] C[421]–C[440] C[661]–C[680]

11
Carrier 3–Sector,

4th
C i

C[201]–C[220] C[441]–C[460] C[681]–C[700]

12 Carrier C[221]–C[240] C[461]–C[480] C[701]–C[720]

 . . . continued on next page
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Table 3-34: BTS.cal File Array (Per Sector)

BBX RX DiversityRXTXSectorization

Slot[20] (Redundant BBX–13)

1 (Omni) 3–Sector, C[1]–C[20] C[241]–C[260] C[481]–C[500]

2
3–Sector,

1st
C i

C[21]–C[40] C[261]–C[280] C[501]–C[520]

3 6 Sector,
1st

Carrier C[41]–C[60] C[281]–C[300] C[521]–C[540]

4
1st

Carrier 3–Sector, C[61]–C[80] C[301]–C[320] C[541]–C[560]

5
Carrier 3–Sector,

3rd
C i

C[81]–C[100] C[321]–C[340] C[561]–C[580]

6 Carrier C[101]–C[120] C[341]–C[360] C[581]–C[600]

 . . . continued on next page

7 3–Sector, C[121]–C[140] C[361]–C[380] C[601]–C[620]

8
3–Sector,

2nd
C i

C[141]–C[160] C[381]–C[400] C[621]–C[640]

9 6 Sector,
2nd

Carrier C[161]–C[180] C[401]–C[420] C[641]–C[660]

10
2nd

Carrier 3–Sector, C[181]–C[200] C[421]–C[440] C[661]–C[680]

11
Carrier 3–Sector,

4th
C i

C[201]–C[220] C[441]–C[460] C[681]–C[700]

12 Carrier C[221]–C[240] C[461]–C[480] C[701]–C[720]

S Ten calibration points per sector are supported for each branch. Two
entries are required for each calibration point.

S The first value (all odd entries) refer to the CDMA channel
(frequency) where the BLO is measured. The second value (all even
entries) is the power set level. The valid range for PwrLvlAdj is from
2500 to 27500 (2500 corresponds to –125 dBm and 27500
corresponds to +125 dBm).

S The 20 calibration entries for each sector/branch combination must be
stored in order of increasing frequency. If less than 10 points
(frequencies) are calibrated, the largest frequency that is calibrated is
repeated to fill out the 10 points.
Example:
C[1]=384, odd cal entry

=   1 ‘‘calibration point”
C[2]=19102, even cal entry
C[3]=777,
C[4]=19086,
.
.
C[19]=777,
C[20]=19086, (since only two cal points were calibrated this 

would be repeated for the next 8 points)

S When the BBX is loaded with image = data, the cal file data for the
BBX is downloaded to the device in the order it is stored in the cal
file. TxCal data is sent first, C[1] – C[240]. Sector 1’s ten calibration
points are sent (C[1] – C[20]) followed by sector 2’s ten calibration
points (C[21] – C[40]), etc. The RxCal data is sent next (C[241] –
C[480]), followed by the RxDCal data (C[481] – C[720]).

S Temperature compensation data is also stored in the cal file for each
set.
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Test Equipment Set-up for RF Path Calibration

Follow the procedure in Table 3-35 to set up test equipment.

Table 3-35: Set Up Test Equipment for RF Path Calibration

Step Action

1 If it has not already been done, refer to the procedure in Table 3-5 (on page 3-17) to interface the LMF
computer terminal to the frame LAN A connector.

2 If it has not already been done, refer to Table 3-6 (on page 3-26) to start a GUI LMF session.

3 If required, calibrate the test equipment per the procedure in Table 3-27 (on page 3-78).

NOTE
Verify the GPIB controller is properly connected and turned on.

! CAUTION
To prevent damage to the test equipment, all transmit (TX) test connections must be via the 30 dB
directional coupler for 800 MHz with an additional 20 dB in–line attenuator for 1.7/1.9 GHz.

4 For TX path calibration, connect the test equipment as shown in Figure 3-16, Figure 3-17, or
Figure 3-19, depending on the communications analyzer being used.

Transmit (TX) Path Calibration Description

The assigned channel frequency and power level (as measured at the top
of the frame) for transmit calibration are derived from the site CDF files.
For each BBX, the channel frequency is specified in the ChannelList
CDF file parameter and the power is specified in the SIFPilotPwr
CDF file parameter for the sector associated with the BBX (located
under the ParentSECTOR field of the ParentCARRIER CDF file
parameter).

NOTE If both the BTS–x.cdf and CBSC–x.cdf files are current, all
information will be correct on the LMF. If not, the carrier and
channel will have to be set for each test.

The calibration procedure attempts to adjust the power to within +0.5 dB
of the desired power. The calibration will pass if the error is less than
+1.5 dB.

The TX Bay Level Offset at sites WITHOUT the directional coupler
option, is approximately 42.0 dB ±3.0 dB.

S At sites WITHOUT RFDS option, BLO is approximately 
42.0 dB ±4.0 dB. A typical example would be TX output power
measured at BTS (36.0 dBm) minus the BBX TX output level
(approximately –6.0 dBm) would equate to 42 dB BLO.

The TX Bay Level Offset at sites WITH the directional coupler option,
is approximately 41.4 dB ±3.0 dB. TX BLO = Frame Power Output
minus BBX output level.

S Example: TX output power measured at RFDS TX coupler
(39.4 dBm) minus the BBX TX output level (approximately
–2.0 dBm) and RFDS directional coupler/cable (approximately
–0.6 dBm) would equate to 41.4 dB BLO.
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TX Calibration and the LMF

The LMF Tests > TX > TX Calibration... and Tests > All Cal/Audit...
selections perform TX BLO calibration testing for installed BBX(s). The
All Cal/Audit... selection initiates a series of actions to perform TX
calibration, and if calibration is successful, download BLO and perform
TX audit. The TX Calibration... selection performs only TX
calibration. When TX Calibration... is used, BLO download and TX
audit must be performed as separate activities. The CDMA Test
Parameters window which opens when TX Calibration... or All
Cal/Audit... is selected contains several user–selectable features which
are described in the following subsections.

Rate Set Drop-down Pick List

The Rate Set Drop–down Box is enabled if at least one MCC card is
selected for the test. The available options for TX tests are 1 = 9600, and
3 = 9600 1X. Option 3 is only available if 1X cards are selected for the
test. The available transfer rate options for RX tests are 1 = 9600 and
2 = 14400. Option 2 is only available if no 1X cards are selected.

Verify BLO
In both the TX Calibration and All Cal/Audit dialog boxes, a Verify
BLO checkbox is provided and checked by default. After the actual TX
calibration is completed during either the TX Calibration or All
Cal/Audit process, the BLO derived from the calibration is compared to
a standard, acceptable BLO tolerance for the BTS. In some installations,
additional items may be installed in the transmit path. The additional
change in gain from these items could cause BLO verification failure
and, therefore, failure of the entire calibration. In these cases, either the
Verify BLO checkbox should be unchecked or the additional path losses
should be added into each applicable sector using the
Util>Edit>TX Coupler Loss... function.

Single-Sided BLO Checkbox

Another option that appears in the pull–down menu is Single–sided
BLO. Normally valid BLO values are some value plus–or–minus some
offset. The ranges that we currently use for calibration are wider than
necessary to accommodate the redundant BBX. The lower half of that
range is where non–redundant BBXs should be. When Single–sided
BLO is selected, the result is only considered a success if it is in the
lower half of the range. If it was normally a success from 37–47 (which
is 42 �5), Single–sided BLO would make it a success only if the result
was from 37–42. To get the more stringent conditions, the operator
checks Single–sided BLO when calibrating non–redundant transceivers.
Single–sided BLO carries the likelihood of more failures. This option
should only be used by experienced CFEs.
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Test Pattern Drop-down Pick List

The Tests > TX > TX Calibration... menu window has a Test Pattern
pull–down menu. This menu has the following choices:

S Pilot (default) – performs tests using a pilot signal only. This pattern
should be used when running in–service tests. It only requires a BBX
to do the test.

S Standard – performs the tests using pilot, synch, paging and six
traffic channels. This pattern should be used on all non–in–service
tests. Standard requires a BBX and an MCC. Standard uses gain
values specified by the IS97 standard.

S CDFPilot –performs the tests using the pilot signal, however, the gain
is specified in the CDF file. Advanced users may use CDFPilot to
generate a Pilot pattern using the value specified by the PilotGain
parameter in the CDF file instead of a pre–determined value.

S CDF – performs the tests using pilot, synch, paging and six traffic
channels, however, the gain for the channel elements is specified in
the CDF file. Advanced users may use CDF to generate a standard
pattern. Instead of using the values specified by IS97, the settings for
the following CDF parameters are used:

– PilotGain

– PchGain

– SchGain

– NomGain1Way

Set-up for TX Calibration

The workaround in Table 3-36 allows the user to manually set the BLO
limits to ensure that the redundant BBX BLO test does not fail due to the
preset offset being incorrectly set for the frame under test. A future LMF
release will correct this problem.

Table 3-36: Initial Set-up for TX Calibration

n Step Action

1 Delete the existing calibration file (if any) from the BTS folder on LMF
laptop from the location C:\wlmf\cdma\bts–#, where # is the BTS
number.

2 To edit the nominal TX BLO, from the Util menu, select Edit > TX
Nominal Offset.  In the TX Cal Parameter window, make any necessary
changes to ensure the Tx BLO Nominal Offset (in dB) is correct:

– For 800 MHz, the value is 45.0 (dB), OR

– For 1900 MHz, the value is 43.0 (dB).

3 Download the data, which includes BLO values, to all the BBXs. From the
Device menu, select  Download > Data
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TX Calibration

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

CAUTION Always wear an approved anti–static wrist strap while handling
any circuit card or module. If this is not done, there is a high
probability that the card or module could be damaged by ESD.

All Cal/Audit and TX Calibration  Procedure

The LMF All Cal/Audit and TX calibration procedures are essentially
identical, except for the step that selects the type of procedure desired
(Refer to Step 4 in Table 3-37).

Prerequisites

Before running this procedure, be sure that the following have been
done:

S The card in slot CSM 1, GLIs, MCCs, and BBXs have correct code
and data loads.

S Primary CSM and MGLI are INS_ACT (bright green).

S All BBXs are OOS_RAM (yellow).

S If running calibration or audit using a test pattern other than Pilot,
MCCs are INS_ACT (bright green).

S Test equipment and test cables are calibrated and connected for TX
calibration.

S LMF is logged into the BTS in the GUI environment.

NOTE Verify all BBX boards removed and repositioned have been
returned to their assigned shelves/slots. Any BBX boards moved
since they were downloaded will have to be downloaded again.

All Cal Audit/TX Path Calibration procedure

Follow the procedure in Table 3-37 to perform the All Cal/Audit and TX
path calibration test.

Table 3-37: All Cal/Audit and TX Calibration Procedure

n Step Action

1 If it has not already been done, configure test equipment for TX calibration by following the
procedure in Table 3-35.

2 Click on the BBX(s) to be calibrated.

3 If the Test Pattern to be used is Standard, CDFPilot, or CDF, select at least one MCC (refer to
“Test Pattern Drop–down Pick List” under “TX Calibration and the LMF” in this section).

. . . continued on next page
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Table 3-37: All Cal/Audit and TX Calibration Procedure

n ActionStep

4 For All Cal Audit...

– Click Tests in the BTS menu bar, and select TX > All Cal/Audit... from the pull–down
menus.  A CDMA Test Parameters window will appear.

For TX Calibration

– Click Tests in the BTS menu bar, and select TX > TX Calibration from the pull–down
menus.  A CDMA Test Parameters window will appear.

5 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed
in the Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to
select multiple carrier(s)–sector(s).

6 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.  If it is not, obtain the latest bts–#.cdf (or bts–#.necf) and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels
box.

7 If at least one MCC was selected in Step 3, select the appropriate transfer rate (1 = 9600, 3 = 9600
1X) from the drop–down list in the Rate Set box.

NOTE
The rate selection of 3 is only available if 1X cards are selected for the test.

8 If Verify BLO is to be used during the calibration, leave the checkbox checked (default).

9 If Single–Sided BLO is to be used during the calibration, click on the checkbox.

* IMPORTANT
Single–Sided BLO should only be used for primary BBXs. Do not check the box when
calibrating the redundant BBX.

10 In the Test Pattern box, select the test pattern to use for the calibration from the drop–down list
(refer to “Test Pattern Drop–down Pick List” under “TX Calibration and the LMF” in this section
– see page 3-91).

11 Click OK to display the status report window followed by a Directions pop-up window.

12 Follow cable connection directions as they are displayed. When the calibration process is
completed, results will be displayed in the status report window.

13 Click on the Save Results or Dismiss button, as desired, to close the status report window.
 

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re–run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.
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Download BLO Procedure

After a successful TX path calibration, download the bay level offset
(BLO) calibration file data to the BBXs. BLO data is extracted from the
CAL file for the Base Transceiver Subsystem (BTS) and downloaded to
the selected BBX devices.

NOTE If a successful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

S BBXs being downloaded are OOS–RAM (yellow).

S TX calibration is successfully completed.

Follow the steps in Table 3-38 to download the BLO data to the BBXs.

Table 3-38: Download BLO

n Step Action

1 Select the BBX(s) to be downloaded.

2 Click Device in the BTS menu bar, and select Download
> BLO from the pull–down menus. A status report
window displays the result of the download.

NOTE
Selected device(s) do not change color when BLO is
downloaded.

3 Click on OK to close the status report window.

Calibration Audit Introduction

The BLO calibration audit procedure confirms the successful generation
and storage of the BLO calibration offsets. The calibration audit
procedure measures the path gain or loss of every BBX transmit path at
the site. In this test, actual system tolerances are used to determine the
success or failure of a test. The same external test equipment set up is
used.

NOTE RF path verification, BLO calibration, and BLO data download
to BBXs must have been successfully completed prior to
performing the calibration audit.
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TX Path Audit

Perform the calibration audit of the TX paths of all equipped BBX slots
per the procedure in Table 3-39

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

NOTE If a successful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

TX Audit Test

The Tests menu item, TX Audit, performs the TX BLO Audit test for a
BBX(s). All measurements are made through the appropriate TX output
connector using the calibrated TX cable setup.

Prerequisites

Before running this test, ensure that the following have been done:

S CSM–1, GLIs, and BBXs have correct code load and data load.

S Primary CSM and MGLI are INS.

S All BBXs are OOS_RAM.

S Test equipment and test cables are calibrated and connected for TX
BLO calibration.

S LMF is logged into the BTS.
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TX Path Audit procedure

After a TX calibration has been performed, or if verification of BLO data
in the CAL file is required, follow the procedure in Table 3-39 to
perform a BTS TX path audit.

Table 3-39: BTS TX Path Audit

n Step Action

1 If it has not already been done, configure test equipment for TX path audit by following the procedure
in Table 3-35 (TX audit uses the same configuration as TX calibration).

2 Select the BBX(s) to be audited.

3 If the Test Pattern to be used is Standard, CDFPilot or CDF, select at least one MCC (refer to
“Test Pattern Drop–down Pick List” under “TX Calibraton and the LMF” in this section).

4 Click Tests in the BTS menu bar, and select TX>TX Audit... from the pull–down menus.  A
CDMA Test Parameters window will appear.

5 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to
select multiple carrier(s)–sector(s).

6 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.  If it is not, obtain the latest bts–#.cdf (or bts–#.necf) and cbsc–#.cdf files from the CBSC.

NOTE
The correct channel number may be manually entered into the Carrier # Channels box.

7 If at least one MCC was selected in Step 2, select the appropriate transfer rate (1 = 9600, 3 = 9600
1X) from the drop–down list in the Rate Set box.

NOTE
The rate selection of 3 is only available if 1X cards are selected for the test.

8 Select Verify BLO (default) or Single–sided BLO.

NOTE
Single–sided BLO is only used when checking non–redundant transceivers.

9 In the Test Pattern box, select the test pattern from the drop–down list (refer to “Test Pattern
Drop–down Pick List” – see page 3-91).

10 Click OK to display the status report window followed by a Directions pop-up window.

11 Follow the cable connection directions as they are displayed.  When the calibration process is
completed, results will be displayed in the status report window.

12 Click on the Save Results or Dismiss button, as desired, to close the status report window.
 

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the Status Report window and provides information in the
Description field. Recheck the test setup and connection and re–run the
test. If the tests fail again, note specifics about the failure, and refer to
Chapter 6, Troubleshooting.
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All Cal/Audit Test
The Tests menu item, All Cal/Audit, performs the TX BLO Calibration
and Audit test for a XCVR(s). All measurements are made through the
appropriate TX output connector using the calibrated TX cable setup.

NOTE If the TX calibration portion of the test passes, the BLO data is
automatically downloaded to the BBX(s) before the audit portion
of the test is run.

Prerequisites

Before running this test, ensure that the following have been done:

S CSM–1, GLIs, BBXs have correct code and data loads.

S Primary CSM and MGLI are INS.

S All BBXs are OOS_RAM.

S Test equipment and test cables are calibrated and connected for TX
BLO calibration.

S LMF is logged into the BTS.

Follow the procedure in Table 3-40 to perform the All Cal/Audit test.

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no CDMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

Table 3-40: All Cal/Audit Test

n Step Action

1 Select the BBX(s) to be tested.

NOTE
If STANDARD, CDFPilot, or CDF is selected for the TEST PATTERN, then at least one MCC
must be also selected.

2 From the Tests menu, select All Cal/Audit.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.

Press and hold the <Shift> or <Ctrl> key to select multiple items.

4 Type the appropriate channel number in the Carrier n Channels box.

5 If at least one MCC was selected in Step1 select the appropriate transfer rate (1 = 9600, 3 = 9600
1X) from the drop–down list in the Rate Set box.

NOTE
The rate selection of 3 is only available if 1X cards are selected for the test.

6 Select Verify BLO or Single–sided BLO.

NOTE
Single–sided BLO is only used when checking non–redundant transceivers.

7 In the Test Pattern box, select the test pattern from the drop–down list (refer to “Test Pattern
Drop–down Pick List” – see page 3-91).

8 Click on OK.
. . . continued on next page
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Table 3-40: All Cal/Audit Test

n ActionStep

9 Follow the cable connection directions as they are displayed. A status report window displays the
test results.

10 Click on Save Results or Dismiss to close the status report window.
 

Create CAL File

The Create Cal File function gets the BLO data from BBXs and
creates/updates the CAL file for the BTS. If a CAL file does not exist, a
new one is created. If a CAL file already exists, it is updated. After a
BTS has been fully optimized, a copy of the CAL file must exist so it
can be transferred to the CBSC. If TX calibration has been successfully
performed for all BBXs and BLO data has been downloaded, a CAL file
exists. Note the following:

S The Create Cal File function only applies to selected (highlighted)
BBXs.

WARNING The user is not encouraged to edit the CAL file as this action can
cause interface problems between the BTS and the LMF. To
manually edit the CAL file, you must first logout of the BTS. If
you manually edit the CAL file and then use the Create Cal File
function, the edited information is lost.

Prerequisites

Before running this test, the following should be done:

S LMF is logged into the BTS.

S BBXs are OOS_RAM with BLO downloaded.

Creating a CAL File

Table 3-41: Create CAL File

n Step Action

1 Select the applicable BBXs.

NOTE
The CAL file is only updated for the selected BBXs.

2 Click on the Device menu.

3 Click on the Create Cal File menu item. A status report
window displays the results of the action.

4 Click OK to close the status report window.
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RFDS Set–up and Calibration

RFDS Description

NOTE The RFDS is not available for the –48 V BTS at the time of this
publication.

The optional RFDS performs RF tests of the site from the CBSC or from
an LMF. The RFDS consists of the following elements:

S Antenna Select Unit (ASU)

S Fixed Wireless Terminal Interface Card (FWTIC)

S Subscriber Unit Assembly (SUA)

For complete information regarding the RFDS, refer to the CDMA
CDMA RFDS Hardware Installation; 68P64113A93, CDMA RFDS
User’s Guide; 68P64114A51, and the LMF Help function on–line
documentation.

RFDS Parameter Settings

The bts–#.cdf file includes RFDS parameter settings that must match the
installed RFDS equipment. The paragraphs below describe the editable
parameters and their defaults. Table 3-42 explains how to edit the
parameter settings.

S RfdsEquip – valid inputs are 0 through 2.
0 = (default) RFDS is not equipped
1 = Non-Cobra/Patzer box RFDS
2 = Cobra RFDS

S TsuEquip – valid inputs are 0 or 1
0 = (default) TSU not equipped
1 = TSU is equipped in the system

S MC1....4 – valid inputs are 0 or 1
0 = (default) Not equipped
1 = Multicouplers equipped in RFDS system 

(9600 system RFDS only)

S Asu1/2Equip – valid inputs are 0 or 1
0 = (default) Not equipped
1 = Equipped

S TestOrigDN – valid inputs are ’’’ (default) or a numerical string up to
15 characters. (This is the phone number the RFDS dials when
originating a call. A dummy number needs to be set up by the switch,
and is to be used in this field.)

NOTE Any text editor may be used to open the bts–#.cdf file to verify,
view, or modify data. Because the bts–#.cdf file is generated on
a Unix system, a more sophisticated editor, such as MicroSoft
WordPad, will display file content in a more easily–read format
than many simple text editors.
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Checking and Setting RFDS Parameters

Follow the procedure in Table 3-42 to review and/or edit RFDS
parameters.

Table 3-42: RFDS Parameter Settings

Step Action

1 Important! Log out of the BTS prior to performing this procedure.

2 Using a text editor, verify the following fields are set correctly in the bts–#.cdf file:

EXAMPLE:

Asu1Equip = 1
Asu2Equip = 0 (1 if system is non-duplexed)
Mc1Equip = 0
Mc2Equip = 0
Mc3Equip = 0
Mc4Equip = 0
RfdsEquip = 2
TestOrigDN = ’123456789’
TsuEquip = 1

NOTE
The above is an example of entries extracted from the bts–#.cdf file that should have been generated
by the OMC–R and copied to the LMF. These fields will have been set by the OMC–R if the
RFDSPARM database is modified for the RFDS.

3 Save changes and/or quit the editor.

4 Log into the BTS using an LMF GUI session (refer to Table 3-6).

5 If no changes were made to the bts–#.cdf file fields listed in Step 2, proceed to Step 6. If changes were
made, continue with Step 8.

NOTE
To make certain the complete data download is accepted, the MGLI should be OOS_RAM (yellow)
when RFDS parameter settings are downloaded.

6 When changes are made to RFDS parameters in the bts–#.cdf file, data must be downloaded to the
MGLI by performing the following:

6a – To be sure it does not take control when the MGLI is disabled, manually disable the redundant
GLI card by unseating it from the backplane connectors and sliding it partially out of the shelf
slot.

6b – Click on the MGLI.

6c – Click on Device in the BTS menu bar, and select Disable from the pull–down menu. A status
report window shows the status of the operation.

6d – When the operation is complete, click OK to close the status report window.

6e – Click on the MGLI (now OOS_RAM (yellow)).

6f – Click on Device in the BTS menu bar, and select Download > Data from the pull–down menus
(selected devices do not change color when data is downloaded). A status report window shows
the status of the download.

6g – Click OK to close the status report window.

6h – Click on the MGLI.
. . . continued on next page
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Table 3-42: RFDS Parameter Settings

Step Action

6i – Click on Device in the BTS menu bar, and select Enable from the pull–down menu. A status
report window shows the status of the operation.

6j – When the operation is complete, click OK to close the status report window.j

! CAUTION
When the MGLI changes to INS_ACT, data will automatically be downloaded to the RFDS. During
this process, the RFDS LED will slowly begin flashing red and green for approximately 2–3 minutes.
DO NOT attempt to perform any functions with the RFDS until the LED remains steady green.

6k – Re–seat the redundant GLI card into the backplane connectors and lock it in place with the ejector
tabs.

6l – Once the redundant GLI initializes, download data to it by selecting the card and, in the BTS
menu bar, clicking Device and selecting Download > Data from the pull–down menus.

7 Any MCCs that were INS_ACT when the MGLI was disabled must be disabled, downloaded with
data, and re–enabled as follows:

7a – Select the devices to be reset by clicking on them or using Select from the BTS menu bar and
clicking on MCCs in the pull–down menu.

7b – In the BTS menu bar, click on Device and select Disable from the pull–down menu. A status
report window shows the status of the operation.

7c – Click OK to close the status report window.

7d – Repeat Step 7a to select the MCCs.

7e – Click on Device in the BTS menu bar and select Download > Data from the pull–down menu.
(Selected devices do not change colot when data is downoaded.)

– A status report window shows the status of the download.

7f – Click on OK to close the status report window.

7g – When data download is complete, enable the MCCs by following the procedure in Table 3-17.

8 Click on the RFDS tab.

9 Status the RFDS TSU by performing the following:

9a – Click on the SUA to select it.

9b – Click on TSU in the BTS menu bar, and select Status TSU from the pull–down menu. A status
report shows the software version number for the TSIC and SUA.

9c – Click OK to close the status report window.

NOTE
If the LMF displays an error message, check the following:

S Ensure AMR cable is correctly connected from the BTS to the RFDS.

S Verify RFDS has power.

S Verify RFDS status LED is green.

S Verify entries in RFDS fields of the bts–#.cdf file are correct (refer to Step 2).

S Status the MGLI and ensure it is communicating (by Ethernet) with the LMF, and is in the proper
state (INS_ACT (bright green)).
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RFDS TSU NAM Programming

The Number Assignment Module (NAM) information needs to be
programmed into the TSU before it can receive and process test calls, or
be used for any type of RFDS test. The RFDS TSU NAM must be
programmed with the appropriate system parameters and phone number
during hardware installation. The TSU phone and TSU MSI must be
recorded for each BTS used for OMC–R RFDS software configuration.

NOTE The user will only need to program the NAM for the initial
install of the RFDS.

Explanation of Parameters used when Programming the TSU NAM

Table 3-43 defines the parameters used when editing the tsu.nam file.

Table 3-43: Definition of Parameters

Access_Overload_Code
Slot_Index
System ID
Network ID

These parameters are obtained from the switch.

Primary_Channel_A
Primary_Channel_B
Secondary_Channel_A
Secondary_Channel B

These parameters are the channels used in operation of the system.

Lock_Code
Security_Code
Service_Level
Station_Class_Mark

Do not change.

IMSI_11_12
IMSI_MCC

These fields are obtained at the OMC using the following command:
OMC000>disp bts–# imsi
If the fields are blank, replace the IMSI fields in the NAM file to 0,
otherwise use the values displayed by the OMC.

MIN Phone Number This field is the phone number assigned to the mobile. The ESN and
MIN should be entered into the switch as well.

NOTE
This field is different from the TODN field in the bts–#.cdf file. The
MIN is the phone number of the RFDS subscriber, and the TODN is
the number the subscriber calls.
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Valid NAM Ranges

Table 3-44 provides the valid NAM field ranges. If any of the fields are
missing or out of range, the RFDS errors out.

Table 3-44: Valid NAM Field Ranges

Valid Range

NAM Field Name Minimum Maximum

Access_Overload_Code 0 15

Slot_Index 0 7

System ID 0 32767

Network ID 0 32767

Primary_Channel_A 25 1175

Primary_Channel_B 25 1175

Secondary_Channel_A 25 1175

Secondary_Channel_B 25 1175

Lock_Code 0 999

Security_Code 0 999999

Service_Level 0 7

Station_Class_Mark 0 255

IMSI_11_12 0 99

IMSI_MCC 0 999

MIN Phone Number N/A N/A
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Set Antenna Map Data

The antenna map data must be entered manually if an RFDS is installed.
Antenna map data does not need to be entered if an RFDS is not
installed. The antenna map data is only used for RFDS tests and is
required if an RFDS is installed.

Prerequisite
S Logged into the BTS

Follow the procedure in Table 3-45 to set antenna map data for the
RFDS.

Table 3-45: Set Antenna Map Data

Step Action

1 Click on Util in the BTS menu bar, and select Edit > Antenna Map... from the pull–down menus. A
tabbed data entry pop–up window will appear.

2 In the data entry pop–up window, click on the TX Antenna Map or RX Antenna Map tab to select
the antenna map to be edited.

3 Locate the carrier and sector number for which data is to be entered or edited, and click in the column
where entry or editing is needed.

4 Enter/edit Antenna # and Antenna Label column data as needed for each carrier.

NOTE
Refer to the CDMA Help > Utility Menu > Edit–Antenna Map... section of LMF Help function
on–line documentation for antenna map examples.

5 For each tab with changes, click on the Save button to save displayed values.

6 Click on the Dismiss button to close the window.

NOTE
S Values entered or changed after the Save button was used will be lost when the window is

dismissed.

S Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.
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Set RFDS Configuration Data

If an RFDS is installed, the RFDS configuration data must be manually
entered.

Prerequisite
S LMF is logged into the BTS

NOTE The entered antenna# index numbers must correspond to the
antenna# index numbers used in the antenna maps.

Follow the procedure in Table 3-46 to set the RFDS Configuration Data.

Table 3-46: Set RFDS Configuration Data

Step Action

1 Click on Util in the BTS menu bar, and select Edit > RFDS Configuration... from the pull–down
menus. A tabbed data entry pop–up window will appear.

2 In the data entry pop–up window, click on the TX RFDS Configuration or RX RFDS Configuration
tab, as required.

3 To add a new antenna number, perform the following:

3a – Click on the Add Row button.

3b – Click in the Antenna #, Cal Antenna, Scap Antenna, or Populate [Y/N] columns, as required.

3c – Enter the desired data.

4 To edit existing values, click in the data box to be changed and change the value.

NOTE
Refer to the CDMA Help > Utility Menu > Edit–RFDS Configuration... section of LMF Help
function on–line documentation for RFDS configuration data examples.

5 To delete a row, click on the row and then click on the Delete Row button.

6 For each tab with changes, click on the Save button to save displayed values.

7 Click on the Dismiss button to close the window.

NOTE
S Values entered or changed after the Save button was used will be lost when the window is

dismissed.

S Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.
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RFDS Calibration

The RFDS Calibration option is used to calibrate the RFDS TX and RX
paths.

TX Path Calibration – For a TX antenna path calibration the BTS
XCVR is keyed at a pre–determined power level and the BTS power
output level is measured by the RFDS. The power level is then measured
at the TX antenna directional coupler by the power measuring test
equipment item being used (power meter or analyzer). The difference
(offset) between the power level at the RFDS and the power level at the
TX antenna directional coupler is used as the TX RFDS calibration
offset value.

RX Path Calibration – For an RX antenna path calibration the RFDS is
keyed at a pre–determined power level and the power input level is
measured by the BTS BBX. A CDMA signal at the same power level
measured by the BTS BBX is then injected at the RX antenna directional
coupler by the communications system analyzer. The difference (offset)
between the RFDS–keyed power level and power level measured at the
BTS BBX is the RFDS RX calibration offset value.

RFDS calibration and the CAL file – The TX and RX RFDS
calibration offset values are written to the CAL file in the slot[385]
Block.

TSIC channel frequency – For each RFDS TSIC, the channel
frequency is determined at the lower third and upper third of the
appropriate band using the frequencies listed in Table 3-47.

Table 3-47: RFDS TSIC Calibration Channel Frequencies

System Channel Calibration Points

800 MHz (A and B) 341 and 682

1.9 GHz 408 and 791

WARNING Before installing any test equipment directly to any TX OUT
connector, verify that there are no CDMA channels keyed.
Failure to do so can result in serious personal injury and/or
equipment damage.

Prerequisites

S Test equipment has been selected.

S Test equipment and test cables have been calibrated.

S TX calibration has been performed and BLO data has been
downloaded to the BBXs.

S Test equipment and test cables are connected for TX calibration.

S Antenna map data has been entered for the site.

S BBXs are OOS–RAM.
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RFDS Calibration Procedure

Follow the procedure in Table 3-48 to perform RFDS calibration.

Table 3-48: RFDS Calibration Procedure

Step Action

1 In the LMF, select the CDMA BTS–xxx tab.

2 If the BTS Control button is not selected (no black dot showing), click on the B button in the BTS
menu bar to select it.

3 Select the BBX(s) assigned to the carrier(s) and sector(s) which will be used in RFDS calibration
(refer to Table 1-6 for BBX carrier and sector assignments).

4 Click on RFDS in the BTS menu bar, and select RFDS Calibration... from the pull–down menu. An
RFDS Calibration set–up window will be displayed.

5 In the Tests to Perform box, select TX Calibration or RX Calibration, as required

6 Enter the appropriate channel number(s) (refer to Table 3-47) in the Channel Field box. To enter more
than one channel number, use the following methods:

– Separate non–sequential channel numbers with a comma and no spaces; 
for example:  247,585,742.

– Enter a range of sequential channels by typing the first and last channel numbers in the range
separated by a dash and no spaces; 
for example:  385–395.

7 If the frame is equipped with TX combiners, click in the Has Combiners checkbox.

8 Select the appropriate carrier(s) and sector(s) from the Carriers pick list (hold down the Shift or Ctrl
key while clicking on pick list items to select multiple carrier(s)–sector(s)).

9 Select the appropriate Rx branch (Main, Diversity or Both) in the drop–down list if performing RX
calibration.

10 Click  on the OK button. A status report window is displayed, followed by a Directions pop-up
window.

11 Follow the cable connection directions as they are displayed.

12 When the test is completed, test results are displayed in the status report window.

13 Click on the OK button to close the status report window.

14 Click on the Frame tab.

15 Select the MGLI by clicking on it.

16 Download updated RFDS offset data to the MGLI (see Step 6 in Table 3-42).
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Program TSU NAM

The NAM must be programmed before it can receive and process test
calls, or be used for any type of RFDS test.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

S MGLI is INS.

S TSU is powered up and has a code load.

Program NAM Procedure

Follow the procedure in Table 3-49 to program the TSU NAM.

Table 3-49: Program the TSU NAM

Step Action

1 Select the RFDS tab.

2 Select the SUA (Cobra RFDS) or TSU (GLI based RFDS).

3 Click on TSU in the BTS menu bar, and select Program TSU NAM from the pull–down menu. A
NAM programming window will appear.

4 Enter the appropriate information in the boxes (see Table 3-43 and Table 3-44).

5 Click on the OK button to display the status report.

6 Click on the OK button to close the status report window.
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BTS Redundancy/Alarm Testing

Objective

This section tests the redundancy options that could be included in the
cell site. These tests verify, under a fault condition, that all modules
equipped with redundancy switch operations to their redundant partner
and resume operation. An example would be to pull the currently active
CSM and verify the standby CSM takes over distribution of the CDMA
reference signal.

Redundancy covers many BTS modules. Confirm the redundant options
included in the BTS, and proceed as required. If the BTS has only basic
power supply redundancy, the tests and procedures detailed in the
following tables should be bypassed.

S Table 3-52. Miscellaneous Alarm Tests (BTS Frame)

S Table 3-53. BBX Redundancy Tests (BTS Frame)

S Table 3-54. CSM, GPS, & LFR/HSO Redundancy Alarm Tests

S Table 3-55. PA Redundancy Test

S Table 3-56. MGLI/GLI Redundancy Test

During redundancy verification of the test, alarms reported by the master
GLI (displayed via the alarm monitor) will also be verified/noted.

Test Equipment

The following pieces of test equipment are required to perform this test:

S LMF

S Communications Test Set

Redundancy/Alarm Test

Perform each of the following tests to verify BTS redundancy and to
confirm all alarms are received and reported by the BTS equipment. The
procedures should be performed on the following modules/boards:

S Power supply/converter modules in all frames

S Distribution shelf modules in the BTS frame

S C–CCP shelf modules in the BTS frame (except MCCs)

S PA modules in the BTS frame

S AMR Customer defined input/output tests
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Test Equipment Setup
Follow the procedure in Table 3-50 to set up test equipment:

NOTE All alarm tests are performed using TX antenna 1

Table 3-50: Test Equipment Setup for Redundancy/Alarm Tests

Step Action

1 Interface the LMF computer to the BTS LAN A connector on
the BTS frame (refer to Table 3-5, page 3-17).

2 Login to the BTS.

3 Set up test equipment for TX Calibration at TXOUT1 (see
Figure 3-16).

NOTE
If site is not equipped for redundancy, remove all GLI and
BBX boards installed in any redundant slot positions at this
time.

4 Display the alarm monitor by selecting Util>Alarm Monitor.

5 Unequip all customer defined AMR alarms reported via the
AMR Alarm connector (A & B) by clicking on MGLI, then
selecting Device>Set Alarm Relays>Unequipped.

NOTE
During configuration of MGLI alarm reporting, spurious
alarms may report. Allow the BTS to stabilize for 10 seconds.
If any alarms are actively being reported after the BTS has
stabilized, determine the cause before proceeding further.
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Power Supply Redundancy

Follow the steps in Table 3-51 to verify redundancy of the power supply
modules. Alarms reported by the master GLI (displayed via the alarm
monitor) are also verified.

Table 3-51: Power Supply/Converter Redundancy (BTS Frame)

Step Action

1 Select the MGLI (highlight) and from the pulldown menu select:

Device>BBX/MAWI>Set Redundant Sector>Carrier–#–1–1
Device>BBX/MAWI>Set Pilot Only>Carrier–#–1-1

Device>BBX/MAWI>Set Pilot Gain>Carrier–#-1-1 and Pilot Gain = 262

2 Select (highlight) BBX–1 and from the pulldown menu select Device>BBX/MAWI>Key.

3 Set XCVR gain to 40 and enter the correct XCVR channel number.

4 Remove PS–1 from the power distribution shelf (see Figure 3-27).

– Observe that an alarm message is reported via the MGLI as displayed on the alarm monitor.

– Verify no other modules went OOS.

5 Re-install PS–1.

Observe the alarm clears on the alarm monitor.

6 Repeat steps 4 and 5 for PS–2 and PS–3.

NOTE
For +27 V systems, skip to step 7 through step 10.

7 On –48 V systems, remove PS–4 (see Figure 3-28).

– Observe that an alarm message is reported via the MGLI as displayed on the alarm monitor.

– Verify no other modules went OOS.

8 Re-install PS–4.

Observe the alarm clears on the alarm monitor.

9 Repeat steps 7 and 8 for PS–5 through PS–9.

10 Verify that all PWR/ALM LEDs are GREEN.

11 Select BBX-1 and Device>BBX/MAWI>Dekey
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Figure 3-27: SC 4812T C–CCP Shelf
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Figure 3-28: –48 V BTS Power Conversion Shelf
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Miscellaneous Alarm/Redundancy Tests

Follow the steps in Table 3-52 to verify alarms reported by the master
GLI are displayed via the alarm monitor if a BTS frame module failure
occurs.

Table 3-52: Miscellaneous Alarm Tests

Step Action

1 Select Util>Alarm Monitor to display the alarm monitor window.

2 Perform the following to verify fan module alarms:
• Unseat a fan module (see Figure 3-29 or Figure 3-30).

• Observe an alarm message was reported via the MGLI (as displayed on the alarm monitor).

• Replace fan module and verify the alarm monitor reports that the alarm clears.

• Repeat for all other fan modules in the BTS frame.

NOTE
Follow Step 3 for Starter Frames and Step 4 for Expansion Frames.

3 Starter Frames Only: Perform the following to verify MPC module alarms.
• Unseat MPC modules (see Figure 3-27) one at a time.

• Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

• Replace the MPC modules and verify the alarm monitor reports the alarm clears.

4 Expansion Frames Only: Perform the following to verify EMPC module alarms.
• Unseat EMPC modules (see Figure 3-27) one at a time

• Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

• Replace the EMPC modules and verify the alarm monitor reports that the alarm clears.

5 If equipped with AMR redundancy, perform the following to verify AMR module redundancy/alarms.
• Unseat AMR 2 (see Figure 3-27).

• Observe that an alarm message is reported via the MGLI (as displayed on the alarm monitor).

• Repeat Steps 1 through 3 and/or 4.

• Replace the AMR module and verify the alarm monitor reports that the alarm clears.

• Unseat AMR 1 and observe an alarm message was reported via the MGLI (as displayed on the alarm
monitor).

• Replace the AMR module and verify the LMF reports the alarm has cleared.

NOTE
All PWR/ALM LEDs should be GREEN at the completion of this test.
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Figure 3-29: +27 V BTS C-CCP Fan Modules
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Figure 3-30: –48 V BTS C-CCP and Power Conversion Shelf Fan Modules
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BBX Redundancy

Follow the steps in Table 3-53 to verify redundancy of the BBXs in the
C–CCP shelf. Alarms reported by the master GLI (displayed via the
alarm monitor) are also verified. This test can be repeated for additional
sectors at the customer’s discretion.
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Table 3-53: BBX Redundancy Alarms

Step Action

� WARNING
Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.

1 Enable the primary, then the redundant BBX assigned to ANT 1 by selecting the BBX and
Device>BBX/MAWI>Key.

2 Observe that primary BBXs key up, and a carrier is present at each respective frequency.

3 Remove the primary BBX.

4 Observe a carrier is still present.
The Redundant BBX is now the active BBX for Antenna 1.

5 Replace the primary BBX and reload the BBX with code and data.

6 Re-enable the primary BBX assigned to ANT 1 and observe that a carrier is present at each respective
frequency.

7 Remove the redundant BBX and observe a carrier is still present.

8 The Primary BBX is now the active BBX for ANT 1.

9 Replace the redundant BBX and reload the BBX with code and data.

10 Re-enable the redundant BBX assigned to ANT 1 and observe that a carrier is present at each
respective frequency:

11 De-key the Xcvr by selecting Device>BBX/MAWI>Dekey.

12 Repeat Steps 1 through 11 for additional BBXs/antennas, if equipped.
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CSM, GPS, & LFR/HSO Redundancy/Alarm Tests
Follow the procedure in Table 3-54 to verify the manual redundancy of
the CSM, GPS, and LFR/HSO boards. Verification of alarms reported is
also covered.

NOTE DO NOT perform the procedure in Table 3-54, unless the site is
configured with a LORAN–C or HSO timebase as a backup for
the GPS.

Table 3-54: CSM, GPS, & LFR/HSO,  Redundancy/Alarm Tests

Step Action

� WARNING
Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.

1 Enable the primary, then the redundant BBXs assigned to ANT 1 by selecting the BBX and
Device>BBX/MAWI>Key.

2 Disconnect the GPS antenna cable, located on top of the BTS frame.
This forces the LORAN–C LFR or HSO board timebase to become the CDMA timing source.

3 Observe a CDMA timing reference alarm and source change is reported by the alarm monitor.

4 Allow the LFR/HSO to become the active timing source.

S Verify the BBXs remain keyed and INS.

S Verify no other modules went OOS due to the transfer to LFR/HSO reference.

S Observe the PWR/ALM LEDs on the CSM 1 front panel are steady GREEN.

5 Reconnect the GPS antenna cable.

6 Allow the GPS to become the active timing source.

S Verify the BBXs remain keyed and INS.

S Verify no other modules went OOS due to the transfer back to the GPS reference.

S Observe the PWR/ALM LEDs on CSM 1 are steady GREEN.

7 Disable CSM 1 and enable CSM 2.

S Various CSM source and clock alarms are now reported and the site comes down.

S Alarms clear when the site comes back up.

8 Allow the CSM 2 board to go INS_ACT.

S Verify the BBXs are dekeyed and OOS, and the MCCs are OOS_RAM.

S Verify no other modules went OOS due to the transfer to CSM 2 reference.

S Observe the PWR/ALM LEDs on CSM 2 front panels are steady GREEN.

NOTE
It can take up to 20 minutes for the CSM to re-establish the GPS link and go INS. MCCs go
OOS_RAM.

9 Key BBXs 1 and R and observe a carrier is present.

10 Repeat Steps 2 through 6 to verify CSM source redundancy with CSM 2.

. . . continued on next page
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Table 3-54: CSM, GPS, & LFR/HSO,  Redundancy/Alarm Tests

Step Action

* IMPORTANT
DO NOT ENABLE the redundant CSM.

11 Disable CSM 2 and enable CSM 1.

S Various CSM Source and Clock alarms are reported and the site comes down.

S Alarms clear when the site comes back up.

12 De-key the Xcvr by selecting Device>BBX/MAWI>Dekey.

13 Allow the CSM 1 board to go INS_ACT.

S Verify the BBXs are de-keyed and OOS.

S Verify no other modules went OOS due to the transfer to CSM 1 reference.

S Observe PWR/ALM LEDs on the CSM 1 front panels are steady GREEN.

14 Disable the primary and redundant BBXs.

 

3



BTS Redundancy/Alarm Testing 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATP3-118

Power Amplifier (PA) Redundancy Test

Follow the procedure in Table 3-55 to verify redundancy of the Power
Amplifiers (PA).

WARNING First verify there are no BBX channels keyed BEFORE
moving the antenna connection. Failure to do so can result in
serious personal injury and/or equipment damage.

Table 3-55: Power Amplifier Redundancy Test

Step Action

1 From the pulldown menu select:

Device>BBX/MAWI>Set Redundant Sector>Carrier–#–1–1
Device>BBX/MAWI>Set Pilot Only>Carrier–#–1-1

Device>BBX/MAWI>Set Pilot Gain> Carrier–#-1-1 and Pilot Gain = 262

2 Key-up the BBX assigned to the PAs associated with the sector under test (gain = 40).

3 Adjust the communications test set spectrum analyzer, as required, to observe the overall carrier
amplitude and IM Shelf and note for reference. These figures will be required later.

NOTE
See Figure 3-19 for test equipment setup, if required.

4 Push-in and release the breaker supplying the 1st PA of the pair.

NOTE
After power is removed, IM suppression takes a few seconds to settle out while compensating for the
removal of the 1st PA. The overall gain decreases by approximately 6 dB. The process must be
complete before proceeding.

5 Verify:
• The other PA module did not go OOS due to the loss of the PA.

• The overall carrier amplitude is reduced by approximately 6 dB and IM suppression on the analyzer
display remains basically unchanged.

• PA fault message is reported via the MGLI and displayed on the alarm monitor.

6 Re-apply power to the PA module and observe the alarm has cleared on the alarm monitor.

NOTE
All PWR/ALM LEDs should be GREEN at completion of test.

7 Repeat Steps 4 through 6 to verify the 2nd PA of the pair.

8 De-key the BBX.

� WARNING
First verify there are no BBX channels keyed when moving the antenna connection. Failure to do so
can result in serious personal injury and/or equipment damage.

9 Repeat Steps 1 through 8 to verify PAs assigned to sectors 2 and 3 (if equipped). Move the test cable
on top of the BTS to TX OUT 2 and TX OUT 3 antenna connectors as required.
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MGLI/GLI Redundancy Test

CAUTION This test can only be performed when the MM path is established
by the MM (not just with LAPD link connected). Attempting to
force the GLIs to “hot swap” under alarm monitor control, when
isolated from the MM, causes MGLIs to hang up.

Table 3-56: MGLI/GLI Redundancy Test (with MM Connection Established)

Step Action

NOTE
S This test assumes the alarm monitor is NOT connected to the BTS and the T1/E1 span is connected

and communication is established with the MM.

S BOTH GLIs must be INS before continuing.

1 Verify the BBXs are enabled and a CDMA carrier is present.

2 Identify the primary and redundant MGLI pairs.

3 Pull the MGLI that is currently INS–ACT and has cage control.

4 Observe the BBX remains GREEN, and the redundant MGLI is now active.

5 Verify no other modules go OOS due to the transfer of control to the redundant module.

6 Verify that the BBXs are enabled and a CDMA carrier is present.

7 Reinstall the MGLI and have the OMCR/CBSC place it back in-service.

8 Repeat Steps 1 through 7 to verify the other MGLI/GLI board.
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Alarms Testing

Alarm Verification

ALARM connectors provide Customer Defined Alarm Inputs and
Outputs. The customer can connect BTS site alarm input sensors and
output devices to the BTS, thus providing alarm reporting of active
sensors as well controlling output devices.

The SC 4812T is capable of concurrently monitoring 36 input signals
coming into the BTS. These inputs are divided between 2 Alarm
connectors marked ‘ALARM A’ and ‘ALARM B’ located at the top of
the frame (see Figure 3-31). The ALARM A connector is always
functional; ALARM B is functional when an AMR module is equipped
in the AMR 2 slot in the distribution shelf. ALARM A port monitors
input numbers 1 through 18, while ALARM B port monitors input
numbers 19 through 36 (see Figure 3-32). State transitions on these input
lines are reported to the LMF and OMCR as MGLI Input Relay alarms.

ALARM A and ALARM B connectors each provide 18 inputs and 8
outputs. If both A and B are functional, 36 inputs and 16 outputs are
available. They may be configured as redundant. The configuration is set
by the CBSC.

Alarm Reporting Display

The Alarm Monitor window can be displayed to list alarms that occur
after the window is displayed. To access the Alarm Monitor window,
select Util>Alarm Monitor.

The following buttons are included:

S The Options button allows for a severity level (Warning, Minor, and
Major) selection. The default is all levels. To change the level of
alarms reported click on the Options button and highlight the desired
alarm level(s). To select multiple levels press the <Ctrl> key (for
individual selections) or <Shift> key (for a range of selections) while
clicking on the desired levels.

S The Pause button pauses/stops the display of alarms. When the Pause
button is clicked the name of the button changes to Continue. When
the Continue button is clicked, the display of alarms continues.
Alarms that occur between the time the Pause button is clicked and
the Continue button is clicked are not displayed.

S The Clear button clears the Alarm Monitor display. New alarms that
occur after the Clear button is clicked are displayed.

S The Dismiss button dismisses/closes the Alarm Monitor display.
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Figure 3-31: Alarm Connector Location and Connector Pin Numbering
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Purpose
The following procedures verify the customer defined alarms and relay
contacts are functioning properly. These tests are performed on all AMR
alarms/relays in a sequential manner until all have been verified. Perform
these procedures periodically to ensure the external alarms are reported
properly. Following these procedures ensures continued peak system
performance.

Study the site engineering documents and perform the following tests
only after first verifying that the AMR cabling configuration required to
interconnect the BTS frame with external alarm sensors and/or relays
meet requirements called out in the SC 4812T Series BTS Installation
Manual.

NOTE Motorola highly recommends that you read and understand this
procedure in its entirety before starting this procedure.

Test Equipment
The following test equipment is required to perform these tests:

S LMF
S Alarms Test Box (CGDSCMIS00014) –optional

Abbreviations used in the following figures and tables are
defined as:

S NC = normally closed
S NO = normally open
S COM or C = common
S CDO = Customer Defined (Relay) Output
S CDI = Customer Defined (Alarm) Input

NOTE
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Figure 3-32: AMR Connector Pin Numbering
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NOTE The preferred method to verify alarms is to follow the Alarms
Test Box Procedure, Table 3-57. If not using an Alarm Test Box,
follow the procedure listed in Table 3-58.

CDI Alarm Input Verification with Alarms Test Box
Table 3-57 describes how to test the CDI alarm input verification using
the Alarm Test Box. Follow the steps as instructed and compare results
with the LMF display.

NOTE It may take a few seconds for alarms to be reported. The default
delay is 5 seconds. Leave the alarms test box switches in the new
position until the alarms have been reported.

Table 3-57: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

1 Connect the LMF to the BTS and log into the BTS.

2 Select the MGLI.

3 Click on the Device menu.

4 Click on the Set Alarm Relays menu item.

5 Click on Normally Open.

A status report window displays the results of the action.

6 Click on the OK button to close the status report window.

7 Set all switches on the alarms test box to the Open position.

8 Connect the alarms test box to the ALARM A connector (see Figure 3-31).

9 Set all of the switches on the alarms test box to the Closed position. An alarm should be reported for
each switch setting.

10 Set all of the switches on the alarms test box to the Open position. A clear alarm should be reported
for each switch setting.

11 Disconnect the alarms test box from the ALARM A connector.

12 Connect the alarms test box to the ALARM B connector.

13 Set all switches on the alarms test box to the Closed position. An alarm should be reported for each
switch setting

. . . continued on next page
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Table 3-57: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

14 Set all switches on the alarms test box to the Open position. A clear alarm should be reported for each
switch setting.

15 Disconnect the alarms test box from the ALARM B connector.

16 Select the MGLI.

17 Click on the Device menu.

18 Click on the Set Alarm Relays menu item.

19 Click on Normally Closed. A status report window displays the results of the action.

20 Click OK to close the status report window.

Alarms should be reported for alarm inputs 1 through 36.

21 Set all switches on the alarms test box to the Closed position.

22 Connect the alarms test box to the ALARM A connector.

Alarms should be reported for alarm inputs 1 through 18.

23 Set all switches on the alarms test box to the Open position.

An alarm should be reported for each switch setting.

24 Set all switches on the alarms test box to the Closed position.

A clear alarm should be reported for each switch setting.

25 Disconnect the alarms test box from the ALARM A connector.

26 Connect the alarms test box to the ALARM B connector.

A clear alarm should be reported for alarm inputs 19 through 36.

27 Set all switches on the alarms test box to the Open position.

An alarm should be reported for each switch setting.

28 Set all switches on the alarms test box to the Closed position.

A clear alarm should be reported for each switch setting.

29 Disconnect the alarms test box from the ALARM B connector.

30 Select the MGLI.

31 Click on the Device menu.

32 Click on the Set Alarm Relays menu item.

33 Click on Unequipped.

A status report window displays the results of the action.

34 Click on the OK button to close the status report window.

35 Connect the alarms test box to the ALARM A connector.

36 Set all switches on the alarms test box to both the Open and the Closed position.

No alarm should be reported for any switch settings.

. . . continued on next page
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Table 3-57: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

37 Disconnect the alarms test box from the ALARM A connector.

38 Connect the alarms test box to the ALARM B connector.

39 Set all switches on the alarms test box to both the Open and the Closed position.

No alarm should be reported for any switch settings.

40 Disconnect the alarms test box from the ALARM B connector.

41 Load data to the MGLI to reset the alarm relay conditions according to the CDF file.

 

CDI Alarm Input Verification without Alarms Test Box
Table 3-58 describes how to test the CDI alarm input verification
without the use of the Alarms Test Box. Follow the steps as instructed
and compare results with the LMF display.

NOTE It may take a few seconds for alarms to be reported. The default
delay is 5 seconds. When shorting alarm pins wait for the alarm
report before removing the short.

Table 3-58: CDI Alarm Input Verification Without the Alarms Test Box

Step Action

1 Connect the LMF to the BTS and log into the BTS.

2 Select the MGLI.

3 Click on the Device menu.

4 Click on the Set Alarm Relays menu item.

5 Click on Normally Open.

A status report window displays the results of the action.

6 Click on OK to close the status report window.

7 Refer to Figure 3-32 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25–26 through 59–60) together.

An alarm should be reported for each pair of pins that are shorted.

A clear alarm should be reported for each pair of pins when the short is removed.

8 Refer to Figure 3-32 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25–26 through 59–60) together.

An alarm should be reported for each pair of pins that are shorted.

A clear alarm should be reported for each pair of pins when the short is removed.

9 Select the MGLI.

10 Click on the Device menu.

11 Click on the Set Alarm Relays menu item.

. . . continued on next page
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Table 3-58: CDI Alarm Input Verification Without the Alarms Test Box

Step Action

12 Click on Normally Closed.

A status report window displays the results of the action.

13 Click on OK to close the status report window.

Alarms should be reported for alarm inputs 1 through 36.

14 Refer to Figure 3-32 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25–26 through 59–60) together.

A clear alarm should be reported for each pair of pins that are shorted.

An alarm should be reported for each pair of pins when the short is removed.

15 Refer to Figure 3-32 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25–26 through 59–60) together.

A clear alarm should be reported for each pair of pins that are shorted.

An alarm should be reported for each pair of pins when the short is removed.

16 Select the MGLI.

17 Click on the Device menu.

18 Click on the Set Alarm Relays menu item.

19 Click on Unequipped.

A status report window displays the results of the action.

20 Click on OK to close the status report window.

21 Refer to Figure 3-32 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25–26 through 59–60) together.

No alarms should be displayed.

22 Refer to Figure 3-32 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25–26 through 59–60) together.

No alarms should be displayed.

23 Load data to the MGLI to reset the alarm relay conditions according to the CDF file.
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Pin and Signal Information for Alarm Connectors

Table 3-59 lists the pins and signal names for Alarms A and B.

Table 3-59: Pin and Signal Information for Alarm Connectors

Wire Signal Name Wire Signal Name

Pin
Wire 
Color Alarm A Alarm B Pin

Wire
Color Alarm A Alarm B

1 Blu/Wht A CDO1 NC B CDO9 NC 31 Blu/Yel Cust Retn 4 B CDI 22

2 Wht/Blu A CDO1 Com B CDO9 Com 32 Yel/Blu A CDI 4 Cust Retn 22

3 Org/Wht A CDO1 NO B CDO9 NO 33 Org/Yel Cust Retn 5 B CDI 23

4 Wht/Org A CDO2 NC B CDO10 NC 34 Yel/Org A CDI 5 Cust Retn 23

5 Grn/Wht A CDO2 Com B CDO10 Com 35 Grn/Yel Cust Retn 6 B CDI 24

6 Wht/Grn A CDO2 NO B CDO10 NO 36 Yel/Grn A CDI 6 Cust Retn 24

7 Brn/Wht A CDO3 NC B CDO11 NC 37 Brn/Yel Cust Retn 7 B CDI 25

8 Wht/Brn A CDO3 Com B CDO11 Com 38 Yel/Brn A CDI 7 Cust Retn 25

9 Slt/Wht A CDO3 NO B CDO11 NO 39 Slt/Yel Cust Retn 8 B CDI 26

10 Wht/Slt A CDO4 NC B CDO12 NC 40 Yel/Slt A CDI 8 Cust Retn 26

11 Blu/Red A CDO4 Com B CDO12 Com 41 Blu/Vio Cust Retn 9 B CDI 27

12 Red/Blu A CDO4 NO B CDO12 NO 42 Vio/Blu A CDI 9 Cust Retn 27

13 Org/Red A CDO5 NC B CDO13 NC 43 Org/Vio Cust Retn 10 B CDI 28

14 Red/Org A CDO5 Com B CDO13 Com 44 Vio/Blu A CDI 10 Cust Retn 28

15 Grn/Red A CDO5 NO B CDO13 NO 45 Grn/Vio Cust Retn 11 B CDI 29

16 Red/Grn A CDO6 NC B CDO14 NC 46 Vio/Grn A CDI 11 Cust Retn 29

17 Brn/Red A CDO6 Com B CDO14 Com 47 Brn/Vio Cust Retn 12 B CDI 30

18 Red/Brn A CDO6 NO B CDO14 NO 48 Vio/Brn A CDI 12 Cust Retn 30

19 Slt/Red A CDO7 NC B CDO15 NC 49 Slt/Vio Cust Retn 13 B CDI 31

20 Red/Slt A CDO7 Com B CDO15 Com 50 Vio/Slt A CDI 13 Cust Retn 31

21 Blu/Blk A CDO7 NO B CDO15 NO 51 Red/Wht Cust Retn 14 B CDI 32

22 Blk/Blu A CDO8 NC B CDO16 NC 52 Wht/Red A CDI 14 Cust Retn 32

23 Org/Blk A CDO8 Com B CDO16 Com 53 Blk/Wht Cust Retn 15 B CDI 33

24 Blk/Org A CDO8 NO B CDO16 NO 54 Wht/Blk A CDI 15 Cust Retn 33

25 Grn/Blk Cust Retn 1 B CDI 19 55 Yel/Wht Cust Retn 16 B CDI 34

26 Blk/Grn A CDI 1 Cust Retn 19 56 Wht/Yel A CDI 16 Cust Retn 34

27 Brn/Blk Cust Retn 2 B CDI 20 57 Vio/Wht Cust Retn 17 B CDI 35

28 Blk/Brn A CDI 2 Cust Retn 20 58 Wht/Vio A CDI 17 Cust Retn 35

29 Slt/Blk Cust Retn 3 B CDI 21 +27V
*Pwr Conv Alm –48V

59 Blk/Red Cust Retn 18 B CDI 36

30 Blk/Slt A CDI 3 Cust Retn 21 +27V
*Pwr Conv Retn –48V

60 Red/Blk A CDI 18 Cust Retn 36

NOTE
*For –48V, reserved for Power Supply Module Alarm signal. NOT for use as CDOs or CDIs.

All Cust Rtrn 1–18 are electronically tied together at the RFMF.

All Cust Rtrn 19–36 are electronically tied together at the RFMF.

CDO = Customer Defined Output; CDI = Customer Defined Input; 
NC – normally closed, NO – normally open, Com – common

The “A CDI” numbering is from the LMF/OMCR/CBSC perspective. LMF/OMCR/CBSC starts the numbering at 19
(giving 19 – 36). Actual cable hardware starts the numbering at 0 (giving 0–17)
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Automated Acceptance Test Procedures

Introduction

The Automated Acceptance Test Procedure (ATP) allows Cellular Field
Engineers (CFEs) to run automated acceptance tests on all equipped BTS
subsystem devices using the Local Maintenance Facility (LMF) and
supported test equipment per the current Cell Site Data File (CDF)
assignment.

The results of these tests (at the option of the operator) are written to a
file that can be printed. All tests are controlled from the LMF platform
using the GPIB interface, therefore, only recommended test equipment
supported by the LMF can be used.

This chapter describes the tests run from the GUI environment, which is
the recommended method. The GUI provides the advantages of
simplifying the LMF user interface, reducing the potential for miskeying
commmands and associated parameters, and speeding up the execution
of complex operations involving multiple command strings. If you feel
the command line interface (CLI) will provide additional insight into the
progress of ATPs and problems that could possibly be encountered, refer
to LMF CLI Commands.

NOTE – Before performing any tests, use an editor to view the
“Caveats” section of the “readme.txt” file in the c:\wlmf
folder for any applicable information.

– The ATP test is to be performed on out-of-service (OOS)
sectors only.

– DO NOT substitute test equipment not supported by the
LMF.

Refer to Chapter 3 for detailed interconnection information needed for
calibrating equipment, cables, and other test equipment set components.

4



Automated Acceptance Test Procedures68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP 4-3

Reduced ATP

NOTE Equipment has been factory–tested for FCC compliance. If
license–governing bodies require documentation supporting
SITE compliance with regulations, a full ATP may be necessary.
Perform the Reduced ATP only if reports for the specific BTS
site are NOT required.

After downloading the proper operational software to the BTS, the CFE
must perform these procedures (minimal recommendation):

1. Verify the TX/RX paths by performing TX Calibration, TX Audit,
and FER tests.

2. Retrieve Calibration Data required for normal site operation.

Should failures occur while performing the specified tests, refer to the
Basic Troubleshooting section of this manual for help in determining the
failure point. Once the point of failure has been identified and corrected,
refer to the BTS Optimization and ATP Test Matrix (Table C-3) to
determine the applicable test that must be performed.

In the unlikely event that the BTS passes these tests but has a forward
link problem during normal operation, the CFE should then perform the
additional TX tests for troubleshooting: TX spectral mask, TX rho, and
TX code domain.

NOTE Refer to Chapter 3 for detailed information on test set
connections for calibrating equipment, cables and other test set
components, if  required.

Customer requirements determine which ATP tests are to be performed
and the field engineer selects the appropriate ATP tests to run.
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ATP Test Options

There are three different ATP testing options that can be performed to
completely test a BTS. Depending on your requirements, one of the
following ATP testing options should be run. Table 4-1 provides the
procedure to execute an ATP test. To completely test a BTS, run the ATP
tests according to one of the following ATP testing options:

ATP Testing Option 1
S All TX/RX test – Executes all the TX and RX tests as described in

testing option 2.

ATP Testing Option 2
S All TX test – TX tests verify the performance of the BTS transmit line

up. These include the GLI, MCC, BBX, and CIO cards, the LPAs and
passive components including splitters, combiners, bandpass filter,
and RF cables.

S All RX test – RX tests verify the performance of the BTS receiver line
up. These includes the MPC (for starter frames), EMPC (for
expansion frames), CIO, BBX, MCC, and GLI cards and the passive
components including RX filter (starter frame only), and RF cables.

ATP Testing Option 3

These tests can be run individually:

S TX Mask test

S Rho test

S Pilot Time Offset test

S Code Domain Power test

S FER test

NOTE The Full Optimization test can be run if you want the TX path
calibrated, BLO downloaded, and TX audited before all the TX
and RX tests are run.

NOTE If manual testing has been performed with the HP analyzer,
remove the manual control/system memory card from the card
slot and set the IO CONFIG to the Talk & Listen mode before
starting the automated testing.

NOTE The STOP button can be used to stop the testing process.
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ATP Test Prerequisites

Before attempting to run any ATP tests, ensure the following have been
completed:

S BTS has been optimized and calibrated (see Chapter 3).

S LMF is logged into the BTS.

S CSMs, GLIs, BBXs, MCCs, and TSU (if the RFDS is installed) have
correct code load and data load.

S Primary CSM, GLI, and MCCs are INS_ACT (bright green).

S BBXs are calibrated and BLOs are downloaded.

S No BBXs are keyed (transmitting).

S BBXs are OOS_RAM (yellow).

S Test cables are calibrated.

S Test equipment is connected for ATP tests (see Figure 3-19 through
Figure 3-24 starting on page 3-68).

S Test equipment has been warmed up 60 minutes and calibrated.

S GPIB is on.

S BTS transmit connectors are properly terminated for the test(s) to be
performed.

WARNING Before performing the FER, be sure that all PAs are turned OFF
(circuit breakers pulled) or that all transmitter ports are properly
terminated.

All transmit ports must be properly terminated for all ATP tests.

Failure to observe these warnings may result in bodily injury or
equipment damage.

TX OUT Connection

NOTE Many of the acceptance test procedures require taking
measurements at the TX OUT (BTS/RFDS) connector. At sites
without RFDS installed, all measurements will be via the BTS
TX OUT connector. At sites with RFDS installed, all
measurements will be via the RFDS directional coupler TX
OUT connector.
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Required Test Equipment

The following test equipment is required:

S LMF

S Power meter (used with HP8921A/600 and Advantest R3465)

S Communications system analyzer

S Signal generator for FER testing (required for all communications
system analyzers for 1X FER)

WARNING – Before installing any test equipment directly to any BTS
TX OUT connector, verify that there are no CDMA
channels keyed.

– At active sites, have the OMCR/CBSC place the carrier
assigned to the PAs under test OOS. Failure to do so can
result in serious personal injury and/or equipment damage.

NOTE The test equipment must be re–calibrated before using it to
perform the TX Acceptance Tests.
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Individual Acceptance Tests
The following individual ATP tests can be used to evaluate specific
aspects of BTS operation against individual performance requirements.
All testing is performed using the LMF GUI environment.

TX Testing
TX tests verify any given transmit antenna path and output power
control. All tests are performed using the external, calibrated test
equipment. All measurements are made at the appropriate BTS TX OUT
connector(s).

TX tests verify TX operation of the entire CDMA forward link using
selected BBXs assigned to respective sector antennas. Each BBX is
keyed up to generate a CDMA carrier (using both bbxlevel and BLO)
at the CDF file–specified carrier output power level.

RX Testing
RX testing verifies receive antenna paths for BBXs selected for the test.
All tests are performed using the external, calibrated test equipment to
inject a CDMA RF carrier with all zero longcode at the specified RX
frequency at the appropriate BTS RX IN connector(s).

RX tests verify RX operation of the entire CDMA reverse link using all
equipped MCCs assigned to all respective sector/antennas.

Individual Tests
The following individual tests can be used to verify the results of
specific tests.

Spectral Purity TX Mask (Primary & Redundant BBX)
This test verifies that the transmitted CDMA carrier waveform generated
on each sector meets the transmit spectral mask specification with
respect to the assigned CDF file values.

Waveform Quality (rho)
This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified value in
ANSI–J_STD–019. “Rho” represents the correlation between actual and
perfect CDMA modulation spectrum. A rho value of 1.0000 represents
100% (or perfect correlation).

Pilot Time Offset
The Pilot Time Offset is the difference between the CDMA analyzer
measurement interval (based on the BTS system time reference) and the
incoming block of transmitted data from the BTS (Pilot only, Pilot
Gain = 262, PN Offset = 0).

Code Domain Power (Primary & Redundant BBX)
This test verifies the code domain power levels, which have been set for
all ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 + 2 dB, and, that the noise floor of all EVEN numbered “OFF”
Walsh channels measures < –27 dB (with respect to total CDMA channel
power).
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Frame Error Rate

The Frame Error Rate (FER) test verifies RX operation of the entire
CDMA Reverse Link using all equipped MCCs assigned to all
respective sectors/antennas. This test verifies the BTS sensitivity on all
traffic channel elements currently configured on all equipped MCCs at
an RF input level of –119 dBm (or –116 dBm if using TMPC).
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ATP Test Procedure

Follow the procedure in Table 4-1 to perform any ATP test.

Table 4-1: ATP Test Procedure

Step Action

 1 Be sure that all prerequisites described on page 4-5 have been met.

NOTE
If the LMF has been logged into the BTS with a different Multi–Channel Preselector setting than the
one to be used for this test, the LMF must be logged out of the BTS and logged in again with the new
Multi–Channel Preselector setting. Using the wrong MPC setting can cause a false test failure.

2 Select the device(s) to be tested.

3 From the Tests menu, select the desired test from the pulldown menu:

– All TX/RX ATP... / All TX ATP... / All RX ATP...  or 

– TX > (TX Mask... / Rho... / Pilot Time Offset... / Code Domain Power...) or

– RX > FER...

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list. To select multiple items, hold down the <Shift> or <Ctrl> key while making the selections.

5 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box. If it is not, obtain the latest bts–#.cdf (or bts–#.necf) and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

6 If applicable, select Verify BLO (default) or Single–sided BLO.

NOTE
Single–sided BLO is only used when checking non–redundant transceivers.

7 For RX select the appropriate RX branch (Both, Main, or Diversity) in the drop–down list.

8 In the Rate Set box, select the appropriate data rate (1=9600, 2=14400, 3=9600 1X) from the
drop–down list.

NOTE
The Rate Set selection of 1 is only available if non–1X cards are selected for the test.

The Rate Set selection of 2 is only available if non–1X cards are selected for the test.

The Rate Set selection of 3 is only available if 1X cards are selected for the test.

9 Enter the channel elements to be tested for the RX ATP in the Channel Element(s) box. By default,
all channel elements are specified.

Use one of the following methods to enter more than one channel element:

– Enter non–sequential channel elements separated by a comma and no spaces (for example;
0,5,15).

– Enter a range of sequential channel elements by typing the first and last channel elements
separated by two periods (for example; 0..15).

NOTE
The channel element numbers are 0 based; that is the first channel element is 0.

. . . continued on next page
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Table 4-1: ATP Test Procedure

Step Action

10 If applicable, select a test pattern from the Test Pattern pick list.

NOTE
S Selecting Pilot (default) performs tests using only a pilot signal.

S Selecting Standard performs tests using pilot, synch, paging and 6 traffic channels. This requires
an MCC to be selected.

S Selecting CDFPilot performs tests using only a pilot signal, however, the gain for the channel
elements is specified in the CDF file.

S Selecting CDF performs tests using pilot, synch, paging and 6 traffic channels, however, the gain
for the channel elements is specified in the CDF file.

11 Click on the OK button.  The status report window and a Directions pop-up are displayed.

12 Follow the cable connection directions as they are displayed, and click the Continue button to begin
testing. The test results are displayed in the status report window.

13 Click on Save Results or Dismiss. If Dismiss is used, the test results will not be saved in the test
report file.
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Individual ATP Test Background Information

TX Spectral Purity Transmit Mask Acceptance Test (Tx Mask)

This test verifies the spectral purity of each BBX carrier keyed up at a
specific frequency, per the current CDF file assignment. All tests are
performed using the external calibrated test set, controlled by the same
command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

The Pilot Gain is set to 541 for each antenna, and all channel elements
from the MCCs are forward-link disabled. The BBX is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only). BBX power output is set to obtain +40 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler).

NOTE TX output power is set to +40 dBm by setting BTS power level
to +33.5 dBm to compensate for 6.5 dB increase from pilot gain
set to 541.

The calibrated communications test set measures and returns the
attenuation level of all spurious and IM products in a 30 kHz resolution
bandwidth. With respect to the mean power of the CDMA channel
measured in a 1.23 MHz bandwidth in dB, verify that results meet
system tolerances at the following test points:

S 1.7/1.9 GHz:

– at least –45 dB @ + 900 kHz from center frequency

– at least –45 dB @ – 900 kHz from center frequency

S 800 MHz:

– at least –45 dB @ + 750 kHz from center frequency

– at least –45 dB @ – 750 kHz from center frequency

– at least –60 dB @ – 1980 kHz from center frequency

– at least –60 dB @ – 1980 kHz from center frequency

The BBX then de-keys, and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated.

See Table 4-1 to perform this test.
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Figure 4-1: TX Mask Verification Spectrum Analyzer Display
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TX Waveform Quality (rho) Acceptance Test
This test verifies the transmitted Pilot channel element digital waveform
quality of each BBX carrier keyed up at a specific frequency per the
current CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all channel elements
from the MCCs are forward link disabled. The BBX is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to
40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
channel element digital waveform quality (rho) in dB, verifying that the
result meets system tolerances:

S Waveform quality (rho) should be w0.912 (–0.4dB).

The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated.

See Table 4-1 to perform this test.
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TX Pilot Time Offset Acceptance Test
This test verifies the transmitted Pilot channel element Pilot Time Offset
of each BBX carrier keyed up at a specific frequency per the current
CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all TCH elements from
the MCCs are forward link disabled. The BBX is keyed up, using both
bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to
40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
Time Offset in µs, verifying results meet system tolerances:

S Pilot Time Offset should be within v3 ms of the target PT
Offset (0 ms).

The BBX then de-keys, and if selected, the MCC is  re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated.

See Table 4-1 to perform this test.

TX Code Domain Power/Noise Floor Acceptance Test
This test verifies the Code Domain Power/Noise of each BBX carrier
keyed up at a specific frequency per the current CDF file assignment.
All tests are performed using the external calibrated test set controlled by
the same command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

For each sector/antenna under test, the Pilot Gain is set to 262. All MCC
channel elements under test are configured to generate Orthogonal
Channel Noise Source (OCNS) on different odd Walsh codes and to be
assigned a full–rate gain of 81. The maximum number of MCC/CEs to
be tested an any one time is 32 (32 odd Walsh codes). If more than 32
CEs exist, then multiple sets of measurements are made; so all channel
elements are verified on all sectors.

BBX power output is set to 40 dBm as measured at the TX OUT
connector (on either the BTS or RFDS directional coupler).

Verify the code domain power levels, which have been set for all ODD
numbered Walsh channels, using the OCNS command. This is done by
verifying that Pilot Power (dBm) minus OCNS Power (dBm) is equal to
10.2 $ 2 dB  and that the noise floor of all “OFF” Walsh channels
measures v –27 dB (with respect to total CDMA channel power).

NOTE When performing this test using the LMF and the MCC is an MCC8E
or MCC24E, the redundant BBX may fail or show marginal
performance. This is due to a timing mismatch that the LMF does not
address. Performing this test from the CBSC will not have this timing
problem.
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The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated. Upon completion of the test, the
OCNS is disabled on the specified MCC/CE.

See Table 4-1 to perform this test.

Figure 4-2: Code Domain Power and Noise Floor Levels
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RX Frame Error Rate (FER) Acceptance Test
This test verifies the BTS FER on all traffic channel elements currently
configured on all equipped MCCs (full rate at 1% FER) at an RF input
level of –119 dBm [or –116 dBm if using Tower Top
Amplifier (TMPC)]. All tests are performed using the external calibrated
test set as the signal source controlled by the same command. All
measurements are via the LMF.

The Pilot Gain is set to 262 for each TX antenna, and all channel
elements from the MCCs are forward-link disabled. The BBX is keyed
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up, using only bbxlvl level offsets, to generate a CDMA carrier (with
pilot channel element only). BBX power output is set to –20 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler). The BBX must be keyed to enable the RX receive
circuitry.

The LMF prompts the MCC/CE under test to measure all zero longcode
and provide the FER report on the selected active MCC on the reverse
link for both the main and diversity RX antenna paths, verifying that
results meet the following specification:

S FER returned less than 1% and total frames measured is 1500

All MCC/CEs selected are tested on the specified RX antenna path. The
BBX then de-keys and, if selected, the MCC is re-configured to assign
the applicable redundant BBX to the current RX antenna paths under
test. The test is then repeated.

See Table 4-1 to perform this test.
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Generating an ATP Report

Background

Each time an ATP test is run, an ATP report is updated to include the
results of the most recent ATP tests if the Save Results button is used to
close the status report window. The ATP report is not updated if the
status reports window is closed using the Dismiss button.

ATP Report

Each time an ATP test is run, a separate report is created for each BTS
and includes the following for each test:

S Test name

S BBX number

S Channel number

S Carrier number

S Sector number

S Upper test limit

S Lower test limit

S Test result

S PASS or FAIL

S Description information (if applicable)

S Time stamp

S Details/Warning information (if applicable)

The report can be printed if the LMF computer is connected to a printer.
Follow the procedure in the Table 4-2 to view and/or print the ATP
report for a BTS.

Table 4-2: Generating an ATP Report

n Step Action

1 Click on the Login tab (if not in the forefront).

2 Select the desired BTS from the available Base Station
pick list.

3 Click on the Report button.

4 Click on a column heading to sort the report.

5 – If not desiring a printable file copy, click on the
Dismiss button.

– If requiring a printable file copy, select the desired
file type in the picklist and click on the Save button.
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Chapter 5

Prepare to Leave the Site
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Updating Calibration Data Files

Software Release caveats

With Software Release 2.16.1.x, the packet BTS will NOT detect a new
calibration file on the OMC–R. A manual workaround is available in
bulletin cdma_g_bts_059. This will be corrected in Software Release
2.16.3.

Software Release 2.16.3 will allow the user to load the calibration file
from the LMF directly onto the MGLI. The MGLI will then ftp the new
calibration file to the OMC–R, thereby eliminating the need for the user
to place the calibration file at the OMC–R.

Copy and Load Cal File to to CBSC

After completing the TX calibration and audit, updated CAL file
information must be moved from the LMF Windows environment back
to the CBSC, a Unix environment. The following procedures detail
moving files from one environment to the other.

Copying CAL files from LMF to a Diskette

Follow the procedures in Table 5-1 to copy the CAL files from an LMF
computer to a 3.5 diskette.

Table 5-1: Copying CAL Files to a Diskette

Step Action

1 With Windows running on the LMF computer, insert a disk into Drive A:\.

2 Launch the Windows Explorer application program from the Start > Programs menu list.

3 Select the applicable <x>:\<lmf home directory/cdma/bts–# folder.

4 Drag the bts–#.cal file to Drive A.

5 Repeat Steps 3 and 4, as required, for other bts–# folders.
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Copying CAL Files from Diskette to the CBSC

Follow the procedure in Table 5-2 to copy CAL files from a diskette to
the CBSC.

Table 5-2: Procedures to Copy CAL Files from Diskette to the CBSC

Step Action

1 Log into the CBSC on the OMC–R Unix workstation using your account name and password.

2 Place the diskette containing calibration files (cal files) in the workstation diskette drive.

3 Type eject –q and press the Enter key.

4 Type mount and press the Enter key. Verify that floppy/no_name  is displayed.

NOTE
If the eject command has been previously entered, floppy/no_name  will be appended with a
number. Use the explicit floppy/no_name  reference displayed.

5 Type in cd /floppy/no_name and press the Enter key.

6 Type in ls –lia and press the Enter key. Verify the bts–#.cal file filename appears in the displayed
directory listing.

7 Type in cd and press the Enter key.

8 Type in pwd and press the Enter key. Verify the displayed response shows the correct home directory
(/home/<user’s name>).

9 With Solaris versions of Unix, create a Unix–formatted version of the bts–#.cal file in the home
directory by performing the following:

9a – Type in dos2unix  /floppy/no_name/bts–#.cal  bts–#.cal and press the Enter key.

Where:  #  =  BTS number for which the CAL file was created

NOTE
Other versions of Unix do not support the dos2unix command. In these cases, use the Unix cp (copy)
command. The copied files will contain DOS line feed characters which must be edited out with a
Unix text editor.

10 Type in ls –l *.cal and press the Enter key. Verify the CAL files have been copied. Verify all CAL
files to be transferred appear in the displayed listing.

11 Type eject and press the Enter key.

12 Remove the diskette from the workstation.
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Prepare to Leave the Site

External Test Equipment Removal

Perform the procedure in Table 5-3 to disconnect the test equipment and
configure the BTS for active service.

Table 5-3: External Test Equipment Removal

Step Action

1 Disconnect all external test equipment from all TX and RX
connectors on the top of the frame.

2 Reconnect and visually inspect all TX and RX antenna feed
lines at the top of the frame.

CAUTION Verify that all sector antenna feed lines are connected to the
correct ports on the frame. Crossed antenna cables will cause
system degradation of call processing.

NOTE Each module or device can be in any state prior to downloading.
Each module or device will be in an OOS_RAM state after
downloading has completed.

– For all LMF commands, information in italics represents
valid ranges for that command field.

– Only those fields requiring an input will be specified.
Default values for other fields will be assumed.

– For more complete command examples (including system
response details), refer to the CDMA LMF User  Guide.
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BTS Site Span Configuration Verification

Table 5-4 describes how to verify the current Span Framing Format and
Line Build Out (LBO) parameters. ALL MGLI2/GLI2 boards in all
C–CCP shelves that terminate a T1/E1 span should be verified.

Table 5-4: BTS Span Parameter Configuration

Step Action

1 Connect a serial cable from the LMF COM1 port (via null modem board) to the front panel of the
MGLI2 MMI port (see Figure 5-1).

2 Start an MMI communication session with MGLI2 by using the Windows desktop shortcut icon (see
Table 3-3 on page 3-13).

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

3 Enter the following MMI command to display the current MGLI2/GLI2 framing format and line code
configuration (in bold type):

span view <cr>

Observe a display similar to the options shown below:

COMMAND ACCEPTED: span view

The parameter in NVM is set to T1_2.

The frame format in flash is set to use T1_2.
Equalization:
  Span A – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span B – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span C – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span D – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span E – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span F – Default (0–131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate 
The actual rate is 0

Clock Alarms (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-40 

NOTE
– Defaults for span equalization are 0–131 feet for T1/J1 spans and 120 Ohm for E1.

– Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.

– There is no need to change from defaults unless the OMC–R/CBSC span configuration requires it.

– If the current MGLI2/GLI2 framing format and line code configuration does not display the
correct choice, proceed to Table 5-5.

4 Repeat steps 1 through 3 for all remaining GLIs.

5 Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the drop–down menu.
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Figure 5-1: MGLI2/GLI2 MMI Port Connection
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Set BTS Site Span Configuration

Perform the procedure in Table 5-5 to configure the Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI2/GLI2
boards in all C–CCP shelves that terminate a T1/E1 span must be
configured.

NOTE Perform the following procedure ONLY if span configurations
loaded in the MGLI2/GLI2s do not match those in the
OMCR/CBSC data base, AND ONLY when the exact
configuration data is available. Loading incorrect span
configuration data will render the site inoperable.

Table 5-5: Set BTS Span Parameter Configuration

Step Action

1 If not already done, connect a serial cable from the LMF COM1 port (via null modem board) to the
front panel of the MGLI2 MMI port (see Figure 5-1).

2 Start an MMI communication session with CSM–1 by using the Windows desktop shortcut icon (see
Table 3-3 on page 3-13).

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

. . . continued on next page

5



Prepare to Leave the Site68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP 5-7

Table 5-5: Set BTS Span Parameter Configuration

Step Action

3 If required only, enter the following MMI command for each span line to set the BTS span parameters
to match that of the physical spans a – f run to the site:

span_config <option#1> <option#2> <option#3> <option#4> <option#5>
option#1   =  the span to change (a – f)
option#2   =  the span type (0 – 8):

0 – E1_1 (HDB3, CCS, CRC–4)
1 – E1_2 (HDB3, CCS)
2 – E1_3 (HDB3, CAS, CRC–4, TS16)
3 – E1_4 (HDB3, CAS, TS16)
4 – T1_1 (AMI, DS1 AT&T D4, without ZCS, 3 to 1 packing, Group 0 unusable)
5 – T1_2 (B8ZS, DS1 AT&T ESF, 4 to 1 packing, 64K link)
6 – J1_1 (B8ZS, J1 AT&T ESF, Japan CRC6, 4 to 1 packing)
7 – J1_2 (B8ZS, J1 AT&T ESF, US CRC6, 4 to 1 packing)
8 – T1_3 (AMI, DS1 AT&T D4, with ZCS, 3 to 1 packing, Group 0 unusable)

option#3   =  the link speed (56 or 64) Kbps

option#4   =  the span equalization (0 – 7):
0 – T1_6 (T1,J1:long haul)
1 – T1_4 (T1,J1:393–524 feet)
2 – T1_4 (T1,J1:131–262 feet)
3 – E1_75 (E1:75 Ohm)
4 – T1_4 (T1,J1:0–131 feet)
5 – T1_4 (T1,J1:524–655 feet)
6 – T1_4 (T1,J1:262–393 feet)
7 – E1_120 (E1:120 Ohm)

option#5   =  the slot that has LAPD channel (0 – 31)

Example for setting span configuration to E1_2, 64 Kbps, E1_120–Ohm, LAPD channel 1:

span_config a 1 64 7 1
.
.

span_config f 1 64 7 1

Example for setting span configuration to T1_2, 64 Kbps, T1_4 (0–131 feet), LAPD channel 0:

span_config a 5 64 4 0
.
.

span_config f 5 64 4 0

NOTE
Make sure that spans a – f are set to the same span type and link speed. The equalization may be
different for each individual span.

After executing the span_config command, the affected MGLI2/GLI2 board MUST be reset and
re–loaded for changes to take effect.

Although defaults are shown, always consult site specific documentation for span type and rate used at
the site.

4 Press the RESET button on the GLI2 for changes to take effect.
. . . continued on next page
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Table 5-5: Set BTS Span Parameter Configuration

Step Action

5 This completes the site specific BTS Span setup for this GLI. Move the MMI cable to the next GLI2
and repeat steps 1 and 4 for ALL MGLI2/GLI2 boards.

6 Terminate the Hyperterm session and disconnect the LMF from the MGLI/SGLI.
 

LMF Removal

Perform the procedure in Table 5-6 as required to terminate the LMF
GUI session and remove the LMF computer.

Table 5-6: Terminate the LMF Session and Remove the LMF

Step Action

! CAUTION
DO NOT power down the CDMA LMF without performing the procedure indicated below.
Corrupted/lost data files may result, and in some cases, the CDMA LMF may lock up.

1 Log out of all BTS sessions and exit LMF by clicking on File in the LMF window menu bar and selecting
Logout and Exit from the pull–down list.

2 From the Windows Task Bar click Start>Shutdown. Click Yes when the Shut Down Windows
message appears.

3 Wait for the system to shut down and the screen to go blank.

4 Disconnect the LMF terminal Ethernet connector from the BTS cabinet.

5 Disconnect the LMF serial port, the RS-232 to GPIB interface box, and the GPIB cables as required
for equipment transport.
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Re–connect BTS T1/E1 Spans and Integrated Frame Modem

Before leaving the site, connect any T1 span TELCO connectors that
were removed to allow the LMF to control the BTS. Refer to Table 5-7
and Figure 5-2 as required.

Table 5-7: T1/E1 Span/IFM Connections

Step Action

1 Connect the 50–pin TELCO cables to the BTS span I/O board 50–pin TELCO connectors.

2 If used, connect the dial–up modem RS–232 serial cable to the Site I/O board RS–232 9–pin
sub D connector.

NOTE
Verify that you connect both SPAN cables (if removed previously), and the Integrated Frame
Modem (IFM) “TELCO” connector.

Figure 5-2: Site and Span I/O Boards T1 Span Connections

50–PIN TELCO
CONNECTORS
REMOVED

SPAN A CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

SPAN B CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

TOP of Frame
 (Site I/O and Span I/O boards)

RS–232 9–PIN SUB D
CONNECTOR SERIAL
PORT FOR EXTERNAL
DIAL UP MODEM
CONNECTION (IF USED)

FW00299
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Reset All Devices and Initialize Site Remotely

Devices in the BTS should not be left with data and code loaded from
the LMF. The configuration data and code loads used for normal
operation could be different from those stored in the LMF files. Perform
the procedure in Table 5-8 to reset all devices and initialize site remotely.

Table 5-8: Reset BTS Devices and Remote Site Initialization

Step Action

1 Terminate the LMF session by following the procedures in Table 5-6.

2 Reconnect spans by following the procedure in Table 5-7.

3 – If BTS is configured for circuit operation, go to Step 4.

– If BTS is configured for packet operation, go to Step 5.

4 Circuit BTS Procedure:

4a From the BTS site, contact the OMC–R and request the operator to perform a BTS reset.

or

At the BTS site:

– unseat one GLI card at a time and wait for 30 seconds;

– reseat the GLI and wait for it to complete its initialization (this takes about one minute);

– repeat for the second GLI.

4b Depending on the number of installed operational GLI cards, perform one of the following:

– With fully redundant GLIs, contact the OMC–R and request the operator to run the ACTIVATE
command for the BTS.

– For a non–redundant GLI or a frame where the redundant GLI is not operational, contact the
OMC–R and request the operator:

S ACTIVATE the GLI to set the Nextload attribute for the GLI to the one for the current BSS
software version;

S Disable the GLI;

S Enable the GLI to allow the MM to load the software version specified by the Nextload
attribute;

S Once the GLI is INS_ACT, contact the OMC–R and request the operator ACTIVATE the BTS.

– Once the GLI cards are loaded with the specified code version, the active GLI will verify and
update, as required, the RAM and, if it is necessary, ROM code loads for the installed CSM,
MCC, and BBX cards using the DLM.

. . . continued on next page
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Table 5-8: Reset BTS Devices and Remote Site Initialization

Step Action

5 Packet BTS procedure:

5a From the BTS site, contact the OMC–R and request the operator to PREACTIVATE the BTS to the
required software version for the BSS. There are two types of PREACTIVATE load processes:

– Rolling Upgrade: This load process is only available when the BTS cards are populated for full
redundancy as applicable.

– Quick Reboot: This process is used when there is not full redundancy for the BTS cards. The
GLI3 will disable and reboot to the new load. This will cause all the other cards to go out of
service. Once it is rebooted, the GLI3 determines which cards require a new load and then
downloads the cards in the order which they establish communication with the GLI3 following
their reboot. The GLI3 can reload up to 16 devices simultaneously.

6 After all activities at the site have been completed, contact the OMC–R and confirm that the BTS is
under OMC–R control.
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Notes
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Basic Troubleshooting
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Basic Troubleshooting Overview

Overview

The information in this section addresses some of the scenarios likely to
be encountered by Cellular Field Engineering (CFE) team members.
This troubleshooting guide was created as an interim reference document
for use in the field. It provides basic “what to do if” basic
troubleshooting suggestions when the BTS equipment does not perform
per the procedure documented in the manual.

Comments are consolidated from inputs provided by CFEs in the field
and information gained form experience in Motorola labs and
classrooms.
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Troubleshooting: Installation

Cannot Log into Cell-Site

Follow the procedure in Table 6-1 to troubleshoot a login failure.

Table 6-1: Login Failure Troubleshooting Procedures

n Step Action

1 If the MGLI LED is solid RED, it implies a hardware failure. Reset the MGLI by re-seating it. If
this persists, install a known good MGLI card in the MGLI slot and retry. A Red LED may also
indicate no Ethernet termination at top of frame.

2 Verify that T1 is disconnected (see Table 3-4 on page 3-16).

If T1 is still connected, verify the CBSC has disabled the BTS.

3 Try pinging the MGLI (see Table 3-11 on page 3-34).

4 Verify the LMF is connected to the Primary LMF port (LAN A) in the front of the BTS (see
Table 3-5 on page 3-17).

5 Verify the LMF was configured properly (see Preparing the LMF section starting on page 3–6).

6 Verify the BTS-LMF cable is RG-58 [flexible black cable of less than 76 cm (2.5 feet) length].

7 Verify the Ethernet ports are terminated properly (see Figure 3-9 on page 3-33).

8 Verify a T-adapter is not used on the LMF side port if connected to the BTS front LMF primary
port.

9 Try connecting to the I/O panel (top of frame). Use BNC T-adapters at the LMF port for this
connection.

10 Re-boot the LMF and retry.

11 Re-seat the MGLI and retry.

12 Verify IP addresses are configured properly.

Cannot Communicate to Power Meter

Follow the procedure in Table 6-2 to troubleshoot a power meter
communication failure.

Table 6-2:  Troubleshooting a Power Meter Communication Failure

n Step Action

1 Verify the Power Meter is connected to the LMF with a GPIB adapter.

2 Verify the cable setup as specified in Chapter 3.

3 Verify the GPIB address of the power meter is set to the same value displayed in the applicable
GPIB address box of the LMF Options window Test Equipment tab. Refer to Table 3-25 or
Table 3-26 and the GPIB Addresses section of Appendix F for details.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to the CDMA 2000 Test Equipment
Preparation section of Appendix F for details.

. . . continued on next page
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Table 6-2:  Troubleshooting a Power Meter Communication Failure

n ActionStep

5 Verify the GPIB adapter is not locked up. Under normal conditions, only two green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then cycle GPIB box power and
retry.

6 Verify the LMF computer COM1 port is not used by another application; for example, if a
HyperTerminal window is open for MMI, close it.

7 Reset all test equipment by clicking Util in the BTS menu bar and selecting
Test Equipment>Reset from the pull–down lists.

 

Cannot Communicate to Communications Analyzer

Follow the procedure in Table 6-3 to troubleshoot a communications
analyzer communication failure.

Table 6-3:  Troubleshooting a Communications Analyzer Communication Failure

n Step Action

1 Verify signal generator is connected to LMF with GPIB adapter.

2 Verify cable connections as specified in Chapter 3.

3 Verify the signal generator GPIB address is set to the same value displayed in the applicable GPIB
address box of the LMF Options window Test Equipment tab. Refer to Table 3-25 or Table 3-26
and the GPIB Address section of Appendix F for details.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to the CDMA 2000 Test Equipment
Preparation section of Appendix F for details.

5 Verify the GPIB adapter is not locked up. Under normal conditions, only two green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then cycle the GPIB box power
and retry.

6 Verify the LMF computer COM1 port is not used by another application; for example, if a
HyperTerminal window is open for MMI, close it.

7 Reset all test equipment by clicking Util in the BTS menu bar and selecting
Test Equipment>Reset from the pull–down lists.

6



Troubleshooting: Download68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP 6-5

Troubleshooting: Download

Cannot Download CODE to Any Device (card)

Follow the procedure in Table 6-4 to troubleshoot a code download
failure.

Table 6-4: Troubleshooting Code Download Failure

n Step Action

1 Verify T1 is disconnected from the BTS.

2 Verify the LMF can communicate with the BTS device using the Status function.

3 Communication to the MGLI must first be established before trying to talk to any other BTS
device.
The MGLI must be INS_ACT state (green).

4 Verify the card is physically present in the cage and powered-up.

5 If the card LED is solid RED, it implies hardware failure.
Reset the card by re-seating it.
If the LED remains solid red, replace with a card from another slot & retry.

NOTE
The card can only be replaced by a card of the same type.

6 Re-seat the card and try again.

7 If a BBX reports a failure message and is OOS_RAM, the code load was OK. Use the LMF
Status function to verify the load.

8 If the download portion completes and the reset portion fails, reset the device by selecting the
device and Reset.

9 If a BBX or an MCC remains OOS_ROM (blue) after code download, use the LMF
Device > Status function to verify that the code load was accepted.

10 If the code load was accepted, use LMF Device > Download > Flash to load RAM code into flash
memory.

Cannot Download DATA to Any Device (Card)

Perform the procedure in Table 6-5 to troubleshoot a data download
failure.

Table 6-5: Troubleshooting Data Download Failure

n Step Action

1 Re-seat the card and repeat code and data load procedure.
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Cannot ENABLE Device

Before a device can be enabled (placed in-service), it must be in the
OOS_RAM state (yellow) with data downloaded to the device. The color
of the device changes to green once it is enabled.

The three states that devices can be changed to are as follows:

S Enabled (green, INS)

S Disabled (yellow, OOS_RAM)

S Reset (blue, OOS_ROM)

Follow the procedure in Table 6-6 to troubleshoot a device enable
failure.

Table 6-6: Troubleshooting Device Enable (INS) Failure

n Step Action

1 Re-seat the card and repeat the code and data load procedure.

2 If the CSM cannot be enabled, verify the CDF file has correct latitude and longitude data for cell
site location and GPS sync.

3 Ensure the primary CSM is in INS_ACT state.

NOTE
MCCs will not go INS without the CSM being INS.

4 Verify the 19.6608 MHz CSM clock; MCCs will not go INS otherwise.

5 The BBX should not be enabled for ATP tests.

6 If MCCs give “invalid or no system time”, verify the CSM is operable.

 

Miscellaneous Errors

Perform the procedure in Table 6-7 to troubleshoot miscellaneous
failures.

Table 6-7: Miscellaneous Failures

n Step Action

1 If LPAs continue to give alarms, even after cycling power at the circuit breakers, then connect an
MMI cable to the LPA and set up a Hyperterminal connection (see Table 3-3 on page 3-13).

2 Enter ALARMS in the Hyperterminal window.
The resulting LMF display may provide an indication of the problem.
(Call Field Support for further assistance.)
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Troubleshooting: Calibration

Bay Level Offset Calibration Failure

Perform the procedure in Table 6-8 to troubleshoot a BLO calibration
failure.

Table 6-8: Troubleshooting BLO Calibration Failure

n Step Action

1 Verify the Power Meter is configured correctly (see the test equipment setup section in Chapter 3)
and connection is made to the proper TX port.

2 Verify the parameters in the bts–#.cdf file are set correctly for the following bands:

For 1900 MHz:
Bandclass=1; Freq_Band=16; SSType=16
For 800 MHz:
Bandclass=0; Freq_Band=8; SSType=8
For 1700 MHz:
Bandclass=4; Freq_Band=128; SSType=16

3 Verify that no LPA in the sector is in alarm state (flashing red LED).
Reset the LPA by pulling the circuit breaker and, after 5 seconds, pushing back in.

4 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.

5 Verify the GPIB adapter is not locked up.
Under normal conditions, only two green LEDs must be ‘ON’ (Power and Ready).
If any other LED is continuously ‘ON’, power-cycle (turn power off and on) the GPIB Box and
retry.

6 Verify the sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power Ref
signal.

7 If communication between the LMF and Power Meter is operational, the Meter display will show
“RES”.
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Cannot Load BLO

For Load BLO failures see Table 6-7.

Calibration Audit Failure

Follow the procedure in Table 6-9 to troubleshoot a calibration audit
failure.

Table 6-9: Troubleshooting Calibration Audit Failure

n Step Action

1 Verify the Power Meter is configured correctly (refer to the test equipment setup section of
Chapter  3).

2 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.

3 Verify that no LPA is in alarm state (rapidly flashing red LED).
Reset the LPA by pulling the circuit breaker and, after 5 seconds, pushing back in.

4 Verify that no sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power
Ref signal.

5 After calibration, the BLO data must be re-loaded to the BBXs before auditing.
Click on the BBX(s) and select Device>Download BLO.
Re-try the audit.

6 Verify the GPIB adapter is not locked up.
Under normal conditions, only two green LEDs must be “ON” (Power and Ready).
If any other LED is continuously “ON”, power-cycle (turn power off and on) the GPIB Box and
retry.
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Troubleshooting: Transmit ATP

BTS passed Reduced ATP tests but has forward link problem during normal
operation

Follow the procedure in Table 6-10 to troubleshoot a Forward Link
problem during normal operation.

Table 6-10: Troubleshooting Forward Link Failure (BTS Passed Reduced ATP)

n Step Action

1 Perform these additional TX tests to troubleshoot a forward link problem:

– TX mask

– TX rho

– TX code domain

Cannot Perform TX Mask Measurement
Follow the procedure in Table 6-11 to troubleshoot a TX mask
measurement failure.

Table 6-11: Troubleshooting TX Mask Measurement Failure

n Step Action

1 Verify that TX audit passes for the BBX(s).

2 If performing manual measurement, verify analyzer setup.

3 Verify that no LPA in the sector is in alarm state (flashing red LED).
Re-set the LPA by pulling the circuit breaker and, after 5 seconds, pushing it back in.

Cannot Perform Rho or Pilot Time Offset Measurement
Follow the procedure in Table 6-12 to troubleshoot a rho or pilot time
offset measurement failure.

Table 6-12: Troubleshooting Rho and Pilot Time Offset Measurement Failure

n Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offsets displayed on the analyzer is the same as the PN offset in the CDF file.

3 Re–load BBX data and repeat the test.

4 If performing manual measurement, verify analyzer setup.

5 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the LPA by pulling the
circuit breaker and, after 5 seconds, pushing back in.

6 If Rho value is unstable and varies considerably (e.g. .95,.92,.93), this may indicate that the GPS
is still phasing (i.e., trying to reach and maintain 0 freq. error).
Go to the freq. bar in the upper right corner of the Rho meter and select Hz. Press <Shift–avg>
and enter 10, to obtain an average Rho value. This is an indication the GPS has not stabilized
before going INS and may need to be re-initialized.
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Cannot Perform Code Domain Power and Noise Floor Measurement

Perform the procedure in Table 6-13 to troubleshoot a code domain and
noise floor measurement failure.

Table 6-13: Troubleshooting Code Domain Power and Noise Floor Measurement Failure

n Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offset displayed on analyzer is same as PN offset being used in the CDF file.

3 Disable and re-enable MCC (one or more MCCs based on extent of failure).

 

6



Troubleshooting: Receive ATP68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP 6-11

Troubleshooting: Receive ATP

Multi–FER Test Failure

Perform the procedure in Table 6-14 to troubleshoot a Multi–FER
failure.

Table 6-14: Troubleshooting Multi-FER Failure

n Step Action

1 Verify the test equipment set up is correct for an FER test.

2 Verify the test equipment is locked to 19.6608 and even second clocks.

On the HP8921A test set, the yellow LED (REF UNLOCK) must be OFF.

3 Verify the MCCs have been loaded with data and are INS–ACT.

4 Disable and re-enable the MCC (one or more based on extent of failure).

5 Disable, re-load code and data, and re-enable the MCC (one or more MCCs based on extent of
failure).

6 Verify the antenna connections to frame are correct based on the directions messages.
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Troubleshooting: CSM Check–list

Problem Description
Many of the Clock Synchronization Manager (CSM) board failures may
be resolved in the field before sending the boards to the factory for
repair. This section describes known CSM problems identified in field
returns, some of which are field-repairable. Check these problems before
returning suspect CSM boards.

Intermittent 19.6608 MHz Reference Clock/GPS Receiver Operation
If having any problems with CSM board kit numbers, SGLN1145 or
SGLN4132, check the suffix with the kit number. If the kit has version
“AB”, then replace with version “BC” or higher, and return model “AB”
to the repair center.

No GPS Reference Source
Check the CSM boards for proper hardware configuration. CSM kit
SGLN1145, in Slot l, has an on-board GPS receiver; while kit
SGLN4132, in Slot 2, does not have a GPS receiver. Any incorrectly
configured board must be returned to the repair center. Do not attempt to
change hardware configuration in the field. Also, verify the GPS
antenna is not damaged and is installed per recommended guidelines.

Checksum Failure
The CSM could have corrupted data in its firmware resulting in a
non-executable code. The problem is usually caused by either electrical
disturbance or interruption of data during a download. Attempt another
download with no interruptions in the data transfer. Return the CSM
board back to the repair center if the attempt to reload fails.

GPS Bad RX Message Type
This problem is believed to be caused by a later version of CSM
software (3.5 or higher) being downloaded, via LMF, followed by an
earlier version of CSM software (3.4 or lower), being downloaded from
the CBSC. Download again with CSM software code 3.5 or higher.
Return the CSM board back to the repair center if the attempt to reload
fails.

CSM Reference Source Configuration Error
This problem is caused by incorrect reference source configuration
performed in the field by software download. CSM kits SGLN1145 and
SGLN4132 must have proper reference sources configured (as shown
below) to function correctly.

CSM Kit
No.

Hardware
Configuration

CSM Slot
No.

Reference Source
Configuration

CDF Value

SGLN1145 With GPS Receiver 1 Primary = Local GPS
Backup = Either LFR or HSO

0
2 or 18

SGLN4132 Without GPS Receiver 2 Primary = Remote GPS
Backup = Either LFR or HSO

1
2 or 18
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Takes Too Long for CSM to Come INS

This problem may be caused by a delay in GPS acquisition. Check the
accuracy flag status and/or current position. Refer to the GSM system
time/GPS and LFR/HSO verification section in Chapter 3. At least one
satellite should be visible and tracked for the “surveyed” mode and four
satellites should be visible and tracked for the “estimated” mode. Also,
verify correct base site position data used in “surveyed” mode.
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C–CCP Backplane Troubleshooting

Introduction

The C–CCP backplane is a multi–layer board that interconnects all the
C–CCP modules. The complexity of this board lends itself to possible
improper diagnoses when problems occur.

Connector Functionality

The following connector overview describes the major types of
backplane connectors along with the functionality of each. This
information allows the CFE to:

S Determine which connector(s) is associated with a specific problem
type.

S Isolate problems to a specific cable or connector.

Primary “A” and Redundant “B” Inter Shelf Bus
Connectors

The 40 pin Inter Shelf Bus (ISB) connectors provide an interface bus
from the master GLI to all other GLIs in the modem frame. Their basic
function is to provide clock synchronization from the master GLI to all
other GLIs in the frame.

The ISB also provides the following functions:

S Span line grooming when a single span is used for multiple cages.

S MMI connection to/from the master GLI to cell site modem.

S Interface between GLIs and the AMR (for reporting BTS alarms).

Span Line Connector

The 50–pin span line connector provides a primary and secondary (if
used) span line interface to each GLI in the C–CCP shelf. The span line
is used for MM/EMX switch control of the Master GLI and also all the
BBX traffic.

Primary “A” and Redundant “B” Reference Distribution
Module Input/Output

The Reference Distribution Module (RDM) connectors route the 3 MHz
reference signals from the CSMs to the GLIs and all BBXs in the
backplane. The signals are used to phase lock loop all clock circuits on
the GLIs and BBX boards to produce precise clock and signal
frequencies.

Power Input (Return A, B, and C connectors)

Provides a +27 volt or –48 volt input for use by the power supply
modules.
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Power Supply Module Interface

Each power supply module has a series of three different connectors to
provide the needed inputs/outputs to the C–CCP backplane. These
include a VCC/Ground input connector, a Harting style multiple pin
interface, and a +15 V/Analog Ground output connector. The C–CCP
Power Modules convert +27 or –48 Volts to a regulated +15, +6.5, and
+5.0 Volts to be used by the C–CCP shelf cards. In the –48 V BTS, the
LPA power modules convert –48 Volts to a regulated +27 Volts.

GLI Connector

This connector consists of a Harting 4SU digital connector and a
6–conductor coaxial connector for RDM distribution. The connectors
provide inputs/outputs for the GLIs in the C–CCP backplane.

GLI 10Base–2 Ethernet “A” and “B” Connections

These BNC connectors are located on the C–CCP backplane and routed
to the GLI board. This interface provides all the control and data
communications between the master GLI and the other GLI, between
gateways, and for the LMF on the LAN.

BBX Connector

Each BBX connector consists of a Harting 2SU/1SU digital connector
and two 6–conductor coaxial connectors.  These connectors provide DC,
digital, and RF inputs/outputs for the BBXs in the C–CCP backplane.

CIO Connectors
S RX RF antenna path signal inputs are routed through RX Tri–Filters

(on the I/O plate), and via coaxial cables to the two MPC modules –
the six “A” (main) signals go to one MPC; the six “B” (diversity) to
the other. The MPC outputs the low–noise–amplified signals via the
C–CCP backplane to the CIO where the signals are split and sent to
the appropriate BBX.

S A digital bus then routes the baseband signal through the BBX, to the
backplane, then on to the MCC slots.

S Digital TX antenna path signals originate at the MCCs. Each  output
is routed from the MCC slot via the backplane appropriate BBX.

S TX RF path signal originates from the BBX, through the backplane to
the CIO, through the CIO, and via multi-conductor coaxial cabling to
the LPAs in the LPA shelf.

C–CCP Backplane Troubleshooting Procedure

Table 6-15 through Table 6-24 provide procedures for troubleshooting
problems that appear to be related to a defective C–CCP backplane. The
tables are broken down into possible problems and steps that should be
taken in an attempt to find the root cause.

NOTE Table 6-15 through Table 6-24 must be completed before
replacing ANY C–CCP backplane.
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Digital Control Problems

No GLI Control via LMF (all GLIs)

Follow the procedure in Table 6-15 to troubleshoot a GLI control via
LMF failure.

Table 6-15: No GLI Control via LMF (all GLIs)

n Step Action

1 Check the 10Base–2 ethernet connector for proper connection, damage, shorts, or opens.

2 Verify the C–CCP backplane Shelf ID DIP switch is set correctly.

3 Visually check the master GLI connector (both board and backplane) for damage.

4 Replace the master GLI with a known good GLI.

 

No GLI Control through Span Line Connection (All GLIs)

Follow the procedures in Table 6-16 and Table 6-17 to troubleshoot GLI
control failures.

Table 6-16: No GLI Control through Span Line Connection (Both GLIs)

Step Action

1 Verify the C–CCP backplane Shelf ID DIP switch is set correctly.

2 Verify that the BTS and GLIs are correctly configured in the OMCR/CBSC data base.

3 Visually check the master GLI connector (both board and backplane) for damage.

4 Replace the master GLI with a known good GLI.

5 Check the span line inputs from the top of the frame to the master GLI for proper connection and
damage.

6 Check the span line configuration on the MGLI (see Table 5-4 on page 5-5).

Table 6-17: MGLI Control Good – No Control over Co–located GLI

Step Action

1 Verify that the BTS and GLIs are correctly configured in the OMCR CBSC data base.

2 Check the ethernet for proper connection, damage, shorts, or opens.

3 Visually check all GLI connectors (both board and backplane) for damage.

4 Replace the remaining GLI with a known good GLI.

6



C–CCP Backplane Troubleshooting68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP 6-17

No AMR Control (MGLI good)

Perform the procedure in Table 6-18 to troubleshoot an AMR control
failure when the MGLI control is good.

Table 6-18: MGLI Control Good – No Control over AMR

Step Action

1 Visually check the master GLI connector (both board and backplane) for damage.

2 Replace the master GLI with a known good GLI.

3 Replace the AMR with a known good AMR.

No BBX Control in the Shelf – (No Control over
Co–located GLIs)

Perform the procedure in Table 6-19 to troubleshoot a BBX control in
the shelf failure.

Table 6-19: No BBX Control in the Shelf – No Control over Co–located GLIs

Step Action

1 Visually check all GLI connectors (both board and backplane) for damage.

2 Replace the remaining GLI with a known good GLI.

3 Visually check BBX connectors (both board and backplane) for damage.

4 Replace the BBX with a known good BBX.

No (or Missing) Span Line Traffic

Perform the procedure in Table 6-20 to troubleshoot a span line traffic
failure.

Table 6-20: MGLI Control Good – No (or Missing) Span Line Traffic

Step Action

1 Visually check all GLI connectors (both board and backplane) for damage.

2 Replace the remaining GLI with a known good GLI.

3 Visually check all span line distribution (both connectors and cables) for damage.

4 If the problem seems to be limited to one BBX, replace the MGLI with a known good MGLI.

5 Perform the BTS Span Parameter Configuration ( see Table 5-4 on page 5-5).

6 Ensure that ISB cabling is correct.
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No (or Missing) MCC Channel Elements

Perform the procedure in Table 6-21 to troubleshoot a channel elements
failure.

Table 6-21: No MCC Channel Elements

Step Action

1 Verify MCC channel elements (CEs) are correct. MCCTYPE codes are: MCC8E=0, MCC24E=2,
MCC–1X=3.

2 If the problem seems to be limited to one MCC, replace the MCC with a known good MCC.

– Check connectors (both board and backplane) for damage.

3 If no CEs on any MCC:

– Verify clock reference to CIO.
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DC Power Problems

Perform the procedure in Table 6-22 to troubleshoot a DC input voltage
to power supply module failure.

WARNING Potentially lethal voltage and current levels are routed to the
BTS equipment. This test must be carried out with a second
person present, acting in a safety role. Remove all rings, jewelry,
and wrist watches prior to beginning this test.

No DC Input Voltage to Power Supply Module

Table 6-22: No DC Input Voltage to Power Supply Module

Step Action

1 Verify DC power is applied to the BTS frame.

2 Verify there are no breakers tripped.

* IMPORTANT
If a breaker has tripped, remove all modules from the applicable shelf supplied by the breaker and
attempt to reset it.

– If the breaker trips again, there is probably a cable or breaker problem within the frame.

– If the breaker does not trip, there is probably a defective module or sub–assembly within the shelf.

3 Verify that the C–CCP shelf breaker on the BTS frame breaker panel is functional.

4 Use a voltmeter to determine if the input voltage is being routed to the C–CCP backplane by
measuring the DC voltage level on the PWR_IN cable.

– If the voltage is not present, there is probably a cable or breaker problem within the frame.

– If the voltage is present at the connector, reconnect and measure the level at the “VCC” power
feed clip on the distribution backplane.

– If the voltage is correct at the power clip, inspect the clip for damage.

5 If everything appears to be correct, visually inspect the power supply module connectors.

6 Replace the power supply module with a known good module.

7 If steps 1 through 5 fail to indicate a problem, a C–CCP backplane failure (possibly an open trace) has
occurred.
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No DC Voltage (+5, +6.5, or +15 Volts) to a Specific GLI,
BBX, or Switchboard

Perform the procedure in Table 6-23 to troubleshoot a DC input voltage
to GLI, BBX, or Switchboard failure.

Table 6-23: No DC Input Voltage to any C–CCP Shelf Module

Step Action

1 Verify the steps in Table 6-22 have been performed.

2 Inspect the defective board/module (both board and backplane) connector for damage.

3 Replace suspect board/module with known good board/module.

TX and RX Signal Routing Problems

Perform the procedure in Table 6-24 to troubleshoot TX and RX signal
routing problems.

Table 6-24: TX and RX Signal Routing Problems

Step Action

1 Inspect all Harting Cable connectors and back–plane connectors for damage in all the affected board
slots.

2 Perform steps in the RF path troubleshooting flowchart in this manual.
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Module Front Panel LED Indicators and Connectors

Module Status Indicators

Each of the non-passive plug-in modules has a bi-color (green & red)
LED status indicator located on the module front panel. The indicator is
labeled PWR/ALM. If both colors are turned on, the indicator is yellow.

Each plug-in module, except for the fan module, has its own alarm
(fault) detection circuitry that controls the state of the PWR/ALM LED.

The fan TACH signal of each fan module is monitored by the AMR.
Based on the status of this signal, the AMR controls the state of the
PWR/ALM LED on the fan module.

LED Status Combinations for All Modules (except GLI, CSM, BBX, MCC)

PWR/ALM LED

The following list describes the states of the module status indicator.

S Solid GREEN –  module operating in a normal (fault free) condition.

S Solid RED – module is operating in a fault (alarm) condition due to
electrical hardware failure.

Note that a fault (alarm) indication may or may not be due to a complete
module failure and normal service may or may not be reduced or
interrupted.

DC/DC Converter LED Status Combinations

The PWR CNVTR has alarm (fault) detection circuitry that controls the
state of the PWR/ALM LED. This is true for both the C–CCP and LPA
power converters.

PWR/ALM LED

The following list describes the states of the bi-color LED.

S Solid GREEN –  module operating in a normal (fault free) condition.

S Solid RED –  module is operating in a fault (alarm) condition due to
electrical hardware problem.
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CSM LED Status Combinations
PWR/ALM LED

The CSMs include on-board alarm detection. Hardware and
software/firmware alarms are indicated via the front panel indicators.

After the memory tests, the CSM loads OOS–RAM code from the Flash
EPROM, if available. If not available, the OOS–ROM code is loaded
from the Flash EPROM.

S Solid GREEN – module is INS_ACT or INS_STBY no alarm.

S Solid RED – Initial power up or module is operating in a fault (alarm)
condition.

S Slowly Flashing GREEN – OOS_ROM no alarm.

S Long RED/Short GREEN – OOS_ROM alarm.

S Rapidly Flashing GREEN – OOS_RAM no alarm or INS_ACT in
DUMB mode.

S Short RED/Short GREEN – OOS_RAM alarm.

S Long GREEN/Short RED – INS_ACT  or INS_STBY alarm.

S Off – no DC power  or on-board fuse is open.

S Solid YELLOW – After a reset, the CSMs begin to boot. During
SRAM test and Flash EPROM code check, the LED is yellow. (If
SRAM or Flash EPROM fail, the LED changes to a solid RED and
the CSM attempts to reboot.)

Figure 6-1: CSM Front Panel Indicators & Monitor Ports

PWR/ALM
Indicator

FREQ
MONITOR

SYNC
MONITOR

FW00303

 . . . continued on next page
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FREQ Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the 19.6608 MHz clock generated by the CSM. When
both CSM 1 and CSM 2 are in an in-service (INS) condition, the CSM 2
clock signal frequency is the same as that output by CSM 1.

The clock is a sine wave signal with a minimum amplitude of +2 dBm
(800 mVpp) into a 50 Ω load connected to this port.

SYNC Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the “Even Second Tick” reference signal generated by the
CSMs.

At this port, the reference signal is a TTL active high signal with a pulse
width of 153 nanoseconds.

MMI Connector – Only accessible behind front panel. The
RS–232 MMI port connector is intended to be used primarily in
the development or factory environment, but may be used in the
field for debug/maintenance purposes.

GLI2 LED Status Combinations

The GLI2 module has indicators, controls and connectors as described
below and shown in Figure 6-2.

The operating states of the 5 LEDs are:

ACTIVE
Solid GREEN – GLI2 is active. This means that the GLI2 has shelf
control and is providing control of the digital interfaces.

Off – GLI2 is not active (i.e., Standby). The mate GLI2 should be
active.

MASTER
S Solid GREEN – GLI2 is Master (sometimes referred to as MGLI2).

S Off – GLI2 is non-master (i.e., Slave).

ALARM
S Solid RED – GLI2 is in a fault condition or in reset.

S While in reset transition,  STATUS LED is OFF while GLI2 is
performing ROM boot (about 12 seconds for normal boot).

S While in reset transition,  STATUS LED is ON while GLI2 is
performing RAM boot (about 4 seconds for normal boot).

S Off – No Alarm.
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STATUS
S Flashing GREEN– GLI2 is in service (INS), in a stable operating

condition.

S On – GLI2 is in OOS RAM state operating downloaded code.

S Off – GLI2 is in OOS ROM state operating boot code.

SPANS
S Solid GREEN – Span line is connected and operating.

S Solid RED – Span line is disconnected or a fault condition exists.

GLI2 Pushbuttons and Connectors
RESET Pushbutton – Depressing the RESET pushbutton
causes a partial reset of the CPU and a reset of all board devices.
The GLI2 is placed in the OOS_ROM state

MMI Connector – The RS–232MMI port connector is intended
to be used primarily in the development or factory environment
but may be used in the field for debug/maintenance purposes.

LAN Connectors (A & B) – The two 10BASE2 Ethernet circuit
board mounted BNC connectors are located on the bottom front
edge of the GLI2; one for each LAN interface, A & B. Ethernet
cabling is connected to tee connectors fastened to these BNC
connectors.
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Figure 6-2: GLI2 Front Panel
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GLI3 Front Panel

Figure 6-3 shows the GLI3 front panel.

Figure 6-3: GLI3 Front Panel
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OFF – card is powered down, in initialization, or in standby
GREEN – operating normally
YELLOW – one or more of the equipped initialized spans is
receiving a remote alarm indication signal from the far end
RED – one or more of the equipped initialized spans is in an
alarm state
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BBX LED Status Combinations

PWR/ALM LED

The BBX module has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

The following list describes the states of the bi-color LED:

S Solid GREEN – INS_ACT no alarm

S Solid RED Red – initializing or power-up alarm

S Slowly Flashing GREEN – OOS_ROM no alarm

S Long RED/Short GREEN – OOS_ROM alarm

S Rapidly Flashing GREEN – OOS_RAM no alarm

S Short RED/Short GREEN – OOS_RAM alarm

S Long GREEN/Short RED – INS_ACT  alarm

MCC LED Status Combinations

The MCC module has LED indicators and connectors as described
below (see Figure 6-4). Note that the figure does not show the
connectors as they are concealed by the removable lens.

The LED indicators and their states are as follows:

PWR/ALM LED

S RED – fault on module

ACTIVE LED

S Off – module is inactive, off-line, or not processing traffic.

S Slowly Flashing GREEN – OOS_ROM no alarm.

S Rapidly Flashing Green – OOS_RAM no alarm.

S Solid GREEN – module is INS_ACT, on-line, processing traffic.

PWR/ALM and ACTIVE LEDs

S Solid RED – module is powered but is in reset or the BCP is inactive.

MMI Connectors

S The RS–232 MMI port connector (four-pin) is intended to be used
primarily in the development or factory environment but may be used
in the field for debugging purposes.

S The RJ–11 ethernet port connector (eight-pin) is intended to be used
primarily in the development environment but may be used in the field
for high data rate debugging purposes.
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Figure 6-4: MCC Front Panel
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LPA Shelf LED Status Combinations

LPA Module LED

Each LPA module contains a bi–color LED just above the MMI
connector on the front panel of the module. Interpret this LED as
follows:

S GREEN — LPA module is active and is reporting no alarms (Normal
condition).

S Flashing GREEN/RED — LPA module is active but is reporting an
low input power condition. If no BBX is keyed, this is normal and
does not constitute a failure.
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Basic Troubleshooting – Span Control Link

Span Problems (No Control Link)

Perform the procedure in Table 6-25 to troubleshoot a control link
failure.

Table 6-25: Troubleshoot Control Link Failure

n Step Action

1 Connect the CDMA LMF computer to the MMI port on the applicable MGLI/GLI as shown in
Figure 6-5 or Figure 6-6.

2 Start an MMI communication session with the applicable MGLI/GLI by using the Windows
desktop shortcut icon.

3 Once the connection window opens, press the CDMA LMF computer Enter key until the GLI>
prompt is obtained.

4 At the GLI>  prompt, enter:

config ni current  <cr>  (equivalent of span view command)

The system will respond with a display similar to the following:

The frame format in flash is set to use T1_2.
Equalization:
  Span A – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span B – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span C – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span D – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span E – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span F – Default (0–131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate 
The actual rate is 0

NOTE
Defaults for span equalization are 0–131 feet for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.

There is no need to change from defaults unless the OMC–R/CBSC span configuration requires it.

5 The span configurations loaded in the GLI must match those in the OMCR/CBSC database for the
BTS. If they do not, proceed to Table 6-26.

6 Repeat steps 1 through 5 for all remaining GLIs.

7 If the span settings are correct, verify the edlc parameters using the show command.

Any alarm conditions indicate that the span is not operating correctly.

S Try looping back the span line from the DSX panel back to the MM, and verify that the looped
signal is good.

S Listen for control tone on the appropriate timeslot from the Base Site and MM.

8 Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the drop–down menu.

9 If no TCHs in groomed MCCs (or in whole C–CCP shelf) can process calls, verify that the ISB
cabling is correct and that ISB A and ISB B cables are not swapped.
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Figure 6-5: MGLI/GLI Board MMI Connection Detail
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Figure 6-6: GLI3 Board MMI Connection Detail
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Set BTS Site Span Configuration

Table 6-26 describes how to set the span parameter configuration.

NOTE Perform the following procedure ONLY if span configurations
loaded in the MGLI/GLIs do not match those in the
OMCR/CBSC data base, AND ONLY when the exact
configuration data is available. Loading incorrect span
configuration data will render the site inoperable.

Table 6-26: Set BTS Span Parameter Configuration

n Step Action

1 If not previously done, connect the CDMA LMF computer to the MMI port on the applicable
MGLI/GLI as shown in Figure 6-5.

2 If there is no MMI communication session in progress with the applicable MGLI/GLI, initiate one
by using the Windows desktop shortcut icon.

3 At the GLI>  prompt, enter:

config  ni  format  <option>  <cr> 

The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni format option 
Next available options:
   LIST –  Option : Span Option
        E1_1 : E1_1 – E1 HDB3 CRC4    no TS16
           E1_2 : E1_2 – E1 HDB3 no CRC4 no TS16
           E1_3 : E1_3 – E1 HDB3 CRC4    TS16
          E1_4 : E1_4 – E1 HDB3 no CRC4 TS16
          T1_1 : T1_1 – D4, AMI, No ZCS
         T1_2 : T1_2 – ESF, B8ZS
         J1_1 : J1_1 – ESF, B8ZS (Japan) – Default
         J1_2 : J1_2 – ESF, B8ZS
         T1_3 : T1_3 – D4, AMI, ZCS
>

NOTE
With this command, all active (in–use) spans will be set to the same format.

4 To set or change the span type, enter the correct option from the list at the entry prompt (>), as
shown in the following example:

> T1_2 <cr> 

NOTE
The entry is case–sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:

CP:  Invalid command
GLI2>

5 An acknowledgement similar to the following will be displayed:

The value has been programmed. It will take effect after the next reset.
GLI2>

. . . continued on next page
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Table 6-26: Set BTS Span Parameter Configuration

n ActionStep

6 If the current MGLI/GLI span rate must be changed, enter the following MMI command:

config  ni  linkspeed <cr> 

The terminal will display a response similar to the following:

Next available options:
 LIST –  linkspeed : Span Linkspeed
                   56K : 56K (default for T1_1 and T1_3 systems)
                  64K : 64K (default for all other span configurations)
>

NOTE
With this command, all active (in–use) spans will be set to the same linkspeed.

7 To set or change the span linkspeed, enter the required option from the list at the entry prompt (>),
as shown in the following example:

>64K <cr>

NOTE
The entry is case–sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:

CP: Invalid command

GLI2>

8 An acknowledgement similar to the following will be displayed:

The value has been programmed.  It will take effect after the next reset.
GLI2>

9 If the span equalization must be changed, enter the following MMI command:

config ni equal<cr>

The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni equal span equal
Next available options:
   LIST –       span : Span
                       a : Span A
                       b : Span B
                       c : Span C
                       d : Span D
                       e : Span E
                       f : Span F
>

. . . continued on next page
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Table 6-26: Set BTS Span Parameter Configuration

n ActionStep

10 At the entry prompt (>), enter the designator from the list for the span to be changed as shown in
the following example:

>a<cr> 

The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni equal a equal 
Next available options:
   LIST –      equal :  Span Equalization
                       0 : 0–131 feet (default for T1/J1)
                       1 : 132–262 feet
                       2 : 263–393 feet
                       3 : 394–524 feet
                       4 : 525–655 feet
                       5 : LONG HAUL
                        6 : 75 OHM
                       7 : 120 OHM (default for E1)
>

11 At the entry prompt (>), enter the code for the required equalization from the list as shown in the
following example:

>0<cr> 

The terminal will display a response similar to the following:

> 0
The value has been programmed. It will take effect after the next reset.
GLI2>

12 Repeat Steps 9 through 11 for each in–use span.

NOTE
– After executing the config  ni  format, config ni linkspeed, and/or config  ni  equal

commands, the affected MGLI/GLI board MUST be reset and reloaded for changes to take
effect.

– Although defaults are shown, always consult site specific documentation for span type and
linkspeed used at the site.

13 Press the RESET button on the MGLI/GLI for changes to take effect.

14 Once the MGLI/GLI has reset, execute the following command to verify span settings are as
required:

config ni current  <cr>  (equivalent of span view command)

The system will respond with a display similar to the following:

The frame format in flash is set to use T1_2.
Equalization:
  Span A – 0–131 feet
  Span B – 0–131 feet
  Span C – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span D – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span E – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span F – Default (0–131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: 64K
Currently, the link is running at 64K
The actual rate is 0

. . . continued on next page
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Table 6-26: Set BTS Span Parameter Configuration

n ActionStep

15 If the span configuration is not correct, perform the applicable step from this table to change it and
repeat Steps 13 and 14 to verify required changes have been programmed.

16 Return to Step 6 of Table 6-25.
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Notes
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Optimization (Pre–ATP) Data Sheets

Verification of Test Equipment Used

Table A-1: Verification of Test Equipment Used

Manufacturer Model Serial Number

Comments:________________________________________________________

__________________________________________________________________

A
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Site Checklist

Table A-2: Site Checklist

OK Parameter Specification Comments

− Deliveries Per established procedures

− Floor Plan Verified

−

−

−

Inter Frame Cables:

Ethernet

Frame Ground

Power

Per procedure

Per procedure

Per procedure

−

−

−

Factory Data:

BBX

Test Panel

RFDS

Per procedure

Per procedure

Per procedure

− Site Temperature

− Dress Covers/Brackets

Preliminary Operations

Table A-3: Preliminary Operations

OK Parameter Specification Comments

− Shelf ID Dip Switches Per site equipage

− BBX Jumpers Verified per procedure

− Ethernet LAN verification Verified per procedure

Comments:_________________________________________________________

A
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Pre–Power and Initial Power  Tests

Table A-4: Pre–power Checklist

OK Parameter Specification Comments

− Pre–power–up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications

−

−

−

−

−

−

−

−

Internal Cables:

ISB (all cages)

CSM (all cages)

Power (all cages)

Ethernet Connectors

LAN A ohms

LAN B ohms

LAN A shield

LAN B shield

Ethernet Boots

verified

verified

verified

verified

verified

isolated

isolated

installed

− Air Impedance Cage (single cage) installed

− Initial power–up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications:

Comments:_________________________________________________________

A
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General Optimization Checklist

Table A-5: Pre–power Checklist

OK Parameter Specification Comments

−

−

LEDs

Frame fans

illuminated

operational

−

−

−

−

−

−

LMF to BTS Connection

Preparing the LMF

Log into the LMF PC

Create site specific BTS directory

Create master–bts–cdma directory

Download device loads

Moving/Linking files

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

−

−

Ping LAN A

Ping LAN B

per procedure

per procedure

−

−

−

−

−

−

−

−

−

−

Download/Enable MGLIs

Download/Enable GLIs

Set Site Span Configuration

Download CSMs

Download

Enable CSMs

Download/Enable MCCs

Download BBXs

Download TSU (in RFDS)

Program TSU NAM

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

− Test Set Calibration per procedure

Comments:_________________________________________________________

A
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GPS Receiver Operation

Table A-6: GPS Receiver Operation

OK Parameter Specification Comments

− GPS Receiver Control Task State:

tracking satellites

Verify parameter

− Initial Position Accuracy: Verify Estimated
or Surveyed

− Current Position:
lat
lon
height

RECORD in ms
and cm also
convert to deg
min sec

− Current Position: satellites tracked

Estimated:

(>4) satellites tracked,(>4) satellites visible

Surveyed:

(>1) satellite tracked,(>4) satellites visible

Verify parameter
as appropriate:

− GPS Receiver Status:Current Dilution of
Precision 
(PDOP or HDOP): (<30)

Verify parameter

− Current reference source:
Number: 0; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________

A
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LFR Receiver Operation

Table A-7: LFR Receiver Operation

OK Parameter Specification Comments

− Station call letters M X Y Z
assignment.

as specified in site
documentation

− SN ratio is > 8 dB

− LFR Task State: lfr

locked to station xxxx

Verify parameter

− Current reference source:

Number: 1; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________

A



Optimization (Pre–ATP) Data Sheets 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPA-8

LPA IM Reduction

Table A-8: LPA IM Reduction

Parameter Comments

OK LPA
CARRIER

SpecificationOK LPA
# 4:1 & 2:1

3–Sector
2:1

6–Sector
Dual BP
3–Sector

Dual BP
6–Sector

Specification

− 1A C1 C1 C1 C1 No Alarms

− 1B C1 C1 C1 C1 No Alarms

− 1C C1 C1 C1 C1 No Alarms

− 1D C1 C1 C1 C1 No Alarms

− 2A C2 C2 C2 No Alarms

− 2B C2 C2 C2 No Alarms

− 2C C2 C2 C2 No Alarms

− 2D C2 C2 C2 No Alarms

− 3A C3 C1 C1 No Alarms

− 3B C3 C1 C1 No Alarms

− 3C C3 C1 C1 No Alarms

− 3D C3 C1 C1 No Alarms

− 4A C4 C2 No Alarms

− 4B C4 C2 No Alarms

− 4C C4 C2 No Alarms

− 4D C4 C2 No Alarms

A
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LPA Convergence

Table A-9: LPA Convergence

OK Parameter Specification Data

LPA # Converged

− 1A Verify per procedure & upload
convergence data

− 1B
convergence data

− 1C

− 1D

− 2A Verify per procedure & upload
convergence data

− 2B
convergence data

− 2C

− 2D

− 3A Verify per procedure & upload
convergence data

− 3B
convergence data

− 3C

− 3D

− 4A Verify per procedure & upload
convergence data

− 4B
convergence data

− 4C

− 4D

A
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TX BLO/Power Output Verification for 3–Sector Configurations
1–Carrier
2–Carrier Non–adjacent Channels
4–Carrier Non–adjacent Channels

Table A-10: TX BLO Calibration (3–S: 1–C, and 2– and 4–C Non–adjacent Channels)

OK Parameter Specification Comments

−
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

−
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

−
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

−
BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

−
BBX–4, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibrate
carrier 3

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–5, ANT–2 = dB

BBX–r, ANT–2 = dB

−
BBX–6, ANT–3 = dB

BBX–r, ANT–3 = dB

−
BBX–10, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibrate
carrier 4

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–11, ANT–2 = dB

BBX–r, ANT–2 = dB

−
BBX–12, ANT–3 = dB

BBX–r, ANT–3 = dB

−
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

−

carrier 1
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

. . . continued on next page

A
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Table A-10: TX BLO Calibration (3–S: 1–C, and 2– and 4–C Non–adjacent Channels)

OK CommentsSpecificationParameter

−
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

−

carrier 2
BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

−
BBX–4, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–5, ANT–2 = dB

BBX–r, ANT–2 = dB

−

carrier 3
BBX–6, ANT–3 = dB

BBX–r, ANT–3 = dB

−
BBX–10, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–11, ANT–2 = dB

BBX–r, ANT–2 = dB

−

carrier 4
BBX–12, ANT–3 = dB

BBX–r, ANT–3 = dB

 

Comments:________________________________________________________

__________________________________________________________________

2–Carrier Adjacent Channel

Table A-11: TX BLO Calibration (3–S: 2–C Adjacent Channels)

OK Parameter Specification Comments

−
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

−
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

. . . continued on next page

A
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Table A-11: TX BLO Calibration (3–S: 2–C Adjacent Channels)

OK CommentsSpecificationParameter

−
BBX–7, ANT–4 = dB

BBX–r, ANT–4 = dB

−
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX–8, ANT–5 = dB

BBX–r, ANT–5 = dB

−
BBX–9, ANT–6 = dB

BBX–r, ANT–6 = dB

−
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

−

carrier 1
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

−
BBX–7, ANT–4 = dB

BBX–r, ANT–4 = dB

−
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–8, ANT–5 = dB

BBX–r, ANT–5 = dB

−

carrier 2
BBX–9, ANT–6 = dB

BBX–r, ANT–6 = dB

 

Comments:________________________________________________________

__________________________________________________________________

3–Carrier Adjacent Channels
4–Carrier Adjacent Channels

Table A-12: TX BLO Calibration (3–S: 3– or 4–C Adjacent Channels)

OK Parameter Specification Comments

−
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

−
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

. . . continued on next page
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Table A-12: TX BLO Calibration (3–S: 3– or 4–C Adjacent Channels)

OK CommentsSpecificationParameter

−
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

−
BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

−
BBX–4, ANT–4 = dB

BBX–r, ANT–4 = dB

−
Calibrate
carrier 3

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–5, ANT–5 = dB

BBX–r, ANT–5 = dB

−
BBX–6, ANT–6 = dB

BBX–r, ANT–6 = dB

−
BBX–10, ANT–4 = dB

BBX–3, ANT–4 = dB

−
Calibrate
carrier 4

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–11, ANT–5 = dB

BBX–r, ANT–5 = dB

−
BBX–12, ANT–6 = dB

BBX–r, ANT–6 = dB

−
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

−

carrier 1
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

−
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

−
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

−

carrier 2
BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

. . . continued on next page
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Table A-12: TX BLO Calibration (3–S: 3– or 4–C Adjacent Channels)

OK CommentsSpecificationParameter

−
BBX–4, ANT–4 = dB

BBX–r, ANT–4 = dB

−
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–5, ANT–5 = dB

BBX–r, ANT–5 = dB

−

carrier 3
BBX–6, ANT–6 = dB

BBX–r, ANT–6 = dB

−
BBX–10, ANT–4 = dB

BBX–r, ANT–4 = dB

−
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–11, ANT–5 = dB

BBX–r, ANT–5 = dB

−

carrier 4
BBX–12, ANT–6 = dB

BBX–r, ANT–6 = dB

 

Comments:________________________________________________________

__________________________________________________________________

A
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TX BLO/Power Output Verification for 6–Sector Configurations
1–Carrier
2–Carrier Non–adjacent Channels

Table A-13: TX BLO Calibration (6–S: 1–C, 2–C Non–adjacent Channels)

OK Parameter Specification Comments

−
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

−
BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

−
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

−
carrier 1

y ( yp ),
38 dB (minimum) prior to calibration BBX–4, ANT–4 = dB

BBX–r, ANT–4 = dB

−
BBX–5, ANT–5 = dB

BBX–r, ANT–5 = dB

−
BBX–6, ANT–6 = dB

BBX–r, ANT–6 = dB

−
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

−
BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

−
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

−
carrier 2

y ( yp ),
38 dB (minimum) prior to calibration BBX–10, ANT–4 = dB

BBX–3, ANT–4 = dB

−
BBX–11, ANT–5 = dB

BBX–r, ANT–5 = dB

−
BBX–12, ANT–6 = dB

BBX–r, ANT–5 = dB

. . . continued on next page
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Table A-13: TX BLO Calibration (6–S: 1–C, 2–C Non–adjacent Channels)

OK CommentsSpecificationParameter

−
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

−
BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

− Calibration
Audit

0 dB (+0.5 dB) for gain set resolution

BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

−

Audit
carrier 1

( ) g
post calibration BBX–4, ANT–4 = dB

BBX–r, ANT–4 = dB

−
BBX–5, ANT–5 = dB

BBX–r, ANT–5 = dB

−
BBX–6, ANT–6 = dB

BBX–r, ANT–6 = dB

−
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

−
BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

− Calibration
Audit

0 dB (+0.5 dB) for gain set resolution

BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

−

Audit
carrier 2

( ) g
post calibration BBX–10, ANT–4 = dB

BBX–r, ANT–4 = dB

−
BBX–11, ANT–5 = dB

BBX–r, ANT–5 = dB

−
BBX–12, ANT–6 = dB

BBX–r, ANT–6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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BTS Redundancy/Alarm Tests

Table A-14: BTS Redundancy/Alarm Tests

OK Parameter Specification Data

− SIF: Misc. alarm tests Verify per procedure

− MGLI redundancy test Verify per procedure

− GLI redundancy test Verify per procedure

−
Power supply/converter
redundancy

Verify per procedure

− Misc. alarm tests Verify per procedure

−
CSM, GPS, & LFR
redundancy/alarm tests

Verify per procedure

− LPA redundancy test Verify per procedure

Comments:________________________________________________________

__________________________________________________________________

TX Antenna VSWR

Table A-15: TX Antenna VSWR

OK Parameter Specification Data

−
VSWR – 
Antenna 1

   < (1.5 : 1)

−
VSWR –
Antenna 2

   < (1.5 : 1)

−
VSWR –
Antenna 3

   < (1.5 : 1)

−
VSWR –
Antenna 4

   < (1.5 : 1)

−
VSWR –
Antenna 5

   < (1.5 : 1)

−
VSWR –
Antenna 6

   < (1.5 : 1)

Comments:________________________________________________________

__________________________________________________________________

A
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RX Antenna VSWR

Table A-16: RX Antenna VSWR

OK Parameter Specification Data

−
VSWR – 
Antenna 1

   < (1.5 : 1)

−
VSWR –
Antenna 2

   < (1.5 : 1)

−
VSWR –
Antenna 3

   < (1.5 : 1)

−
VSWR –
Antenna 4

   < (1.5 : 1)

−
VSWR –
Antenna 5

   < (1.5 : 1)

−
VSWR –
Antenna 6

   < (1.5 : 1)

Comments:_________________________________________________________

AMR Verification

Table A-17: AMR CDI Alarm Input Verification

OK Parameter Specification Data

−
Verify CDI alarm input
operation (“ALARM A”
(numbers 1 –18)

BTS Relay #XX –
Contact Alarm
Sets/Clears

−
Verify CDI alarm input
operation (“ALARM B” 
(numbers 19 –36)

BTS Relay #XX –
Contact Alarm
Sets/Clears

Comments:_________________________________________________________

A
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Site Serial Number Check List

C–CCP Shelf

Site I/O A & B
C–CCP Shelf
CSM–1

CSM–2

HSO

CCD–1

CCD–2
AMR–1

AMR–2

MPC–1

MPC–2

Fans 1–3 

GLI–1

GLI–2

BBX–1

BBX–2

BBX–3

BBX–4

BBX–5

BBX–6
BBX–7

BBX–8

BBX–9

BBX–10

BBX–11

BBX–12

BBX–r

MCC–1

MCC–2

MCC–3

MCC–4

MCC–5

MCC–6

MCC–7
MCC–8

MCC–9

A
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MCC–10

MCC–11

MCC–12

CIO
SWITCH

PS–1

PS–2

PS–3

LPAs

LPA 1A

LPA 1B

LPA 1C

LPA 1D

LPA 2A

LPA 2B

LPA 2C

LPA 2D

LPA 3A

LPA 3B

LPA 3C

LPA 3D

LPA 4A

LPA 4B

LPA 4C

LPA 4D

Power Conversion Shelf (–48 V BTS Only)

AMR

PS 4

PS 5

PS 6

PS 7

PS 8

PS 9

A
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PN Offset/I & Q Offset Register

Programming Information
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PN Offset Programming Information 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPB-2

PN Offset Programming Information

PN Offset Background

All channel elements transmitted from a BTS in a particular 1.25 MHz
CDMA channel are orthonogonally spread by 1 of 128 possible Walsh
code functions; additionally, they are also spread by a quadrature pair of
PN sequences unique to each sector.

Overall, the mobile uses this to differentiate multiple signals transmitted
from the same BTS (and surrounding BTS) sectors, and to synchronize
to the next strongest sector.

The PN offset per sector is stored on the BBXs, where the corresponding
I & Q registers reside.

The PN offset values are determined on a per BTS/per sector(antenna)
basis as determined by the appropriate cdf file content. A breakdown of
this information is found in Table B-1.

PN Offset Usage

Only the 14–chip delay is currently in use. It is important to determine
the RF chip delay to be able to test the BTS functionality. This can be
done by ascertaining if the CDF file FineTxAdj  value was set to “on”
when the MCC was downloaded with “image data”. The FineTxAdj
value is used to compensate for the processing delay (approximately
20 mS) in the BTS using any type of mobile meeting IS–97
specifications.

If the FineTxAdj value in the cdf file is 213 (D5 HEX), FineTxAdj has
been set for the 14 chip table.

NOTE CDF file I and Q values can be represented in DECIMAL or
HEX. If using HEX, add 0x before the HEX value. If necessary,
convert HEX values in Table B-1 to decimal before comparing
them to cdf file I & Q value assignments.
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PN Offset Programming Information68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP B-3

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

0 17523 23459 4473 5BA3

1 32292 32589 7E24 7F4D
2 4700 17398 125C 43F6

3 14406 26333 3846 66DD
4 14899 4011 3A33 0FAB

5 17025 2256 4281 08D0
6 14745 18651 3999 48DB

7 2783 1094 0ADF 0446
8 5832 21202 16C8 52D2

9 12407 13841 3077 3611
10 31295 31767 7A3F 7C17

11 7581 18890 1D9D 49CA
12 18523 30999 485B 7917

13 29920 22420 74E0 5794
14 25184 20168 6260 4EC8

15 26282 12354 66AA 3042
16 30623 11187 779F 2BB3

17 15540 11834 3CB4 2E3A
18 23026 10395 59F2 289B

19 20019 28035 4E33 6D83
20 4050 27399 0FD2 6B07

21 1557 22087 0615 5647
22 30262 2077 7636 081D

23 18000 13758 4650 35BE
24 20056 11778 4E58 2E02

25 12143 3543 2F6F 0DD7
26 17437 7184 441D 1C10

27 17438 2362 441E 093A
28 5102 25840 13EE 64F0

29 9302 12177 2456 2F91
30 17154 10402 4302 28A2

31 5198 1917 144E 077D
32 4606 17708 11FE 452C

33 24804 10630 60E4 2986
34 17180 6812 431C 1A9C

35 10507 14350 290B 380E
36 10157 10999 27AD 2AF7

37 23850 25003 5D2A 61AB
38 31425 2652 7AC1 0A5C

39 4075 19898 0FEB 4DBA
40 10030 2010 272E 07DA

41 16984 25936 4258 6550
42 14225 28531 3791 6F73

43 26519 11952 6797 2EB0
44 27775 31947 6C7F 7CCB

45 30100 25589 7594 63F5
46 7922 11345 1EF2 2C51

47 14199 28198 3777 6E26
48 17637 13947 44E5 367B

49 23081 8462 5A29 210E
50 5099 9595 13EB 257B

. . . continued on next page
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PN Offset Programming Information 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPB-4

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

51 32743 4670 7FE7 123E

52 7114 14672 1BCA 3950
53 7699 29415 1E13 72E7

54 19339 20610 4B8B 5082
55 28212 6479 6E34 194F

56 29587 10957 7393 2ACD
57 19715 18426 4D03 47FA

58 14901 22726 3A35 58C6
59 20160 5247 4EC0 147F

60 22249 29953 56E9 7501
61 26582 5796 67D6 16A4

62 7153 16829 1BF1 41BD
63 15127 4528 3B17 11B0

64 15274 5415 3BAA 1527
65 23149 10294 5A6D 2836

66 16340 17046 3FD4 4296
67 27052 7846 69AC 1EA6

68 13519 10762 34CF 2A0A
69 10620 13814 297C 35F6

70 15978 16854 3E6A 41D6
71 27966 795 6D3E 031B

72 12479 9774 30BF 262E
73 1536 24291 0600 5EE3

74 3199 3172 0C7F 0C64
75 4549 2229 11C5 08B5

76 17888 21283 45E0 5323
77 13117 16905 333D 4209

78 7506 7062 1D52 1B96
79 27626 7532 6BEA 1D6C

80 31109 25575 7985 63E7
81 29755 14244 743B 37A4

82 26711 28053 6857 6D95
83 20397 30408 4FAD 76C8

84 18608 5094 48B0 13E6
85 7391 16222 1CDF 3F5E

86 23168 7159 5A80 1BF7
87 23466 174 5BAA 00AE

88 15932 25530 3E3C 63BA
89 25798 2320 64C6 0910

90 28134 23113 6DE6 5A49
91 28024 23985 6D78 5DB1

92 6335 2604 18BF 0A2C
93 21508 1826 5404 0722

94 26338 30853 66E2 7885
95 17186 15699 4322 3D53

96 22462 2589 57BE 0A1D
97 3908 25000 0F44 61A8

98 25390 18163 632E 46F3
99 27891 12555 6CF3 310B

100 9620 8670 2594 21DE

. . . continued on next page
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PN Offset Programming Information68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP B-5

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

101 6491 1290 195B 050A

102 16876 4407 41EC 1137
103 17034 1163 428A 048B

104 32405 12215 7E95 2FB7
105 27417 7253 6B19 1C55

106 8382 8978 20BE 2312
107 5624 25547 15F8 63CB

108 1424 3130 0590 0C3A
109 13034 31406 32EA 7AAE

110 15682 6222 3D42 184E
111 27101 20340 69DD 4F74

112 8521 25094 2149 6206
113 30232 23380 7618 5B54

114 6429 10926 191D 2AAE
115 27116 22821 69EC 5925

116 4238 31634 108E 7B92
117 5128 4403 1408 1133

118 14846 689 39FE 02B1
119 13024 27045 32E0 69A5

120 10625 27557 2981 6BA5
121 31724 16307 7BEC 3FB3

122 13811 22338 35F3 5742
123 24915 27550 6153 6B9E

124 1213 22096 04BD 5650
125 2290 23136 08F2 5A60

126 31551 12199 7B3F 2FA7
127 12088 1213 2F38 04BD

128 7722 936 1E2A 03A8
129 27312 6272 6AB0 1880

130 23130 32446 5A5A 7EBE
131 594 13555 0252 34F3

132 25804 8789 64CC 2255
133 31013 24821 7925 60F5

134 32585 21068 7F49 524C
135 3077 31891 0C05 7C93

136 17231 5321 434F 14C9
137 31554 551 7B42 0227

138 8764 12115 223C 2F53
139 15375 4902 3C0F 1326

140 13428 1991 3474 07C7
141 17658 14404 44FA 3844

142 13475 17982 34A3 463E
143 22095 19566 564F 4C6E

144 24805 2970 60E5 0B9A
145 4307 23055 10D3 5A0F

146 23292 15158 5AFC 3B36
147 1377 29094 0561 71A6

148 28654 653 6FEE 028D
149 6350 19155 18CE 4AD3

150 16770 23588 4182 5C24

. . . continued on next page
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PN Offset Programming Information 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPB-6

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

151 14726 10878 3986 2A7E

152 25685 31060 6455 7954
153 21356 30875 536C 789B

154 12149 11496 2F75 2CE8
155 28966 24545 7126 5FE1

156 22898 9586 5972 2572
157 1713 20984 06B1 51F8

158 30010 30389 753A 76B5
159 2365 7298 093D 1C82

160 27179 18934 6A2B 49F6
161 29740 23137 742C 5A61

162 5665 24597 1621 6015
163 23671 23301 5C77 5B05

164 1680 7764 0690 1E54
165 25861 14518 6505 38B6

166 25712 21634 6470 5482
167 19245 11546 4B2D 2D1A

168 26887 26454 6907 6756
169 30897 15938 78B1 3E42

170 11496 9050 2CE8 235A
171 1278 3103 04FE 0C1F

172 31555 758 7B43 02F6
173 29171 16528 71F3 4090

174 20472 20375 4FF8 4F97
175 5816 10208 16B8 27E0

176 30270 17698 763E 4522
177 22188 8405 56AC 20D5

178 6182 28634 1826 6FDA
179 32333 1951 7E4D 079F

180 14046 20344 36DE 4F78
181 15873 26696 3E01 6848

182 19843 3355 4D83 0D1B
183 29367 11975 72B7 2EC7

184 13352 31942 3428 7CC6
185 22977 9737 59C1 2609

186 31691 9638 7BCB 25A6
187 10637 30643 298D 77B3

188 25454 13230 636E 33AE
189 18610 22185 48B2 56A9

190 6368 2055 18E0 0807
191 7887 8767 1ECF 223F

192 7730 15852 1E32 3DEC
193 23476 16125 5BB4 3EFD

194 889 6074 0379 17BA
195 21141 31245 5295 7A0D

196 20520 15880 5028 3E08
197 21669 20371 54A5 4F93

198 15967 8666 3E5F 21DA
199 21639 816 5487 0330

200 31120 22309 7990 5725

. . . continued on next page

B



PN Offset Programming Information68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP B-7

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

201 3698 29563 0E72 737B

202 16322 13078 3FC2 3316
203 17429 10460 4415 28DC

204 21730 17590 54E2 44B6
205 17808 20277 4590 4F35

206 30068 19988 7574 4E14
207 12737 6781 31C1 1A7D

208 28241 32501 6E51 7EF5
209 20371 6024 4F93 1788

210 13829 20520 3605 5028
211 13366 31951 3436 7CCF

212 25732 26063 6484 65CF
213 19864 27203 4D98 6A43

214 5187 6614 1443 19D6
215 23219 10970 5AB3 2ADA

216 28242 5511 6E52 1587
217 6243 17119 1863 42DF

218 445 16064 01BD 3EC0
219 21346 31614 5362 7B7E

220 13256 4660 33C8 1234
221 18472 13881 4828 3639

222 25945 16819 6559 41B3
223 31051 6371 794B 18E3

224 1093 24673 0445 6061
225 5829 6055 16C5 17A7

226 31546 10009 7B3A 2719
227 29833 5957 7489 1745

228 18146 11597 46E2 2D4D
229 24813 22155 60ED 568B

230 47 15050 002F 3ACA
231 3202 16450 0C82 4042

232 21571 27899 5443 6CFB
233 7469 2016 1D2D 07E0

234 25297 17153 62D1 4301
235 8175 15849 1FEF 3DE9

236 28519 30581 6F67 7775
237 4991 3600 137F 0E10

238 7907 4097 1EE3 1001
239 17728 671 4540 029F

240 14415 20774 384F 5126
241 30976 24471 7900 5F97

242 26376 27341 6708 6ACD
243 19063 19388 4A77 4BBC

244 19160 25278 4AD8 62BE
245 3800 9505 0ED8 2521

246 8307 26143 2073 661F
247 12918 13359 3276 342F

248 19642 2154 4CBA 086A
249 24873 13747 6129 35B3

250 22071 27646 5637 6BFE

. . . continued on next page
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PN Offset Programming Information 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPB-8

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

251 13904 1056 3650 0420

252 27198 1413 6A3E 0585
253 3685 3311 0E65 0CEF

254 16820 4951 41B4 1357
255 22479 749 57CF 02ED

256 6850 6307 1AC2 18A3
257 15434 961 3C4A 03C1

258 19332 2358 4B84 0936
259 8518 28350 2146 6EBE

260 14698 31198 396A 79DE
261 21476 11467 53E4 2CCB

262 30475 8862 770B 229E
263 23984 6327 5DB0 18B7

264 1912 7443 0778 1D13
265 26735 28574 686F 6F9E

266 15705 25093 3D59 6205
267 3881 6139 0F29 17FB

268 20434 22047 4FD2 561F
269 16779 32545 418B 7F21

270 31413 7112 7AB5 1BC8
271 16860 28535 41DC 6F77

272 8322 10378 2082 288A
273 28530 15065 6F72 3AD9

274 26934 5125 6936 1405
275 18806 12528 4976 30F0

276 20216 23215 4EF8 5AAF
277 9245 20959 241D 51DF

278 8271 3568 204F 0DF0
279 18684 26453 48FC 6755

280 8220 29421 201C 72ED
281 6837 24555 1AB5 5FEB

282 9613 10779 258D 2A1B
283 31632 25260 7B90 62AC

284 27448 16084 6B38 3ED4
285 12417 26028 3081 65AC

286 30901 29852 78B5 749C
287 9366 14978 2496 3A82

288 12225 12182 2FC1 2F96
289 21458 25143 53D2 6237

290 6466 15838 1942 3DDE
291 8999 5336 2327 14D8

292 26718 21885 685E 557D
293 3230 20561 0C9E 5051

294 27961 30097 6D39 7591
295 28465 21877 6F31 5575

296 6791 23589 1A87 5C25
297 17338 26060 43BA 65CC

298 11832 9964 2E38 26EC
299 11407 25959 2C8F 6567

300 15553 3294 3CC1 0CDE

. . . continued on next page
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PN Offset Programming Information68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP B-9

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

301 17418 30173 440A 75DD

302 14952 15515 3A68 3C9B
303 52 5371 0034 14FB

304 27254 10242 6A76 2802
305 15064 28052 3AD8 6D94

306 10942 14714 2ABE 397A
307 377 19550 0179 4C5E

308 14303 8866 37DF 22A2
309 24427 15297 5F6B 3BC1

310 26629 10898 6805 2A92
311 20011 31315 4E2B 7A53

312 16086 19475 3ED6 4C13
313 24374 1278 5F36 04FE

314 9969 11431 26F1 2CA7
315 29364 31392 72B4 7AA0

316 25560 4381 63D8 111D
317 28281 14898 6E79 3A32

318 7327 23959 1C9F 5D97
319 32449 16091 7EC1 3EDB

320 26334 9037 66DE 234D
321 14760 24162 39A8 5E62

322 15128 6383 3B18 18EF
323 29912 27183 74D8 6A2F

324 4244 16872 1094 41E8
325 8499 9072 2133 2370

326 9362 12966 2492 32A6
327 10175 28886 27BF 70D6

328 30957 25118 78ED 621E
329 12755 20424 31D3 4FC8

330 19350 6729 4B96 1A49
331 1153 20983 0481 51F7

332 29304 12372 7278 3054
333 6041 13948 1799 367C

334 21668 27547 54A4 6B9B
335 28048 8152 6D90 1FD8

336 10096 17354 2770 43CA
337 23388 17835 5B5C 45AB

338 15542 14378 3CB6 382A
339 24013 7453 5DCD 1D1D

340 2684 26317 0A7C 66CD
341 19018 5955 4A4A 1743

342 25501 10346 639D 286A
343 4489 13200 1189 3390

344 31011 30402 7923 76C2
345 29448 7311 7308 1C8F

346 25461 3082 6375 0C0A
347 11846 21398 2E46 5396

348 30331 31104 767B 7980
349 10588 24272 295C 5ED0

350 32154 27123 7D9A 69F3

. . . continued on next page
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PN Offset Programming Information 68P09258A31–A

Oct 20031X SCt 4812T BTS Optimization/ATPB-10

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

351 29572 5578 7384 15CA

352 13173 25731 3375 6483
353 10735 10662 29EF 29A6

354 224 11084 00E0 2B4C
355 12083 31098 2F33 797A

356 22822 16408 5926 4018
357 2934 6362 0B76 18DA

358 27692 2719 6C2C 0A9F
359 10205 14732 27DD 398C

360 7011 22744 1B63 58D8
361 22098 1476 5652 05C4

362 2640 8445 0A50 20FD
363 4408 21118 1138 527E

364 102 22198 0066 56B6
365 27632 22030 6BF0 560E

366 19646 10363 4CBE 287B
367 26967 25802 6957 64CA

368 32008 2496 7D08 09C0
369 7873 31288 1EC1 7A38

370 655 24248 028F 5EB8
371 25274 14327 62BA 37F7

372 16210 23154 3F52 5A72
373 11631 13394 2D6F 3452

374 8535 1806 2157 070E
375 19293 17179 4B5D 431B

376 12110 10856 2F4E 2A68
377 21538 25755 5422 649B

378 10579 15674 2953 3D3A
379 13032 7083 32E8 1BAB

380 14717 29096 397D 71A8
381 11666 3038 2D92 0BDE

382 25809 16277 64D1 3F95
383 5008 25525 1390 63B5

384 32418 20465 7EA2 4FF1
385 22175 28855 569F 70B7

386 11742 32732 2DDE 7FDC
387 22546 20373 5812 4F95

388 21413 9469 53A5 24FD
389 133 26155 0085 662B

390 4915 6957 1333 1B2D
391 8736 12214 2220 2FB6

392 1397 21479 0575 53E7
393 18024 31914 4668 7CAA

394 15532 32311 3CAC 7E37
395 26870 11276 68F6 2C0C

396 5904 20626 1710 5092
397 24341 423 5F15 01A7

398 13041 2679 32F1 0A77
399 23478 15537 5BB6 3CB1

400 1862 10818 0746 2A42

. . . continued on next page
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